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Topic 1

Comparing Two Proportions XE "Comparing Two Proportions"  

	OVERVIEW


In the first course you learned how construct confidence intervals and test hypotheses regarding a population proportion using sample statistics.  In this topic you will consider the situation where you have categorical data from two independent populations.  We will investigate using sample statistics to compare the proportions for the two groups from which the data came.  Such comparisons are an important aspect of many experimental designs.

	OBJECTIVES


· To understand the reasoning underlying statistical procedures for comparing two population proportions.

· To learn how to construct confidence intervals for the difference between two population proportions.

· To see how to test the equality of proportions from two populations. 

	PRELIMINARIES


a) Would you expect more women who have gone through a divorce who say they wanted the divorce more than their ex-husband then the number of men who would say they wanted the divorce more than their ex-wife?

b) Suppose you have a new drug for chronic pain.  You randomly chose 20 patients with chronic pain and randomly assign 10 to use the new drug with the remaining 10 taking the old drug.  If 6 on the new drug felt significantly less pain and 5 on the old drug felt significantly less pain, would you be reasonably convinced that the new drug is better than the old drug?
c) Suppose you have a new drug for chronic pain.  You randomly chose 20 patients with chronic pain and randomly assign 10 to use the new drug with the remaining 10 taking the old drug.  If 9 on the new drug felt significantly less pain and 5 on the old drug felt significantly less pain, would you be reasonably convinced that the new drug is better than the old drug?
d) Do you feel that the higher proportion of people with a college education would feel that their health is excellent compared to other people their age than for people without a college education?

	IN-CLASS ACTIVITIES


	Activity 1-1:  Gender and Divorce    


Do women who divorce want the divorce more than do men?  The National Survey of Families and Housing is a large national survey covering a wide range of topics.  Among them are various aspects of marriage and divorce.  One question asks a respondent who has been divorced to choose between the following options.

· I wanted the divorce, but my spouse did not.

· I wanted the divorce more than my spouse.

· We both wanted the divorce equally.

· My spouse wanted the divorce more than I did.

· My spouse wanted the divorce, but I did not.

It turned out that, out of 102 men responding, 18 said they wanted the divorce more than their wife while 101 out of 191 women responding said they wanted the divorce more than their husband.  A table summarizing these results is given below.

	
	Wanted the divorce more
	Did not want the divorce more
	Total

	Men
	18
	84
	102

	Women
	101
	90
	191

	Total
	119
	174
	293


a) Let a “success” be that the respondent wanted the divorce more than his/her spouse.  Calculate the proportion of “successes”, 
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b) Does the difference indicate that women want the divorce more?

c) If the population proportions were actually the same, could such a difference occur due to chance variation?

In order to get a feel for how likely it is that we could see such a difference due to chance we will simulate, using SPSS, a pair of populations where the total number of people who wanted the divorce more than their spouse is 119, and the total number who did not want the divorce more than their spouse is 174.  We will then randomly assign these 293 responses to the 102 men and 191 women.  We will repeat this a number of times.  This should help see how likely such an outcome is.  

d) We provide the SPSS script RANDDIVORCE.SBS XE "RANDDIVORCE.SBS" .  It requires two inputs, the value of 
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 and the number of random assignments, n, you want to make.  Run the script entering your value for the difference in sample proportions, and asking for 100 random assignments (i.e. n =100).  

e) What proportion of your assignments had a difference in proportions is higher than what you calculated from the table?

f) What proportion of your assignments had a difference in proportions is lower than what you calculated from the table?

g) Do you think, based on this, that there is strong evidence that women who divorce tend to want it more than their ex-husbands?

This simulation is another example of the concept of significance.  The difference in proportions we observe would be an extremely rare event if, in fact, the population proportions were equal.  We can be more precise about this by testing the hypothesis that the to population proportions are equal.  The null hypothesis will be that the two values for 
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 are equal.  We shall describe the general testing procedure and make specific to our situation in the next topic.  We assume we have two populations, population 1 and population 2 and define the following quantities.

	
	Population 1
	Population 2

	Population proportion
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	Sample Size
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	Number of successes in sample
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If 
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are equal we can combine the two samples to get a statistic that estimates that common value of 
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.  It is computed as follows.


[image: image16.wmf]121122

1212

ˆˆ

ˆ

.

XXnpnp

p

nnnn

++

==

++


You use the first one when you know the number of successes in each sample, and you use the second one when you only have the two sample proportions.  Using these quantities the test statistic for testing 
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Make sure that you subtract the sample proportion for the population on the right side of the equal sign from the sample proportion for the population on the left side of the equal sign.  Now, as long as the samples from both populations are random and the sample sizes are such that
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Then Z will have a standard normal distribution.  This means that we can calculate p-values using the normal table.  We summarize the test as follows.

	Testing XE "Comparing two proportions, test" 
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	Test statistic:

p-values:
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	Technical requirements:
a) Both samples random

b) 
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Recall that the p-value gives a measure of the strength of evidence against the null hypothesis.  The following table summarizes how to interpret a given p-value.
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	Interpretation XE "p-value, interpretation" 
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	Little or no evidence against the null hypothesis
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	Some evidence against the null hypothesis
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	Moderate evidence against the null hypothesis
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	Strong evidence against the null hypothesis
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	Very strong evidence against the null hypothesis


	Activity 1-2:  Gender and Divorce (Cont’d.)


a) The null hypothesis for the example in Activity 1-1 is 
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, where 
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is the proportion in that population where the respondent wanted the divorce more that his/her spouse.  What is the appropriate alternative hypothesis for the situation being considered in Activity 1-1?

b) Calculate the value of 
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and record it below along with the other quantities listed.
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c) Use these quantities to calculate the value of Z.
d) Calculate the p-value for this test.

e) What do you conclude?

f) Have the technical requirements for your test been satisfied?

A test can give evidence to support the truth or falsehood of the equality of two population proportions.  However, it gives no information regarding the size of the difference, if one exists.  In order to determine that, we need to construct a confidence interval for the difference between the two population proportions.  We summarize the confidence interval procedure as follows.

	Confidence Interval for 
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 XE "Comparing two proportions, confidence interval" 
When 
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Here, z* is the appropriate critical value for a normal distribution.

Technical requirements:

a) Both samples random.

b) 
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	Activity 1-3:  Gender and Divorce (Cont’d.)


a) Have the technical requirements for the confidence interval procedure described above been satisfied?

b) Construct a 99% confidence interval for 
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, where 
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is the proportion in that population where the respondent would want the divorce more than his/her ex-spouse.

c) What can you conclude about 
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	Activity 1-4:  Using SPSS


SPSS does not have built-in procedures for conducting tests or constructing confidence intervals for comparing two population proportions.  We do, however, provide two scripts for this purpose.  The script for the test is TEST2PROP.SBS XE "TEST2PROP.SBS" .  It has the following dialog box.
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Its use is fairly self-explanatory.

· Enter either the number of successes or the sample proportion in the two top boxes.

· Enter the sample sizes in the next two boxes.

· Click on the appropriate alternative hypothesis.

· Click OK to run the test.  The results will appear in an output window.

a) Use the TEST2PROP.SBS XE "TEST2PROP.SBS"  script to test 
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using the data from Activity 1-1.  
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 is the proportion in each population where the respondent would say that he/she wanted the divorce more than his/her ex-spouse.  Record the value of the test statistic and the p-value below.

The script for the confidence interval is CI2PROP.SBS XE "CI2PROP.SBS" .  It has the following dialog box.
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Its use is fairly self-explanatory.

· Enter either the number of successes or the sample proportion in the two top boxes.

· Enter the sample sizes in the next two boxes.

· Enter the desired confidence level, in percent, in the Confidence Level box.

· Click OK to construct the confidence interval.  The results will appear in an output window.

b) Use the CI2PROP.SBS XE "CI2PROP.SBS"  script to construct a 95% confidence interval for 
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using the data from Activity 1-1.  
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 is the proportion in each population where the respondent would say that he/she wanted the divorce more than his/her ex-spouse.  Record your confidence bounds in the space below.

	Homework Activities


	Activity 1-5:  Obesity in Young Women 


A study of women in an urban Trinidadian community published in the International Journal of Obesity was, in part interested in the connection, if any, between obesity in young girls and the age at which they first menstruated.  Obesity was measured using triceps skinfold size.  Girls with large triceps skinfold thickness are considered to be obese.  Of 80 girls who first menstruated before the age of 12, 36 had large triceps skinfold thickness.  Of 503 girls who first menstruated at age 12 or greater, 150 had large triceps skinfold thickness.

a) What is the parameter of interest?

b) What are the null and alternative hypotheses for this situation?

c) Conduct a test of your null and alternative hypotheses.  What is the value of your test statistic the associated p-value?

d) What do you conclude?

e) Construct a 95% confidence interval for the difference in the proportion of obese girls in the two age groups.

	Activity 1-6:  Mental Impairment of School-Age Children


A study investigated the relationship between the degree of mental impairment and the socio-economic status of his/her parents.  Among other things they were interested in whether the proportion of children having no mental impairment differed depending on whether the child’s parents had low or high socio-economic status.  The researchers sampled 262 children whose parents had low socio-economic status and found that 64 showed no signs of mental impairment.  They also sampled 217 children whose parents had high socio-economic status and found that 21 showed no signs of mental impairment.

a) What is the parameter of interest?

b) State the null an alternative hypotheses.

c) Conduct a test of your hypotheses and report the results.

d) What do you conclude?

e) Construct a 99% confidence interval for the difference in proportion of children having no mental impairment.

	Activity 1-7:  Wearing Eyeglasses and Delinquency


A study was conducted that compared the health of juvenile delinquent boys and a non-delinquent control group.  One question of interest was whether delinquent boys with poor eyesight were less likely to wear glasses than non-delinquent boys with poor eyesight.  In a sample of 35 juvenile delinquent boys with poor eyesight 38% wore glasses.  In a sample of 50 non-delinquent boys with poor eyesight 44% wore glasses.

a) Explain what a test of hypotheses would allow us to determine.

b) State the null and alternative hypotheses both mathematically and in English.

c) Conduct the test and summarize your conclusions.

	Activity 1-8:  Wearing Eyeglasses and Delinquency


Assume that the sample sizes from the two groups are the same.  What would be the minimum sample size be for the difference in these two percentages to be significant at the 
[image: image55.wmf].05

a

=

level?  You can either use trial and error and TEST2PROP.SBS XE "TEST2PROP.SBS"  or determine the value of Z that would be significant at the .05 level and solve algebraically for the sample size.

	Activity 1-9:  Treating Lymphoma


 A clinical trial compared the use of cytoxan and prednisone (CP) and BCNU and prednisone (BP) in the treatment of lymphocytic lymphoma.  The results were measured on a qualitative scale from “Complete response” (best) to “Progression” (worst).  19% of 138 patients treated with CP showed complete response contrasted with 23% of 135 patients treated with BP.

a) Conduct a test to determine if there is a difference between these two treatments.  Show your null and alternative hypotheses, the value of your test statistic, and your p-value.

b) Are your results significant at the .1 level?  The .05 level?  The .01 level?

	Activity 1-10: Smoking and Premature Births


Are mothers who smoke more likely to give birth prematurely than mothers who do not smoke?  A study was conducted to investigate this.  In a sample of 4401 non-smoking mothers, there were 365 premature births.  In a sample of 517 mothers who smoked, there were 49 premature births.  Conduct a test to determine if the data support the notion that mothers who smoke are more likely to give birth prematurely.

	Activity 1-11:  Confidence Intervals and Sample Size


Suppose that the sample proportion from Group A was .45, and the sample proportion from Group B was .55.  Further suppose that the sample size from both groups was the same.  How large would this common sample size need to be in order for a 95% confidence interval for the difference between the two population proportions to have a margin of error (i.e. a half-width) of 3%?

	Activity 1-12: Informing Cancer Patients 


Doctors were surveyed in a large number of European countries asking what they would tell a patient with newly diagnosed colon cancer and also what they would tell his/her spouse.  The doctors were asked to read a case history of a hypothetical patient and to answer 7 yes/no questions.  One of the questions was “Would you tell the patient that he/she has a cancer, if he/she asks you directly to disclose the diagnosis?”  5 of 12 doctors surveyed in Italy answered “yes” while 8 out of 15 Yugoslavian doctors answered “yes.”  Construct a 90% confidence interval for the difference in the proportion of Italian and Yugoslavian doctors who would answer “yes” to the question.  Perhaps the larger question is why would a doctor not tell a patient who asks whether or not he/she has cancer.

	Activity 1-13:  Buying Toilet Paper


Are customers less likely to purchase toilet paper in a suburban market than at a central city market?  One market in a suburb was selected along with one randomly selected central city market, and purchases were observed.  128 out of 454 customers at the central city market purchased at least one roll of toilet paper as compared to 83 out of 454 customers at the suburban market.  Conduct an appropriate test of hypotheses and report your results.
Topic 2

Comparing Two Means XE "Comparing two means"  

	OVERVIEW


In the first course you learned to construct confidence intervals and test hypotheses regarding the value of a population mean.  In many experimental situations you want to compare the mean of a treatment group with that of a control group.  This is what controlled experiments are all about.  We have already seen how to compare two means in a matched pairs experiment.  It is also common to take a random sample from two independent populations for which there is no natural pairing of an observational unit from one population with one from the other population.  For this reason we will extend confidence intervals and tests to include procedures for comparing two populations under such a situation.

	OBJECTIVES


· To learn a procedure for testing whether the means of two independent populations are equal.

· To learn a procedure for constructing confidence intervals for the difference between the mean of two independent populations.

· To learn how to use quantile-quantile plots to determine if a distribution appears to be normal.

	PRELIMINARIES


a) Do you think that liquor prices are higher in states where liquor stores are privately owned than in states where they are state run?

b) Do you think that every privately owned liquor store charges more than every state owned stores?

c) By how much, if any, do you think privately owned liquor stores tend, on average, to charge more than state owned stores?

	IN-CLASS ACTIVITIES

	

	Activity 2-1:  Whiskey Prices


A sample of 16 states where liquor stores are state owned and a sample of 26 states where liquor stores are privately owned was taken.  In each state the average price, in dollars for a fifth of Seagram’s 7 Crown Whiskey was obtained.  The data are shown below, and they are stored in the SPSS file WHISKEY.SAV XE "WHISKEY.SAV" . 

	State Owned:

	4.65
	4.55
	4.11
	4.15
	4.20
	4.55
	3.80
	4.00
	4.19
	4.75

	4.74
	4.50
	4.10
	4.00
	5.05
	4.20
	
	
	
	


	Privately Owned:

	4.82
	5.29
	4.89
	4.95
	4.55
	4.90
	5.25
	5.30
	4.29
	4.85

	4.54
	4.75
	4.85
	4.85
	4.50
	4.75
	4.79
	4.85
	4.79
	4.95

	4.95
	4.75
	5.20
	5.10
	4.80
	4.29
	
	
	
	


a) Histograms for these data are shown below.  Do the plots indicate that there appears to be a difference in the price of whiskey for the different type of states?
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b) Use SPSS to compute the means and standard deviations for each type of state.  Complete the following table.

	Gender
	Sample

 Size
	Sample 

Mean
	Sample

 Standard Deviation

	State Owned


	16
	
	

	Privately Owned


	26
	
	


c) Do the statistics computed seem to lead to a conclusion that is consistent with the one you arrived at using the histograms?  If not, what do you think is going on here?

Merely having the two sample means be different is not enough to permit us to conclude that the population means differ.  The observed difference could be accounted for by the fact that there is sampling variability.  We can, however, use a test of hypotheses to find out if the observed difference in the sample means is “significant.”  A confidence interval can be used to estimate the difference.

For the purposes of discussion we shall establish the following notation.  One population will be denoted as X, and the second population will be denoted by Y.  

	
	Group One (X)
	Group Two (Y)

	Population Mean
	


	



	Population Standard Deviation
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	Sample Size
	


	



	Sample Mean
	


	



	Sample Standard Deviation
	


	




We are interested in testing 
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 in constructing confidence intervals for 
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.  There are two commonly used procedures for constructing confidence intervals for the difference between the two population means and testing the equality of the two population means.  One set of procedures can be used in the situation where 
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.  These will be considered in Topic 3.  The procedures we will present in this topic work when the equality of population standard deviations does not appear reasonable.  The confidence interval and testing procedures we will discuss in this topic are based on the distribution of 
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.  Since we do not know the population standard deviations we replace them with the sample standard deviations to obtain the standard error for
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	Standard Error of 
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For all of the confidence intervals we shall discuss, it is a general rule of thumb that a confidence interval is obtained by

statistic 
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Using this principle we give the following formula for the confidence interval for

.

	Confidence Interval for 

 XE "Comparing two means, confidence interval" 
When 

 and 

have normal distributions and both populations have the same standard deviation, a confidence interval for 

 is given by




Here, t* is the appropriate critical value for a t distribution with degrees of freedom equal to the smaller of 
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Technical requirements:

a) Both samples random.

b) Either both populations are normal or both 
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We also give the procedure for testing the null hypothesis that
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	Testing XE "Comparing two means, test" 
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	Test statistic:

p-values:
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	Technical requirements:
c) Both samples random

d) Both populations normal or both 
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	Activity 2-2: Whiskey Prices (cont’d)


a) Compute and record below the value for
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b) Let Y designate the privately owned stores.  Compute and record below the value of T.

c) What is the appropriate alternative hypothesis for testing if states with privately owned stores have higher mean prices than do states with state run stores?

d) Compute and record the p-value for this test.

e) What do you conclude?

f) Construct a 95% confidence interval for the difference in population means.

g) Use SPSS to test whether privately owned stores, on average, charge more than state owned stores.  Summarize your conclusions.  You do this as follows.  

· Choose Analyze > Compare Means > Independent XE "Independent" -Samples T Test to bring up the following dialog box.
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· Enter the variable containing the commuting times in the Test Variable(s) box, and the group identifying variable in the Grouping Variable box.  When you do this for our example, it will look like the above.  The question marks indicate that you need to tell SPSS how to use the grouping variable to assign cases to groups.  

· You do this by clicking on Define Groups to open the following dialog box.
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· You enter the value of the grouping variable that corresponds to group 1 in the Group 1 box and the value that corresponds to group 2 in the Group 2 box.  This dialog box should look like the one shown above.

· Click Continue.  SPSS also computes a confidence interval for the difference between the two population means.  To set the confidence level click on Options to bring up the following dialog box.
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· Enter the desired confidence level, in percent, and click Continue.  

· Click OK to run the test.  SPSS computes the test statistic and p-value in two different ways.  One assumes that the two population standard deviations are equal.  The other assumes that they are not.  The test we have been discussing is the latter.  The results for this test are in the row labeled Equal Variances not Assumed.  Variance XE "Variance"  is the square of the standard deviation.  

SPSS only computes the p-value for the two-sided test.  It is in the Sig. column.  If you are conducting a one-sided test you obtain the p-value as follows.  Assume that p is the reported p-value in the Sig. column of the output..
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Record the p-value for your test in the space below.

How do the SPSS results compare with your hand calculations?

When you look at the SPSS results you will notice that the degrees of freedom used for the procedures that do not assume equal standard deviations is not the same as what we are telling you to use.  What is going on is that researchers have determined that T actually has an approximate t distribution with degrees of freedom equal to
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This is much too complicated for hand calculations.  For this reason most people recommend computing degrees of freedom in the way we present.  This difference in degrees of freedom is the reason the p-value may not exactly match the one you get by hand.
h) Which of the following statements is a correct interpretation of the p-value for this test?

· The p-value is the probability that states with privately owned stores and states with state run stores have the same prices.

· The p-value is the probability of seeing a mean difference in whiskey prices as extreme as this when, in fact, the two types of states have the same prices.

· The p-value is the probability that states with privately owned stores have higher prices than do states with state run stores

· The p-value is the probability of seeing a mean difference in whiskey prices as extreme as this when, in fact, states with privately owned stores have higher prices than do state with state run stores.

i) From the information given we know that we have two random samples, but the two samples sizes do not equal or exceed 30.  This means that we need to assess whether it is reasonable to assume that the populations are normal.  The two histograms shown above do not help much.  There is, however, a much more definitive tool available.  It is called a Q-Q plot XE "Q-Q plot" .  The Q stands for quantile XE "Quantile" , which is a synonym for percentile.  What it does is compare the spacing of percentiles in a normal distribution with the same percentiles in the data by drawing a scatter plot of the normal percentiles against the sample percentiles.  If the spacings are the same the scatter plot will follow a straight line.  Since we are dealing with sample data, we can only expect that a sample from a normal distribution would result in a plot that follows a straight line approximately.  The procedure for obtaining Q-Q plots in SPSS for the two groups is given below.

· In order to get separate plots for each group we need to split the file.  Click on Data > Split File to obtain the following dialog box.
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· Check Organize output by groups and enter the grouping variable in the Groups Based on box.  Click OK.  From here on a separate analysis will be done for each distinct value of the grouping variable.  If you want to reverse this return to Data > Split File and check Analyze all cases, do not create groups and click OK.
· To draw the Q-Q plots click on Analyze > Descriptive Statistics > Q-Q Plots to bring up the following dialog box.
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· Enter the variable whose means are being analyzed in the Variables box.  Verify that Normal appears in the Test Distribution box.  This is the default setting.  Finally click OK and the requested plots will be drawn in an output window.  There are two plots for each group.  The one titled Normal Q-Q Plot is the usual form for a Q-Q plot.  The plot titled Detrended Normal Q-Q Plot is the same plot except the line shown on the Normal Q-Q plot has been made horizontal.

The two plots you get follow a straight line reasonably well, indicating that the two populations follow a normal distribution reasonably well.

	Activity 2-3: Investigating the T Test


We wish to investigate the effect of changing the various elements in the test statistic for the two sample t test.  To assist in this we provide an SPSS script TEST2MEAN.SBS XE "TEST2MEAN.SBS" .  Its use is self-explanatory.  You enter the two sample means, the two sample standard deviations, the two sample sizes, select the appropriate alternative hypothesis, and click OK.  The results will appear in an output window.

a) What would happen to the p-value for a test of 
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if the difference between sample means is increased?  If 10 is added to both sample means?

b) For each pair of populations compute and the p-values of the test in the space provided.

	
	Sample Mean
	Sample Standard

Deviation
	Sample Size
	p-value

	Population 1
	100
	10
	25
	

	Population 2
	105
	10
	25
	

	Population 1
	100
	10
	25
	

	Population 2
	120
	10
	25
	

	Population 1
	110
	10
	25
	

	Population 2
	115
	10
	25
	


Based on what you see comment briefly on the effect of changing the sample means leaving everything else unchanged.  Did the results match your predictions?

c) What would happen to the p-value for a test of 
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if the sample standard deviations are increased?  Decreased?

d) For each pair of populations compute and record the p-values of the test in the space provided.

	
	Sample Mean
	Sample Standard

Deviation
	Sample Size
	p-value

	Population 1
	100
	15
	10
	

	Population 2
	120
	15
	10
	

	Population 1
	100
	25
	10
	

	Population 2
	120
	25
	10
	

	Population 1
	100
	5
	10
	

	Population 2
	120
	5
	10
	


Briefly comment on the effect of changing the sample standard deviation.  Did it match your prediction?

e) What would happen to the p-value for a test of 
[image: image97.wmf]012

:

H

mm

=

 against 
[image: image98.wmf]12

:

a

H

mm

¹

if the sample sizes are increased?  Decreased?

f) For each pair of populations compute and record the p-values of the test in the space provided.

	
	Sample Mean
	Sample Standard

Deviation
	Sample Size
	p-value

	Population 1
	100
	10
	25
	

	Population 2
	105
	10
	25
	

	Population 1
	100
	10
	35
	

	Population 2
	105
	10
	35
	

	Population 1
	100
	10
	15
	

	Population 2
	105
	10
	15
	


Briefly comment on the effect of changing the sample size.  Did it match your prediction?

	Homework Activities


	Activity 2-4:  Lifetimes of Rats and Diet 


A Study was conducted to investigate the effect, if any, of diet on the lifetime of rats.  One group of rats was sampled and placed on a restricted diet.  Another group was sampled and allowed to eat whatever they wanted.  The researchers felt that a restricted diet should promote longevity.  The data are stored in the SPSS file RATS.SAV XE "RATS.SAV" .

a) Should you use the t test with these data?

b) State the null and alternative hypotheses that are appropriate for this experiment.

c) Have SPSS use the t test to test whether a restricted diet increases longevity.  Report the value of the test statistic, the degrees of freedom, and the p-value.  

d) What should you conclude from these data?

e) Construct a 99% confidence interval for the difference between the two means.

	Activity 2-5:  Popes and Monarchs


Do the lifetimes of British monarchs and Popes differ?  A sample of 14 British kings and queens was taken, and a sample of 30 Popes was taken.  The time from their coronation or election until their death was obtained.  The summary statistics are given below.

	Sample
	Sample Size
	Sample Mean
	Sample Standard

Deviation

	Pope
	30
	13.50
	9.21

	Monarch
	14
	22.71
	18.60


a) State the null and alternative hypotheses that are appropriate for this experiment.

b) Compute the standard error for the difference in sample means.

c) Compute the value of the t statistic.

d) Use the t tables to compute the p-value for testing whether the mean lifetime for Popes differs from that of British monarchs. 

e) What should you conclude from these data?

f) Construct a 90% confidence interval for the difference the two mean lifetimes.

	Activity 2-6:  Estimating Length


Three subjects, Graham, Brian, and David, were asked to estimate the length of 15 different lengths of strings.  The question is whether the mean error for Graham and Brian are the same.  The data are stored in the SPSS file STRING.SAV XE "STRING.SAV" .  The variable Length contains the actual length of each piece of string.  The variable Graham contains Graham’s estimate of the length for that piece of string, and the variable Brian contains Brian’s estimate for the length of that piece of string.

a) Create two variables, one containing the difference between the actual length and Graham’s guess, the other containing the difference between the actual length and Brian’s guess.

b) Are the assumptions satisfied for conducting the t test?  Why?

c) Conduct the t test to see if there is a difference in the mean differences for Brian and Graham.  Either have SPSS do the test, or have SPSS calculate the necessary sample statistics and run the test by hand.  Report the value of the test statistic and the p-value.

d) What does this analysis lead you to conclude?

	Activity 2-7:  Gender and Multiple Sclerosis


Do men and women who contract multiple sclerosis tend to get it at the same mean age?  A study of 32 patients who have multiple sclerosis collected the age at which each contracted the disease.  The data are stored in the SPSS file MS.SAV XE "MS.SAV" . 

a) Should you use the t test with these data?  Why or why not?

b) State the null and alternative hypotheses that are appropriate for this question.

c) Have SPSS conduct the t test of whether there is a difference in the mean age at which men and women develop multiple sclerosis.

d) What should you conclude from these data?

	Activity 2-8:  Detecting Autism in Young Children


Currently autism is only detected at about three years of age.  A study was conducted to determine if detection is possible as early as eighteen months.  A sample of 50 randomly selected eighteen month old children was compared to a sample of 41eighteen month old children having an autistic older sibling.  Nine areas of development were measured on each child.  In one of these areas the mean score for the randomly selected children was 94 with a standard deviation of 3.1 while the mean score for the children with an autistic sibling was 97.5 with a standard deviation of 2.7.  Do these data indicate that there is a difference in this trait between the two groups of children?

Topic 3

Comparing Two Means—Power XE "Power"  

	OVERVIEW


You have been introduced to the concepts that underlie hypothesis testing.  You have seen techniques that apply to testing hypotheses concerning proportions from one and two groups and means from one and two groups.  In this topic we shall introduce a second method for testing the equality of two independent population means.  It is appropriate when both groups have the same population standard deviation.  We shall compare it with the procedure you learned in the Topic 2.  This comparison will be based on the concept of the power of a testing procedure.  Roughly speaking, power is the proportion of the time a testing procedure correctly rejects a false null hypothesis.  Recall that significance XE "significance"  is the proportion of the time a testing procedure incorrectly rejects a true null hypothesis.

	OBJECTIVES


· To learn a second procedure for determining whether two independent population means differ.

· To learn to use graphical and numerical methods to determine if population standard deviations can be assumed to be equal.

· To investigate the proportion of the time tests correctly reject the null hypothesis of equality of means.

· Develop an understanding of the concept of the power of a test and why it is important.

	PRELIMINARIES


a) Do you think that women tend to go to a college that is farther from home than do men?
b) Do you think that every woman goes to a college that is farther from home than for every man?
c) By how much, if any, do you think women tend, on average, to go to a college that is farther from home than for men?
d) Record below the distance it is from home, in miles, for each student in your class.  Also record the gender of each student.

	Student
	Gender
	Distance
	Student
	Gender
	Distance
	Student
	Gender
	Distance

	1
	
	
	11
	
	
	21
	
	

	2
	
	
	12
	
	
	22
	
	

	3
	
	
	13
	
	
	23
	
	

	4
	
	
	14
	
	
	24
	
	

	5
	
	
	15
	
	
	25
	
	

	6
	
	
	16
	
	
	26
	
	

	7
	
	
	17
	
	
	27
	
	

	8
	
	
	18
	
	
	28
	
	

	9
	
	
	19
	
	
	29
	
	

	10
	
	
	20
	
	
	30
	
	


	IN-CLASS ACTIVITIES


	Activity 3-1:  Hypothetical Times Spent on E-Mail


Twenty female students and twenty-five male students at a particular college were polled as to how long they spent reading and sending e-mail in a typical day.  The results are shown in the following table.  The data are stored in the SPSS file HYPOMAIL.SAV XE "HYPOMAIL.SAV" .  

	Gender
	Time
	Gender
	Time
	Gender
	Time

	     F   
	18
	F
	14
	M
	7

	F
	15
	F
	14
	M
	11

	F
	16
	F
	17
	M
	10

	F
	15
	F
	14
	M
	15

	F
	19
	F
	14
	M
	11

	F
	11
	M
	14
	M
	13

	F
	14
	M
	11
	M
	11

	F
	18
	M
	6
	M
	13

	F
	16
	M
	14
	M
	13

	F
	23
	M
	11
	M
	9

	F
	17
	M
	11
	M
	10

	F
	20
	M
	19
	M
	6

	F
	18
	M
	9
	M
	10

	F
	13
	M
	11
	M
	10

	F
	15
	M
	19
	M
	10


a) Histograms for these data are shown below.  Do the plots indicate that there appears to be a difference in the time spent in e-mail activities between the sexes?
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b) Use SPSS to compute the means and standard deviations for each sex.  Complete the following table.

	Gender
	Sample

 Size
	Sample 

Mean
	Sample

 Standard Deviation

	Female


	20
	
	

	Male


	25
	
	


c) Do the statistics computed seem to lead to a conclusion that is consistent with the one you arrived at using the histograms?  If not, what do you think is going on here?

d) Do the sample standard deviations computed in part (b) and the histograms make it appear reasonable to assume that the two populations of times have the same standard deviation?

Recall from Topic 2 that merely having the two sample means be different is not enough to permit us to conclude that the population means differ.  The difference observed could be accounted for by the fact that there is sampling variability.  We can, however, use a test of hypotheses to find out if the observed difference in the sample means is “significant.”  A confidence interval can be used to estimate the difference.

It turns out that, if we can assume that the two population standard deviations are equal, there are procedures that can make use of this fact.  These procedures will, in general, perform better than those given you learned in the first course.  By “perform better” we mean that significance tests will correctly reject the null hypothesis more often at the same significance level and confidence intervals will have the same confidence level and be narrower.  In fact, it is a general principle that procedures that make use of more information about the target population will perform better than those that do not.

The parameters and statistics are the same as we used in Topic 2.  We repeat them here for convenience.

	
	Group One (X)
	Group Two (Y)

	Population Mean
	


	



	Population Standard Deviation
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	Sample Size
	


	



	Sample Mean
	


	



	Sample Standard Deviation
	


	




When it is safe to assume that the two population standard deviations are equal this common standard deviation is estimated by what is commonly referred to as the pooled standard deviation XE "pooled standard deviation" , or 

.  The formula for this is

	Pooled Standard Deviation
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The pooled standard deviation is then used to compute the standard error of 

  Statisticians use the term standard error XE "standard error"  in order to distinguish between the standard deviation associated with a statistic that is computed using sample data from the standard deviation of observations drawn from a population.  In this setting, populations have standard deviations, and statistics have standard errors.  In Topic 2 the standard error of 

was given by the formula




When it is safe to assume that the population standard deviations are equal the standard error of 

is again denoted by 

and is computed by



	Standard Error of 







Recall that for all of the confidence intervals we shall discuss, it is a general rule of thumb that a confidence interval is obtained by

statistic 
[image: image103.wmf]±
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Using this principle we give the following formula for the confidence interval for

.

	Confidence Interval for 

 XE "Comparing two means, confidence interval" 
When 

 and 

have normal distributions and both populations have the same standard deviation, a confidence interval for 

 is given by




Here, t* is the appropriate critical value for a t distribution with 

degrees of freedom.

Technical Requirements:

a) Both samples random.
b) Either both populations are normal or both 
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[image: image105.wmf].

XY

ss

=




As before, the two sample means will have a normal distribution if, either both populations have a normal distribution, or if the sample sizes are greater than or equal to 30.

We also give the procedure for testing the null hypothesis that
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.  It is commonly called the pooled t test XE "pooled t test" .

	Testing XE "Comparing two means, test" 
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	Test statistic:

p-values:
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	Technical requirements:
a) Both samples random
b) Both populations normal or both 
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Since we are using samples to assess population quantities, it is reasonable to expect that sampling variation will result in differences between the two sample standard deviations.  Therefore, a logical question is what range of values for the sample standard deviations is still consistent with an assumption of equal population standard deviations.  Statisticians have studied this question and have found that, as long as 

and 

differ by no more than a factor of 2, it is generally reasonable to assume that the two population standard deviations are equal.  There are more formal procedures than can be used, but this rule of thumb has been found to work pretty well in practice.

	Rule of Thumb

It is generally safe to consider that 
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	Activity 3-2: Hypothetical e-mail Times (cont’d)


a) Do the standard deviations of the two samples of e-mail times indicate that that we may assume that the population standard deviations are equal?

b) Compute and record below the value for
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f) Let Y designate the women.  Compute and record below the value of T.

g) What is the appropriate alternative hypothesis for testing if women students spend more time on e-mail than do the men?

h) Compute and record the p-value for this test.

i) What do you conclude?

j) Construct a 90% confidence interval for the difference in the mean e-mail times.

k) Use SPSS to test whether women students spend more time, on average, than men students reading and answering e-mail. You do this in the way we described in Topic 2.   Summarize your conclusions.  

Recall that SPSS only computes the p-value for the two-sided test.  If you are conducting a one-sided test you obtain the p-value as follows.  Assume that p is the reported p-value.
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If t < 0, then p-value = p/2.
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Compute and record the p-value for your test in the space below.

How do the SPSS results compare with your hand calculations?

	Activity 3-3:  Hypothetical e-mail Times (cont’d.)


a) SPSS computes the t procedure we are introducing here as well as the t procedure presented in Topic 2.  Record the results of the unpooled test below.  It is the test labeled Equal variances not assumed. 

b) Compare your results with those of Activity 3-2.

In Activity 3-2 and Activity 3-3 you should have concluded that female students do spend more time with e-mail than do men students.  This naturally leads to the question of why we should bother with two different techniques when they lead to the same conclusion.  The point is that this will not always be the case.  The goal in any test is that we be able to determine, correctly, whether or not the null hypothesis is true.  No testing procedure will always be correct in its conclusions.  Given this, we search for procedures that, on average, make the fewest number of mistakes.  The notion of significance is aimed at making sure that we conclude incorrectly the null hypothesis is not true a small proportion of the time.  A 5% significance level assures that we will erroneously reject the null hypotheses no more than 5% of the time.  The other half of the problem is insuring that we can correctly determine that the null hypothesis is not true.  This leads to the notion of the power of a test.  Roughly speaking, power is the proportion of the time that a test correctly rejects the null hypothesis.  The definition is then as follows.

	Power XE "Power" 
For a test with a fixed significance level, the power of the test is the probability of finding a significant result when the null hypothesis is false.


Since it is possible to achieve any desired significance level, the goal in statistics is to find and use procedures that have the highest power.  It turns out that, in general, procedures that use the most information about the populations from which the samples are drawn will have the higher power.  For our purposes this means that, when two populations have the same standard deviation, a procedure that is makes use of this will be more powerful than one that is not.

	Activity 3-4:  Investigating Power XE "Power" 


a) Use the computer to run the following simulation.  Let two independent populations have a common standard deviation of 1.  Let the mean of one population be 10, and let the mean of the other vary as shown in the following table.  Now conduct 1000 tests of the null hypothesis that the two means are equal against the alternative hypothesis that they are not equal.  To assist in this we provide the SPSS script POWER.SBS XE "POWER.SBS" .  When you run the script enter the values for 

and 

in the appropriate box and click OK to run the script.  The script will conduct 1000 tests of 
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 for the population means entered in the dialog box and determine how many of these are significant at the .05 level.  The results will appear in an output window.  The script computes and reports the proportion of the time that the pooled testing procedure presented in this topic and the unpooled testing procedure given in Topic 2 reject the null hypothesis.  Tabulate the proportion of the time that each rejects the null hypothesis.

	


	
	Proportion of the Time the 

Null Hypothesis is Rejected

	


	


	Test Assuming Equal

Standard Deviations
	Test Not Assuming Equal

Standard Deviations

	10


	10
	
	

	10


	10.5
	
	

	10


	11
	
	

	10


	12
	
	


b) How do you interpret the entries when both population means are 10?

c) What happens as the difference between the two means increases?
d) Based on the data in the table in part (a), which test procedure appears to have the greatest power?

	Homework Activities


	Activity 3-5:  Memorization Methods


An experiment was conducted to determine if there is a difference in the effectiveness of two methods for memorizing items.  One method is to repeat the thing to be memorized as many times as possible (repetition).  The other method is to create a mental picture (visualization) of the item to be memorized.  In the experiment 54 randomly selected people were asked to memorize word pairs (e.g. DOG—CAT).  Repetition was to be used by 27 of the subjects and visualization by the remaining 27 subjects.  There were 12 word pairs to be memorized.  Each subject was then shown one member of each pair and asked to give the other member.  The data can be found in the SPSS file MEMORY.SAV XE "MEMORY.SAV" .

a) Should you use the pooled t test or the unpooled t test with these data?
b) State the null and alternative hypotheses that are appropriate for this experiment.
c) Have SPSS use the appropriate t test to test whether one memorization method is superior to the other.  Report the value of the test statistic and the p-value.

d) What should you conclude from these data?
e) Construct a 95% confidence interval for the difference between the two population means.
	Activity 3-6:  Memorization Methods (cont’d.)


In addition to recording the memorization method in the experiment described in Activity 3-5, the gender each subject was reported.  There were 34 women and 20 men in the experiment.  We wish to determine if women are superior to men in the ability to memorize word pairs.  The summary statistics are given below.

	Sample
	Sample Size
	Sample Mean
	Sample Standard

Deviation

	Men
	20
	5.2
	4.073

	Women
	34
	7.5
	2.733


a) Explain why you are justified in concluding that the assumptions for the pooled t test have been met.
b) State the null and alternative hypotheses that are appropriate for this experiment.
c) Compute the pooled standard deviation.
d) Compute the standard error for the difference in sample means.
e) Compute the value of the t statistic.
f) Use the t tables to compute the p-value for testing whether women are superior to men in the ability to memorize word pairs.
g) What should you conclude from these data?
h) Construct a 90% confidence interval for the difference between the two means.
	Activity 3-7:  Television Ratings


The SPSS file RATINGS.SAV XE "RATINGS.SAV"  contains the 45 highest rated television shows of all time along with the network on which it aired and the rating in terms of percent of all households owning television sets that viewed the program.  We wish to determine if NBC and CBS have the same average rating among these 45 shows.  

a) Are the assumptions satisfied for conducting the pooled t test? The unpooled t test?  Why?
b) If your answer to part (a) was “no,” identify and remove any outliers in the data.  Now what is your answer to part (a)?
c) Which t test, if any, should you conduct?
d) If any t test is appropriate, have SPSS conduct the most appropriate test to see if there is a difference in the mean ratings for NBC and CBS.  Report the value of the test statistic and the p-value.
e) What does this analysis lead you to conclude?

	Activity 3-8:  Television Ratings (cont’d.)


We wish to determine if, among the top 45 television shows, sports programs have a higher average rating than non-sports programs.  

a) Should you use the pooled t test or the unpooled t test with these data?  Why?
b) If not, what can you do, if anything, to satisfy the assumptions?  If something can be done, go ahead and do it.  Explain what you did.
c) State the null and alternative hypotheses that are appropriate for this question.
d) Have SPSS conduct the appropriate t test of whether sports programs received a higher average rating than non-sports programs.
e) What should you conclude from these data?

	Activity 3-9:  Heights of Singers 


Are men who sing bass taller than men who sing tenor?  The SPSS file CHORAL.SAV XE "CHORAL.SAV"  contains the heights of members of the New York Choral Society in four pitch ranges—Tenor 1, Tenor 2, Bass 1 and Bass 2.  We are interested in whether Bass 1 singers are taller, on average, than Tenor 1 singers.

a) Are the assumptions met for conducting either t test?  If so, which one(s)?  If not, why not?

b) Which t test should you use, if any?

c) State the null and alternative hypotheses that are appropriate for this question.

d) Have SPSS conduct the appropriate t test, if any.  Report the value of the test statistic and the p-value.

e) What should you conclude from these data? 

f) Construct a 99% confidence interval for the difference between the mean heights.

	Activity 3-10:  Distance from Home


The data collected in the preliminary give the distances from home for students in your class separated according to gender.  We wish to see if the average distance from home is the same for both men and women.

a) Assuming that we can view the members of this class as constituting a random sample, what is the population?  Students at your school?  College students in the United States?  College students throughout the world?

b) Which two sample t test should you use with these data?  Why?

c) State the null and alternative hypotheses that are appropriate for this question.

d) Have SPSS conduct the appropriate t test.  Report the value of the test statistic and the p-value.

e) What should you conclude from these data?
Topic 4

Testing Medians—One Population

	OVERVIEW


The testing procedures for population means that you have been introduced to in the first course and in Topic 2 and Topic 3 of this course have required that the population satisfy certain conditions.  Each testing procedure needed to meet some requirements to insure that the sample means used had, at least approximately, a normal distribution.  The test given in Topic 3 further required that the population standard deviations be equal.  

There are times when it is impossible to assure that these requirements are satisfied.  In order to analyze the "center" of the distribution in these cases we must shift our attention from the population mean to the population median.  Recall that when the distribution is symmetric, the mean and the median are identical.  There are a number of tests for the population median that do not require that we know anything about the distribution of the population.  They are collectively referred to as nonparametric tests XE "nonparametric tests" .  In this topic we will introduce you to the Wilcoxon Signed Rank Test.  It is one of the most popular nonparametric tests for a single median.

	OBJECTIVES


· Introduce you to the general ideas underlying rank tests.

· Introduce you to the Wilcoxon Signed Rank Test.

	PRELIMINARIES


a) Do you think the average (median) student has two siblings?

b) Record in the table below the number of siblings each student in your class has.

	Student
	# Siblings
	Student
	# Siblings
	Student
	# Siblings

	1
	
	11
	
	21
	

	2
	
	12
	
	22
	

	3
	
	13
	
	23
	

	4
	
	14
	
	24
	

	5
	
	15
	
	25
	

	6
	
	16
	
	26
	

	7
	
	17
	
	27
	

	8
	
	18
	
	28
	

	9
	
	19
	
	29
	

	10
	
	20
	
	30
	


c) If the median student does have two siblings, what proportion of them should have two or more siblings?  Two or fewer siblings?

	IN-CLASS ACTIVITIES


The idea behind the so-called rank tests XE "rank tests"  is to replace the numerical value of the observations with their ranks.  What this means is that the smallest observed value will receive a rank of 1, the second smallest observed value will receive a rank of 2, and so on.  The difference in the various rank tests is exactly what quantities get ranked.  In any case, these ranks become the numbers that are processed to obtain the quantity whose p-value is computed.

	Activity 4-1:  Computing Signed Ranks


The data shown in the following table are a random sample from a hypothetical population.  We wish to test the hypothesis that the "average" value of the population is 5.

	Sample
	Value
	Sample
	Value
	Sample
	Value
	Sample
	Value

	1
	10
	6
	34
	11
	13
	16
	6

	2
	9
	7
	2
	12
	2
	17
	0

	3
	7
	8
	3
	13
	13
	18
	9

	4
	11
	9
	42
	14
	2
	19
	22

	5
	21
	10
	9
	15
	5
	20
	10


a) Enter the data into SPSS and draw a Q-Q plot against a normal distribution.  Does it appear that the t-test discussed in the first course should be applied to these data?  Why or why not?

Since the sample size is less than 30, you can use the t-test only if it is safe to assume that the population distribution is normal.  Based on the Q-Q plot you should have concluded that this assumption is questionable.
In such a situation we would like to have a testing procedure that does not require the assumption of a normal population distribution.  To do this we shall test the population median rather than the population mean.  To be able to formulate the problem mathematically we need to introduce some notation.

	Population Median XE "Population Median" 
The median of a population will be denoted by
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Using this notation, we will be testing
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There are adaptations of the procedure we will present that handle the one-sided alternatives.  As is usual the differences involve how the p-value is computed.  The remaining activities will walk you through the process needed to use the Wilcoxon Signed Rank Test.
The first task is to assign each observation an appropriate rank.  This is done by first determining how far away, in absolute value, each observation is from the hypothesized median.  We also keep track of whether each observation was above or below the hypothesized median.  Any observation that is exactly equal to the hypothesized median will be discarded.  Observations below the hypothesized median will be given a minus (-) sign.  Observations above the hypothesized median will be given a plus (+) sign.  The number of observations remaining after this process will be denoted by n.  The n distances are then assigned ranks.  The observation with the smallest absolute distance will be given a rank of 1.  The observation with the second smallest absolute distance will be given a rank of 2, and so on.  The observation with the greatest absolute distance will be given a rank of n.  In the case when more than one observation has the same absolute distance we must do the following.  Observations having the same absolute distance are said to be tied XE "Tied" .  Determine what ranks these tied observations would have received had they been different.  Then give each tied observation the average value of those ranks.  

For example, the set of values 5, 7, 7, 8, 9, 9, 9, 10 would be assigned ranks as shown in the table below.  Note that n is 8.

	Value
	Rank

	5
	1

	7
	(2 + 3)/2 = 2.5

	7
	(2 + 3)/2 = 2.5

	8
	4

	9
	(5 + 6 + 7)/3 = 6

	9
	(5 + 6 + 7)/3 = 6

	9
	(5 + 6 + 7)/3 = 6

	10
	8


	Activity 4-2:  Computing Signed Ranks (Cont'd.)


For the problem begun in Activity 4-1 we will be testing
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That is 
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a) For each observation in the data set complete the following table.

	Observed Value

x
	Distance
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	Absolute Distance




	Sign
	
	Observed

Value

x
	Distance
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	Sign

	10


	
	
	
	
	13
	
	
	

	9


	
	
	
	
	2
	
	
	

	7


	
	
	
	
	13
	
	
	

	11


	
	
	
	
	2
	
	
	

	21


	
	
	
	
	5
	
	
	

	34


	
	
	
	
	6
	
	
	

	2


	
	
	
	
	0
	
	
	

	3


	
	
	
	
	9
	
	
	

	42


	
	
	
	
	22
	
	
	

	9


	
	
	
	
	10
	
	
	


b) In the table below write the absolute distances that are not equal to zero in ascending order.  Write the signs associated with each one, and then assign ranks to the absolute distances

	Absolute Distance
	Sign
	Rank
	
	Absolute

Distance
	Sign
	Rank

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	


The Wilcoxon signed rank test XE "Wilcoxon signed rank test"  is based on the idea that, when the null hypothesis is true, the observations should be evenly scattered about the hypothesized median.  This translates into the idea that, if we were to sum the ranks of those observations that were above
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, and sum the ranks of those observations that were below
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, both sums should be about the same.  Theoretically they should, on average, be the same, but sampling variation will cause differences.  Thus, if the sum of the ranks of the observations greater than 
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—those with a plus (+) sign—is very large or very small we will have evidence against the null hypothesis.  This means that our test statistic will be

W = sum of ranks receiving a + sign.

Since large values or small values of W are evidence against the null hypothesis, the p-value will be computed as follows.  

Assume that a given sample results in W having a value of w.  It turns out there are two cases to be considered.  They depend on whether w is greater or less than 
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W has a distribution that is different from those we have seen previously.  This means that we need a separate table to calculate p-value.  Such a table is given Table V.  This table gives the probability that W will be greater than or equal to w for various values of w for n ranging from 3 through 20.  For lower tail probabilities we use the table as follows.
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To illustrate the computation, we shall calculate the p-value if n = 10 and w = 14.  So, 
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So, based on this sample, there is no evidence against the null hypothesis.

	Activity 4-3:  Computing p-value for the Signed Rank Test


a) What is the value of n from Activity 4-2?  Compute 

.
b) Compute the value of w.
c) Use the procedure outlined above to determine the p-value for the Wilcoxon Signed Rank Test.  What do you conclude with regard to the truth of the null hypothesis?
We shall now summarize the procedure for conducting the Wilcoxon Signed Rank test.  In addition, we shall show the formulas for computing the p-values for the one-sided tests.

	Wilcoxon Signed Rank Test XE "Wilcoxon Signed Rank Test" 
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1. Give each observation above 
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a plus (+) sign.  Give each observation below 
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a minus (-) sign.  Discard each observation equal to
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. Let n be the number of observations receiving a sign.
2. Compute the absolute distances from the hypothesized median, 
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. 
3. Order the absolute distances and assign ranks.
4. Let W = sum of ranks having a plus (+) sign.
5. Use Table V to compute the p-value according to the following table. 
p-value:
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Technical Requirements:
a) Random sample.


Table V only goes up to n = 20.  It is natural to ask what can be done in those cases when n is between 21 and 29, and it is not safe to assume the population distribution is normal.  In these instances it is possible to use an approximate normal distribution.  It turns out that when n > 20, the distribution of W is approximately normal with a mean of
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.  Thus, we can conduct the test using the z statistic
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Thus, if we let z be the value of Z computed for a given sample the p-values are calculated as follows.

	Large Sample Approximation for the

Wilcoxon Signed Rank Test XE "Wilcoxon Signed Rank Test, large sample" 
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Test Statistic:
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p-value:
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Technical Requirements:
a) Random sample.

b) 
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	Activity 4-4:  Using the Normal Approximation


Even though n = 19 in the data from Activity 4-1 we will use the normal approximation just to illustrate the procedure.  We will use the z test to assess whether the population median is 5.  Compare your results with those from Activity 4-3.

a) Transcribe the value of
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from Activity 4-3.

b) Compute and record the value of
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c) Compute and record the value of Z.
d) Compute and record the p-value for your test.

e) How does this result compare with the one you obtained in Activity 4-3?

SPSS conducts the Wilcoxon Signed Rank Test.  However, the situation is for matched pairs.  Recall from the first course that the situation was that you were testing for the equality of means for two groups where there was a natural pairing between each member of one group and a corresponding member of the other group.  We can use this procedure to test a single median by creating a new variable that contains the value of 
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for each case.  

· In our example we would create a variable where each entry was a 5.  You do this by using Transform > Compute as follows.
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· Now click on Analyze > Nonparametric Tests> 2 Related Samples to bring up the following dialog box.
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· Select the column containing the data and the column containing 
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as shown.  Make sure that Wilcoxon is checked and click OK to run the test.  SPSS conducts the Z test 
	Activity 4-5:  Using SPSS to Conduct the Wilcoxon Signed Rank Test


a) Open the SPSS data file Activity 4-1.SAV.  Create a new variable nullmed that has a value of 5 for all cases.  Have SPSS conduct the test of 
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.  Your results should look like the following.

Wilcoxon Signed Ranks Test
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The output contains the following information.

· The null hypothesis.

· The sample size and the value of n.

· The sum and mean of the positive ranks

· The sum and mean of the negative ranks

· The value of Z using the positive rank sum.  If the output states that the value of Z is based on negative ranks, the value of Z will have the opposite sign from the one you compute by hand using positive ranks.
· The p-value for the 2-tailed test.  (Asymp. Sig.)

If you want the p-value for a one-sided alternative, use the displayed p-value as shown below.
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	If Z > 0, then p-value = Asymp. Sig/2

If Z < 0, then p-value = 1 – Asymp. Sig./2
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	Activity 4-6:  Signed Rank Test for Matched Pairs


You will recall from the first course that the single sample t test could be used to test the equality of the mean of two groups when there was a natural pairing between members of both groups.  The Wilcoxon Signed Rank test can also be used in a similar manner.  The following table shows the percentage of the population that was below the poverty line for states in the Northeast in 1997 and 1998.

	State
	1997
	1998
	Diff.
	
	State
	1997
	1998
	Diff.

	CT


	10.1


	9.0
	
	
	NY
	16.6
	16.6
	

	MA


	11.2
	10.4
	
	
	RI
	11.9
	12.2
	

	ME


	10.7
	10.2
	
	
	VT
	10.9
	9.6
	

	NH


	7.7
	9.4
	
	
	
	
	
	


a) For each state subtract the 1998 percentage from the 1997 percentage.  Record the results in the table above.

b) We will test 
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.  Assign ranks to the differences using the method described in Activity 4-2.

	Abs. Diff.


	
	
	
	
	
	
	

	Sign


	
	
	
	
	
	
	

	Rank


	
	
	
	
	
	
	


c) Compute W and the p-value.

d) What do you conclude?

e) These data are stored in the SPSS data file POVERTY.SAV XE "POVERTY.SAV" .  Open the file and delete all but the seven states from the Northeast.  Use Analyze > NonParametric Tests > 2 Related Samples to test 
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.  For your pairs you will select the variables Year1 and Year2.  How do the SPSS results compare with those you found by hand??

	Homework Activities


	Activity 4-7:  Number of Children


A national survey has found that the median number of children in American households is 2.   We wish to see if the sample of class members supports this finding.  That is, we want to test whether the median number of children in a family is 2 or not.

a) State the null and alternative hypotheses that are appropriate for this question.

b) Compute the value of the Wilcoxon Signed Rank Test statistic by hand.  Show your work.

c) Is the normal approximation appropriate in this case?

d) If the normal approximation is appropriate, use it to compute the p-value for the test.  If not, use Table V to compute the p-value.

e) What do you conclude?

	Activity 4-8:  Reading Scores


The SPSS data set SCHOOLTESTS.SAV XE "SCHOOLTESTS.SAV"  contains the average state scores on a reading test for fourth graders in 1998 and for eighth graders in 1998.  It is of interest to determine if the eighth graders score higher than the fourth graders.  We will use paired comparisons and the Wilcoxon Signed Rank Test.

a) What are the appropriate null and alternative hypotheses for this question.

b) Have SPSS conduct the Wilcoxon Signed Rank Test on the differences.  Report the value of Z and the p-value.

c) What do you conclude?

d) Do you feel that it is legitimate to consider this to be a random sample?  Why or why not?

	Activity 4-9:  Response Times


An experiment was conducted to determine if people react more quickly to a visual stimulus than an audio stimulus.  Theory suggests that reactions should be faster for the audio stimulus.  A sample of 58 randomly selected subjects were exposed to a visual stimulus and asked to push a button as soon as possible after noting the stimulus.  The time between onset of the stimulus and pressing the button was measured.  The same 58 subjects also had their reaction time measured using the audio stimulus.  The order in which this was done differed randomly from subject to subject.  The results are given in the SPSS data set RESPONSE.SAV XE "RESPONSE.SAV" .

a) What do you think the purpose was in changing the order of the stimuli?

b) Is this a matched pairs experiment?

c) What are the appropriate null and alternative hypotheses for this experiment.

d) Use SPSS to conduct the Wilcoxon Signed Rank Test with these data.  Summarize your results.

e) Do the data support the theory?

	Activity 4-10:  Poverty in the United States


We wish to see if the number of people in the United States in poverty is declining.  The SPSS data set POVERTY.SAV XE "POVERTY.SAV"  gives the percentage of people in each state that were in poverty in 1997 and in 1998.  The question is whether the median percentage of people below the poverty limit declined from 1997 to 1998.

a) Have SPSS randomly select 15 states.  You do this by clicking Data > Select Cases.  Check Random Sample of Cases then click .  In the dialog box that appears indicate that you want Exactly 15 cases from the first 51 cases.  Then click Continue followed by OK to take your sample.  List which 15 states were in your sample.

b) What are the appropriate null and alternative hypotheses?

c) Use SPSS to conduct the Wilcoxon Signed Rank with this sample.  Summarize your results.

d) Did the percentage of people on poverty decline from 1997 to 1998?

	Activity 4-11:  Shoshone Indians


In mathematics, the so-called “golden ratio” is 
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.  The ancient Greeks referred to a rectangle whose length-to-breadth ratio was this value as being a “golden rectangle.”  In fact, they used it when building structures such as the Parthenon.  The Shoshone Indians decorated their leather goods with beaded rectangles.  Anthropologists were interested in whether it is reasonable to suppose that the Shoshone’s used the golden ratio when they made their beaded rectangles.  Below are the length-to-breadth ratios of 20 Shoshone beaded rectangles.  The data are also stored in the SPSS data set SHOSHONE.SAV XE "SHOSHONE.SAV" .  

	0.693
	0.662
	0.690
	0.606
	0.570

	0.749
	0.672
	0.628
	0.609
	0.844

	0.654
	0.615
	0.668
	0.601
	0.576

	0.670
	0.606
	0.611
	0.553
	0.933


a) Use the Wilcoxon Signed Rank test to determine whether it is reasonable or not to conclude that the golden ratio was used. 

b) Could you or should you have used the t test here?

Topic 5

Comparing Two Medians

	OVERVIEW


In the previous topic we introduced the idea of using test statistics based on ranks for testing hypotheses regarding medians when the normality assumption for the t test is not justified.  It turns out that there is a rank based alternative to the two sample t tests discussed in Topic 2 and Topic 3 of this text.  It is known as the Wilcoxon Rank Sum Test.  It requires only that the two populations be independent and that random samples are taken from each.

	OBJECTIVES


· To learn how to test the equality of two population medians using ranks.

· Learn the Wilcoxon Rank Sum Test.

	PRELIMINARIES


a) Suppose the median of Population 1 is higher than that of Population 2 and you have a random sample of 5 observations from each one.  Would you expect that more of the observations from Population 1 would be higher than those from Population 2?

b) How much cash do you have with you?  Record the amount and gender for each member of your class in the table below.

	Gender
	Amount
	Gender
	Amount
	Gender
	Amount

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	


	IN-CLASS ACTIVITIES


	Activity 5-1:   Computing the Rank Sum Statistic


a) Open the SPSS data set POVERTY.SAV XE "POVERTY.SAV" .  This file gives all 50 states and the District of Columbia showing the percentage of the population below the poverty line in 1997 and in 1998.  In the table below write the 1998 percentage below poverty for the following states in the Northeast and in the Southeast.

	Northeast
	ME
	MA
	VT
	NH
	RI
	CT
	NY

	Percent


	
	
	
	
	
	
	

	Southeast
	LA
	MS
	AL
	GA
	TN
	
	

	Percent


	
	
	
	
	
	
	


b) Place the percentages in ascending order, underlining the percentages belonging to the northern states.

c) Recall from Topic 4 how to assign ranks to sorted data.  Assign ranks to the above data and write the ranks below each percentage.

d) Sum the ranks of the northern states.  Call this sum R.  

e) Let m designate the number of northern states, and compute 
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The quantity you have just computed is known as the Wilcoxon Rank Sum statistic.  It is used to conduct a test that of the null hypothesis that the medians of two independent populations are equal to each other.  The idea behind this procedure is quite straightforward.  Suppose two populations have the same median, and we have equal size samples from each.  In this case, observations from the two populations should be randomly mixed together.  This would mean that computing the rank sum, R, for the observations from one population should result in a value roughly the same as computing the rank sum for the observations from the other population.  Now, suppose the median of Population 2 is higher than that of Population 1.  Then the observations from Population 2 should show a statistical tendency to be higher than those from Population 1.  In such an instance, the rank sum, R, for the observations from Population 2 should be higher than the rank sum for the observations from Population 1.

Thus, the Wilcoxon Rank Sum test uses one of the rank sums.  For the purposes of running the test we shall designate the population from which the larger sample is drawn as Population 2.  The number of observations from Population 2 will be denoted by m, and the number of observations from Population 1 will be denoted by n.  The only reason we need to do this is to make it easier to construct tables for computing the p-value of the test.  This is also the reason why we subtract the quantity 
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from the sum of the ranks.

The only remaining issue is how we can compute p-values for this test.  For small samples, the exact distribution of 
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 is known.  Table VI gives percentage points for the Wilcoxon Rank Sum statistic.  For given values of m and n the entry in a column gives the value w for 
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 that has an upper tail probability roughly equal to the p value at the top of the column.  When the actual p value is different than the column heading it is placed in parenthesis next to the value for w.  For example, with m=8 and n=5, the table shows that 
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	Activity 5-2:  Using Table VI


a) Let m = 6 and n = 3.  Find 
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b) Let m = 9 and n = 7.  Find 
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c) Let m = 8 and n = 8.  Find c such that 
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d) Let m = 7 and n = 4.  Approximate as best as possible 
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e) Let m = 5 and n = 4.  Approximate as best as possible 
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We can now see how to use Table VI to compute the p-value for the Wilcoxon Rank Sum test XE "Wilcoxon Rank Sum test" .  We summarize the procedure below.

	Wilcoxon Rank Sum Test XE "Wilcoxon rank sum test" 
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1) Let Population 1 be associated with the smaller sample size.  Let Population 2 be associated with the larger sample size.  Let n = sample size from Population 1, and m = sample size from Population 2.

2) Combine both samples, keeping track of the parent population for each observation and assign ranks to the combined samples.

3) Let R = sum of the ranks from Population 2.

4) Compute 
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 Call this value w.

5) Compute the p-value in the following manner using Table VI.
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	Technical Requirements:
a) Both samples are random.


	Activity 5-3:  Computing the p-value


a) What are the values for m and n for testing that the median poverty level for the southern states is different than that for the northern states?

b) Use these values and Table VI to compute the p-value  for testing 
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c) What do you conclude?

	Activity 5-4:  Using SPSS to Conduct the Wilcoxon Rank Sum Test


a) Create a new variable called Region. .  For the states in our sample from the Northeast, assign a value of 1, and for the states in our sample from the Southeast, assign a value of 2.  Leave the remaining states empty.  As a general rule, in order to have SPSS results correspond to those you would do by hand, make sure that group that you would label as group 1 has the lower value of the two.

b) Use SPSS to conduct the test of  
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as follows.  SPSS runs the Wilcoxon Rank Sum Test.  The two samples must be in a single variable with a separate group identifying variable.  This is the same setup that you used for the two-sample t procedures.  Proceed as follows.

· Click on Analyze >Nonparametric Tests > 2 Independent XE "Independent"  Samples to bring up the following dialog box.
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· Select the variable to be analyzed (1998) in the Test Variable List box.  

· Select the group identifying variable (Region) for the Grouping Variable box.  You will notice that Region appears as Region(?,?).  Click Define Groups to open the following dialog box.
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· You enter the value of Region that corresponds to group 1 and the value of Region that corresponds to group 2 as shown above.  This is the same procedure you used to define groups for the independent samples T test.  

· Click Continue, Make sure that Mann-Whitney U is checked, and click OK to run the test.  The test statistic that we are using is also referred to as the Mann-Whitney U test statistic.  In any event, you should see output like the following.

Mann-Whitney Test
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The output contains the following information.

· The sample size, mean rank, and rank sum for each group.

· The quantity Mann-Whitney U is the value of W*.

· The quantity Wilcoxon W is the rank sum of the group with the smallest value of the grouping variable.  In this case that is the Northeast region.

· There is a normal approximation for larger sample sizes that we will cover shortly.  Z is the value of that statistic.

· The quantity Asymp. Sig. (2-tailed) is the two-tailed p-value using the normal approximation.

· The quantity Exact Sig. [2*(1-talied Sig.)] is the two-tailed p-value for the test using the exact distribution.  When the sample sizes get large this value is not displayed.

If you are testing for a one-sided alternative hypothesis, you get the one-sided p-values using the displayed p-value as shown in the following table.  You may use either the asymptotic significance value or the exact significance value.
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	If Z > 0, then p-value = Sig/2

If Z < 0, then p-value = (1 – Sig.)/2
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:
	If Z < 0, then p-value = Sig/2

If Z > 0, then p-value = (1 – Sig.)/2


When the values of m and n are beyond those covered by Table VI, we can make use of the fact that 
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 has an approximate normal distribution.  When m and n are greater than 10, 
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 will have a distribution that is approximately normal with a mean of
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This means that we can use 
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as a test statistic.  The large sample procedure is summarized below.

	Large Sample Test for XE "Wilcoxon rank sum test, large sample" 
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	Test Statistic:

p-values:
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	Technical Requirements:
a) Random samples

b) m and n greater than 10


	Activity 5-5:  Using the Large Sample Wilcoxon Rank Sum Test


a) We will use the large sample approximation to test whether the median poverty level in 1998 for the 11 northeastern states of Maine, Massachusetts, Connecticut, New Hampshire, Vermont, New York, Pennsylvania, New Jersey, Delaware, and Rhode Island is less than that for the eleven western states of Washington, Oregon, California, Idaho, Nevada, Arizona, New Mexico, Colorado, Wyoming, Montana, and Utah.  State the null and alternative hypotheses

b) If we let the northeastern states be group 1 and the western states be group 2 it turns out that the value for 
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 is 36.5.  Compute the value for 
[image: image199.wmf]*

W

m


b) Compute the value for 
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c) Compute the value for Z.

d) Use the value for z and the normal tables to compute the p-value for testing if the median poverty level in the eastern stats is less than that for the western states.   What do you conclude?

	Homework Activities


	Activity 5-6:  Heights of Singers


The SPSS data file CHORAL.SAV XE "CHORAL.SAV"  contains the heights of members of the New York Choral Society according to their voice range.  We wish to see if the median height of Bass 2 singers is greater than that of Tenor 2 singers.

a) What are the appropriate null and alternative hypotheses for this question?

b) Conduct the Wilcoxon Rank Sum Test to determine if the median height for Bass 2 singers is greater than that for Tenor 2 singers.   Summarize your results including the value of the test statistic and the p-value.

c)  What do you conclude?

d) Does this mean that a randomly selected Bass 2 singer will always be taller than a randomly selected Tenor 2?  Why or why not?

	Activity 5-7:  Memorization Methods (cont’d.)


A study was conducted to see if there is a difference between two methods for memorization.  A sample of 54 people was divided into two groups of 27 each.  One group was instructed to memorize 12 word pairs, such as DOG—CAT, using repetition.  The other group was instructed to memorize the word pairs by creating a visual image for them.  Each was then given half of the word pair and asked to give back the other half.  The number of correct responses, out of 12, was recorded.  The data can be found in the SPSS data file MEMORY.SAV XE "MEMORY.SAV" .  Let group 1 be the repetition group and group 2 be the visualization group.

a) What are the appropriate null and alternative hypotheses for this experiment?

b) Have SPSS rank the 54 scores using Transform > Rank Cases, keeping track of which memorization method was used.

c) Compute W*.  What are m and n?

d) Compute the value for Z.

e) Use the normal tables to calculate the p-value for your test.

f) What do you conclude?

	Activity 5-8:  Scoring in the NFL


When the first score in an NFL football game is a touchdown, does it take, on average, longer than when the first score is a field goal?  Ten randomly selected NFL games from the 1986 season show the following.  The times are in minutes.  These data are stored in the SPSS data file NFLSCORE.SAV XE "NFLSCORE.SAV" .
	Time:
	7.47
	8.32
	4.15
	5.31
	5.47

	Type of Score:
	Touchdown
	Field Goal
	Touchdown
	Field Goal
	Field Goal

	
	
	
	
	
	

	Time:
	3.53
	8.59
	2.03
	11.38
	12.08

	Type of Score:
	Field Goal
	Touchdown
	Field Goal
	Field Goal
	Touchdown


a) What are the appropriate null and alternative hypotheses?

b) Compute the value of W* by hand.

c) Use Table VI to calculate the p-value for this test.

d) What do you conclude?

e) How should you have proceeded if you were given a sample of 10 games with the time to the first field goal and the time to the first touchdown in each?  Would you be addressing the same question?

	Activity 5-9:  Origins of the Etruscans


Anthropologists have long wondered about the origins of the Etruscan empire.  Were they native Italians or immigrants from somewhere else?  An anthropometric study measured the maximum skull breadth, in millimeters, of the skulls of 8 Etruscan males and the skulls of 7 randomly selected Italian males.  The data are given below.   They are stored in the SPSS data file ETRUSCAN.SAV XE "ETRUSCAN.SAV" .

	Etruscan:

	   153  140  146 126 148 135 147 147

	Italian:

	   139 134 131 129 129 127 134


a) What are the appropriate null and alternative hypotheses?

b) Compute, by hand, the value of the Wilcoxon Rank Sum test statistic.

c) Calculate the p-value for this test.
d) What do you conclude?

e) Do think the technical requirements for the Wilcoxon Rank Sum Test have been met?  Why or why not?

	Activity 5-10:  Cancer Survival


Seventeen patients with advanced cancer of the bronchus and seventeen patients with advanced cancer of the colon were treated with the drug ascorbate and their survival times, in days, were measured.  The question is whether the survival time differs with the organ affected?  The survival times are given below.  These data are stored in the SPSS data file CANCER.SAV XE "CANCER.SAV" .
	Bronchus:
	
	
	
	
	

	81
	461
	20
	450
	246
	166

	63
	64
	155
	859
	151
	166

	37
	223
	138
	72
	245
	

	
	
	
	
	
	

	Colon:
	
	
	
	
	

	248
	377
	189
	1843
	180
	537

	519
	455
	406
	365
	942
	776

	372
	163
	101
	20
	283
	


Use the most appropriate test of those that have been discussed thus far in this course, to ascertain if there appears to be a difference in the average survival time between patients with cancer of the bronchus and cancer of the colon.  Have SPSS do the calculations.
Topic 6

Comparing Two Standard Deviations XE "Comparing two standard deviations" 
	OVERVIEW


In Topic 3 you were introduced to a more powerful test for the equality of two independent population means.  It required the additional assumption that the two population standard deviations be equal.  In addition, you were given an empirical rule for assessing whether this additional assumption is reasonable.  There are times, however, when we would like to conduct a formal test of the hypothesis that they are equal.  In this topic we shall introduce such a test.

	OBJECTIVES


· To introduce the F distribution XE "F distribution"  and the tables for this distribution.

· To learn the test, based on the F distribution XE "F distribution" , for testing the equality of two standard deviations.

	PRELIMINARIES


a) If two independent populations have the same standard deviations, will the two sample standard deviations always be the same?

b) If two independent populations have the same standard deviations, by how much would you expect the sample standard deviations to differ?

c) Do you think that the amount of change that male students carry will be more variable than that for female students?

d) Record below the gender and the amount of change that each student in the class has.

	Gender
	Change
	Gender
	Change
	Gender
	Change

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	


	IN-CLASS ACTIVITIES


	Activity 6-1:  Memorization Methods (cont’d.)


a) Open the SPSS data file MEMORY.SAV XE "MEMORY.SAV" .  Use SPSS to draw side-by-side box plots for the memorization score separated according to the memorization method.  Do the plots indicate that there appears to be a difference in the standard deviations of the amount of change?

b) Use SPSS to compute the standard deviation by gender, and complete the following table.

	Method
	Sample Size
	Sample 

Standard Deviation

	Repetition


	
	

	Imagery


	
	


c) Do the statistics computed seem to lead to a conclusion that is consistent with the one you arrived at using the box plots?  If not, what do you think is going on here?

For the test we will be considering, we wish to determine whether or not the standard deviations of two independent groups are equal or not.  There are one-sided tests, but we will not consider them here.  For the purposes of the discussion we shall establish the following notation.  One population will be denoted as X, and the second population will be denoted as Y.

	
	Group One (X)
	Group Two (Y)

	Population Standard Deviation
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	Sample Size
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Using this notation we will be testing
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For technical reasons the test statistic will be based on the squares of the sample standard deviations rather than the sample standard deviations themselves.  The square of the standard deviation is known as the variance XE "variance" .  Anyway, the test statistic is computed as follows.  Begin by letting
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The test statistic is
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	Activity 6-2:  Computing the Test Statistic


a) Compute the test statistic for the memorization method data.

b) If the null hypothesis is not true, and the population standard deviations differ, would you expect the value of the test statistic to be greater than one, less than one, or is it impossible to tell?  Explain why you think so.

c) Does the value of your test statistic appear to give evidence that the two standard deviations are not equal?

The test statistic rigs things so that the larger of the two sample standard deviations is always in the numerator.  This means that as the sample standard deviations differ, the value of the test statistic becomes greater than 1. Therefore, evidence against the null hypothesis will be values of F > 1.  The only issue to be resolved is the strength of evidence against 
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for a given value of F.  In other words, how do we compute the p-value for this test?

If the populations from which the samples are drawn have normal distributions, it turns out that F has a distribution that is known as an F distribution.  The F distribution XE "F distribution"  is, like the t distribution, a family of distributions.  The particular member of this family that is appropriate for a given situation depends on the sizes of the two samples.  Like the t distribution we use the term degrees of freedom XE "degrees of freedom" .  The F distribution has two degrees of freedom parameters associated with it—one for the numerator variance and one for the denominator variance.  If the numerator variance,
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observations, the numerator degrees of freedom will be 
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, and, if the denominator variance, 
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 observations, the denominator degrees of freedom will be 
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.  Under these conditions F is said to have an F distribution with 
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degrees of freedom.  A common shorthand, which we will adopt, is to say that d.f. = 
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 to signify that something has an F distribution with d.f. =
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.  The F distributions have the following properties.

· They are skewed to the right.

· As 
[image: image221.wmf]2

n

becomes larger 
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 approaches what is known as a chi-square distribution.  The chi-square distribution will be discussed in Topic 7.

As with the normal, t, and chi-square distributions, we have provided a table for the F distribution XE "F distribution" .  It is in Table IV.  You will now find out how to use the table.  You will see that the columns of the table correspond to the degrees of freedom for the numerator—the table calls them dfn.  The rows are broken into blocks according to the denominator degrees of freedom—the table calls them dfd.  For each denominator degrees of freedom there are five separate p values.  The body of the table gives values of f such that 
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For example, suppose F has an F distribution XE "F distribution"  with d.f. = (7,10).  Then Table IV tells us that 
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  Make sure you verify that this is so.   In the notation given above we would write this result as 
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	Activity 6-3:  Exploring the F Distribution


a) Use the F table to find 
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b) Use the F table to find
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c) Use the F table to find, as closely as you can, 
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d) Use the F table to find, as closely as you can,
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e) Use the F table to find, as closely as you can, 
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f) Use the F table to find, as closely as you can, 
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g) Use the F table to find f such that 
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We are now ready to compute the p-value for our test of the equality of two population standard deviations.  Things are slightly different than was the case when we tested the equality of two population means.  This is a two-sided test, but the test statistic is computed so that the larger of the two sample variances always goes in the numerator of the F ratio.  This means, as we stated earlier, that F values greater than 1 give evidence that the null hypothesis is not true.  For these reasons the p-value is calculated as follows.  Let f be the observed value of 
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	Activity 6-4:  Computing the p-value


a) Refer to Activity 6-2.  What are the degrees of freedom for your F ratio?

b) What is the value of f that should be used in the p-value calculation?

c) Use Table IV to calculate 
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d) Calculate the p-value for the test.

e) What conclusion do you draw from this test?  Is it consistent with what you thought in Activity 6-1?  If not, what do you think is going on here?

To summarize, the procedure for testing the equality of two population standard deviations is given below.

	Testing XE "Comparing two standard deviations, test" 
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a) Let 
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c) The test statistic is 
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Let f  be the observed value of F.  The p-value is calculated by
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Technical requirements:

a) Both samples are random.
b) Both populations are normal.


	Activity 6-5: Hypothetical e-mail Times


You are going to test whether the standard deviation in e-mail time is the same for men as it is for women using the hypothetical data given in Activity 3-1.  The data are stored in the SPSS data file HYPOMAIL.SAV XE "HYPOMAIL.SAV" .
a) Have SPSS compute the sample standard deviations for men and for women for the e-mail data given in Activity 3-1.

b) Compute and record the value of the F ratio.

c) Record the degrees of freedom for your F ratio.

d) Compute the p-value for testing the equality of the population standard deviations.

e) Interpret your results.  Does this test indicate that the use of the pooled t test is valid for testing the equality of the mean e-mail times for men versus women?  Explain.

	Homework Activities


	Activity 6-6: Student Distances from Home


Refer to the data we collected in Topic 3.  Your instructor will tell you where to find the SPSS data file containing these data.

a) Do the assumptions required for the F test of equality of standard deviations appear to be satisfied?

b) If so, conduct the test for equality of standard deviations and summarize your conclusions.

c) If not, explain what the potential problems are in conducting the test for equality of standard deviations anyway.

	Activity 6-7:  Student Change


a) Enter the data collected in part (d) of the preliminaries into SPSS, and use SPSS to draw side-by-side box plots for the amount of change students in your class had separated according to gender.  Do the plots indicate that there appears to be a difference in the standard deviations of the amount of change?

b) Have SPSS compute the two sample standard deviations..

c) Conduct the test for equality of standard deviations and summarize your conclusions.

	Activity 6-8:  Heights of Singers (cont’d.)


Refer to the data on the heights of members of the New York Choral Society that are stored in the SPSS data file CHORAL.SAV XE "CHORAL.SAV" . We wish to see if the standard deviation of the Tenor 2 singers is the same as the standard deviation of the Bass 2 singers.

a) Do the assumptions required for the F test for equality of standard deviations appear to be satisfied?

b) If not, remove any outliers.  Now do the assumptions appear to be satisfied?

c) If so, conduct the test for equality of standard deviations and summarize your conclusions.

	Activity 6-9:  Television Ratings (cont’d.)


Refer to the television ratings data stored in the SPSS data file RATINGS.SAV XE "RATINGS.SAV" .  We wish to determine if the standard deviation for the sports shows is equal to the standard deviation of the non-sports shows.  

a) Conduct the F test for the equality of standard deviations.

b) Is the difference significant at the 5% level?  1% level?

c) How reliable do you feel that your conclusion in the previous part is?  Explain.

	Activity 6-10:  Robustness of the F Test


A test is said to be robust XE "robust"  if the p-values you calculate remain accurate even if the assumptions regarding the distributions of the populations are not met.  Use the SPSS script FDEMO.SBS.  The dialogue box for this script asks you to enter the number of samples to be taken.  The script then takes that many samples of size 25 each from two independent non-normal populations.  It counts the number of F tests that are significant at the .05 level and computes of percent of significant results.  If the p-value calculations for the F tests are accurate, then the results should be significant about 5% of the time.  Have the script take 1000 samples.  Summarize your results.  Do you think it is safe to use the F test with non-normal populations?
Topic 7

Independence of Categorical Variables

	OVERVIEW


In the first course you learned how to use conditional distributions and segmented bar charts to investigate whether or not two categorical variables are independent of each other.  Since we are dealing with random data it is possible that a given bar chart may indicate that two categorical variables are related when, in fact, no relationship exists.  To assess this we need a test to ascertain if the perceived relationship can or cannot be attributed to sampling variability.

	OBJECTIVES


· Learn the chi-square test for the independence of two categorical variables.

· Learn the chi-square distribution.
· Learn how to use SPSS to conduct the chi-square test.

	PRELIMINARIES


a) Do you think that men tend to be more or less politically conservative than women?

b) In the table provided below record the gender and political philosophy of members of your class.  M=male, F=female, C=conservative, M=moderate, L=liberal.

	Gender
	Politics
	Gender
	Politics
	Gender
	Politics

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	  Gender
	  Politics
	  Gender
	  Politics
	  Gender
	  Politics

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	


c) What do you think it means for two categorical variables to be related?

	IN-CLASS ACTIVITIES


	Activity 7-1:  Race and Politics


a) The table below shows the results from the Pew Center’s 1996 Religion and Politics Survey.  It compares the interviewee’s race with his/her political orientation.

	
	White
	Black
	Other

	Conservative
	641
	47
	61

	Moderate
	634
	64
	79

	Liberal
	297
	50
	43


· Have SPSS create a segmented bar chart XE "Segmented bar chart" , using race for the explanatory variable and political orientation as the response variable.  Reproduce your chart below.

b) Do the segments in each of the bars for each of the racial categories show the same pattern?  In not, briefly describe how they differ.

The pattern of segments varies from bar to bar.  This means that the tendency for a person to have a certain political philosophy appears to vary according to that person’s race.  Thus, it is more likely for a Black person to be politically conservative than is the case for a White person.  This variation from bar to bar in the pattern of the segments is what we mean when we say that two categorical variables are related or are associated XE "Associated" .  Another term used in this context is independent XE "Independent" .  Two categorical variables are said to be independent if the pattern of segmentation does not vary from bar to bar (i.e. the two variables are not related).  If the pattern does vary, then the variables are said to be dependent XE "Dependent" .  

c) Does the segmented bar chart indicate that the two variables are independent or dependent?

The test we will discuss chooses between the following hypotheses.
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In order to do this we need to determine how many observations we would expect to find in each cell of the two-way table if the row and column variables are independent.  The resulting test statistic will compare this expected number with the number of observations that actually occurred in that cell.  The amount by which these two numbers differ will give evidence against the null hypothesis.

Before we proceed, let us introduce some notation that will help describe what is going on.  Let r be the number of rows in the two-way table, and let c be the number of columns in the table.  In addition, let i be used to denote a particular row in the table, and let j be used to denote a particular column in the table.  Rows are numbered starting with the top row, and columns are numbered starting with the leftmost column.  Armed with this we define the following quantities.
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	Activity 7-2:  Getting Used to the Notation


a) What are the values of r and c for the table shown in Activity 7-1?
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b) Compute the total number of observations in row 1 (numbering goes from top to bottom).  This would be denoted by
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c) Compute the total number of observations in column 2 (numbering goes from left to right).  This would be denoted by
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d) Compute the total number of observations in the table.  This would be denoted by N.
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e) Compute the following quantities.
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In order to compute the number of observations we would expect to see in a given cell if the row and column variables are independent, we make use of the following theoretical fact.  When the row and column variables are independent, the proportion of observations in a given cell should be equal to the product of the proportion of the observations that are in that cell’s row and the proportion of the observations that are in that cell’s column.  In terms of our notation, we would say
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Therefore, if we multiply this proportion by the total number of observations, we have the number of observations that should appear in a given cell when the row and column variables are independent.  This quantity is called the expected count XE "Expected count" .  This will be denoted by
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This means that we would compute 
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 as follows.
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These expected counts are not rounded.  Leave them as fractions.

	Activity 7-3:  Computing the Expected Counts


Use the preceding discussion as a guide and compute each of the following.  Write them in the following table.
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You should notice that the expected counts for each row sum to the total observed counts for that row, and the expected counts for each column sum to the total observed counted for that column.  This serves as a convenient check that the computations are correct.

In order to test whether or not the row and column variables are independent, we compare the observed counts with the expected counts.  This is done by computing a statistic that is known as chi-square XE "Chi-square" .  We will denote this by
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Then these quantities are summed to get our test statistic.  As a formula, this looks like the following.
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As an example, the component of the sum for the cell in row 1 and column 1 is computed as follows.
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	Activity 7-4:  Computing Chi-Square


a) Compute the missing components of chi-square for the table given below.
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b) Sum the nine entries in the table from part (a) to compute the value of chi-square.  Record your result below.
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Once we have the value for 
[image: image283.wmf]2

c

we need to compute the p-value in order to determine if there is strong evidence against the null hypothesis that the two variables are independent.  It turns out that, if each of the expected counts is at least 5, then
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has an approximate distribution called chi-square XE "Chi-square distribution" .  The chi-square distribution, like the t distribution is a family of distributions.  The particular member of this family that is appropriate for a given situation depends on the number of rows and columns in the two-way table.  Like the t distribution we use the term degrees of freedom XE "Degrees of freedom" .  Degrees of freedom will be denoted by d.f.  The number of degrees of freedom for a particular table is equal to the product of the number of rows in the table less one and the number of columns less one.  In our notation this is
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Under these conditions 
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 degrees of freedom.  A common shorthand, which we will adopt is to denote something that has a 
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As with the normal, t and F distribution XE "F distribution" , we provide a table for the 
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distribution XE "Chi-square distribution" .  It is in Table III.  You will now find out how to use the table.  The rows of the table correspond to the number of degrees of freedom.  The columns give values of p.  p is an upper tail probability.  The body of the table gives values of x such that
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.  For example, suppose we have a 
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distribution with d.f. = 10.  Then Table III tells us that 
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	Activity 7-5:  Exploring the Chi-Square Distribution


a) Use the 
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b) Use the 
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c) Use the 
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table to find, as closely as possible,
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d) Use the 
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e) Use the 
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table to find, as closely as possible,
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We are now ready to compute the p-value for our test of the independence of two categorical variables.  Large values of 
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give evidence against the null hypothesis.  This means that this is a one-sided test.  If we let x be the computed value of
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	Activity 7-6:  Computing the p-value


a) Refer to the table in Activity 7-1.  What are the degrees of freedom associated with this table?  Record you value below.
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b) Are all of your expected counts for this table at least 5?

c) What is the value of x that should be used in this p-value calculation?

d) Use Table III to calculate the p-value for the test.

e) What conclusion do you draw from this test?  Are political position and race related?

SPSS can perform the calculations we have outlined above.  There are two possible cases here.  

Case 1:  Using raw data

In this case you have one variable containing the explanatory variable and another variable containing the response variable.  

· Click Analyze > Descriptive Statistics > Crosstabs to bring up the following dialog box.
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· Enter the explanatory variable in the Column(s) box, and enter the response variable in the Row(s) box.

· You should always request that SPSS show the expected counts.  To do this click on Cells to bring up the following dialog box.
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· Make sure that at least Observed and Expected are checked in the Counts area.  You may also want to check Columnin the Percentages area.  This will have SPSS show the conditional distributions.  Click Continue.  
· Click Statistics to bring up the following dialog box.
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· Make sure that Chi-square XE "Chi-square"  is checked.  Click Continue.
· Click OK to create the two-way table and conduct the chi-square test.

Case 2:  Entering a summary two-way table.

In this case you need to create, in a new data view, one variable containing the possible values of the explanatory variable, one variable containing the possible values of the response variable, and a third variable containing the number of observed counts in each cell of the table.  For an r-by-c table there will be rc cases.  A data view that contains the data in the two-way table of political views versus race is shown below.  Make sure that you assign value labels to each level of the explanatory and response variables in Variable View.  This will make the resulting table much more readable.  
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· Now weight the table using the observed counts stored in the variable Count.  Click on Data > Weight Cases to bring up the following dialog box.
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· Check Weight cases by, and place the variable containing the observed counts in the Frequency Variable box as shown above.  Click OK.  
· Now proceed as directed in Case 1 to create the two-way table and conduct the chi-square test.

f) Open the SPSS data file race_pol.SAV.  Have SPSS create the table that compares race and political orientation and perform the chi-square analysis.  Compare the output with your hand calculations.  Are they the same?  If not, can you explain the difference?

The chi-square test we have been discussing is summarized below.

	Chi-square XE "Chi-square"  Test XE "Chi-square test"  for Testing
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a) Compute row totals,
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b) For each cell compute the expected count, 
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c) The test statistic is
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d) Let x be the calculated value for
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.  The p-value is calculated by 
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If the expected cell counts are not all 5 or more, it is common practice to combine rows and/or columns in order to meet this requirement.  You should combine rows and columns in such a manner that the resulting table can be easily interpreted.  For example, if we needed to combine rows labeled “good,” “better,” and “best,” you would not want to combine “good” with “best.”  As long as you have at least one degree of freedom in the resulting table, the test can be run.  You should not lose sight, however, of the fact that the test is assessing the independence of the variables as represented in your final table, not the original one.  If you are doing this in SPSS you can easily combine rows or columns using Transform > Recode to change the values of appropriate variable.  
	Homework Activities


	Activity 7-7:  Pet Birds and Lung Cancer


Kohlmeier, Arminger, Bartolomeycik, Bellach, Rehm and Thomas, British Medical Journal, 305, pp. 986-989, conducted a study to determine if keeping a pet bird could be considered a risk factor in the development of lung cancer.  They took a sample of patients in Berlin who had contracted lung cancer and a sample of patients in Berlin who had not contracted lung cancer.  The data are summarized in the following table.

	
	Kept a pet bird
	Did not keep a pet bird

	Lung Cancer
	98
	141

	No Lung Cncer
	101
	328


a) Conduct a chi-square analysis to determine if keeping a pet bird is independent from developing lung cancer.  

b) What do you conclude?  

c) Is keeping a pet bird a risk factor?

	Activity 7-8:  High School Graduates


A random sample of 115 students leaving high school was taken to see what relationship, if any, existed between success in passing the General Certificate of Education Advanced Level examinations and where students were headed after graduation.  These are much like examinations taken by many state’s high school students in the United States.  The number of examinations each student passed along with whether they went on to college, some other training program or straight to employment were observed.  The results are summarized below.

	Examinations

	Passed
	College
	Other Training
	Employment

	1
	1
	7
	14

	2
	10
	7
	12

	3
	29
	4
	11

	4 or more
	16
	1
	3


a) Do the data indicate that there is a relationship between the number of advanced level examinations passed and the ultimate destination of high school graduates?  Explain in detail how you justify your conclusion.  

b) If there is a relation, how would you describe it?

	Activity 7-9:  Gender and Politics


a) Conduct a chi-square analysis on the data collected in the Preliminaries to ascertain there is a relationship between the gender of a student at your school and his/her political orientation.  

b) What do you conclude?  Justify your conclusions.  

c) If a pattern exists, describe it.

	Activity 7-10:  Religiosity and Marriage


The SPSS data set REL_MAR.SAV XE "REL_MAR.SAV"  contains a portion of the NSFH data from NSFH.SAV XE "NSFH.SAV" .  Marital Status gives the marital status of the respondent—1 = married, 2 = separated, 3 = divorced, and 4 = widowed.  Religiosity gives the number of times per month the respondent attends church—0 = never, 1 = once a week or less, 2 = twice a week, and 3 = more than twice a week.  

a) Do the data indicate there is a relation between marital status and the number of times one attends church?  Justify your conclusions.  

b) If there is a relationship, how would you characterize it?

	Activity 7-11:  Deciding Authorship


The chi-square test can be used in answering questions that come under the general heading of goodness-of-fit problems.  Here the problem is to determine if randomly selected items from a population follow a particular pattern or not.  A particularly intriguing example of this type of analysis is that of trying to determine if the pattern of words in manuscripts of unknown authorship follow the patterns of a particular author.  To do this, a sample of the author’s works is compared with the manuscripts whose author is not known.  It is common to look at things such as the frequency of use of particular words and the frequency of use of words of various lengths.  We shall look at an example of the latter.

In 1861 the New Orleans Crescent published a ten letters that were signed by Quintus Curtius Snodgrass.  The letters describe events that seem to have occurred, but there is no record of the existence of anyone named Quintus Curtius Snodgrass.  Some claimed that the author was actually Mark Twain.  The table below gives the distribution of word lengths from the Snodgrass letters and the distribution of word lengths from a sample of the works of Mark Twain.

	Word Length
	1
	2
	3
	4
	5
	6
	7

	Mark Twain
	312
	1146
	1394
	1177
	661
	442
	367

	Q. C. Snodgrass
	424
	2685
	2752
	2302
	1431
	992
	896

	
	
	
	
	
	
	
	

	Word Length
	8
	9
	10
	11
	12
	13+
	

	Mark Twain
	231
	181
	109
	50
	24
	12
	

	Q. C. Snodgrass
	638
	465
	276
	152
	101
	61
	


These data are saved in the SPSS data file AUTHOR.SAV.  To perform the analysis, let the two authors be the columns of a two-way table, and let the word lengths be the rows of the table.  Then do the chi-square analysis on the resulting table.

a) The chi-square analysis we are doing tests the null hypothesis that the row and column variables are independent against the alternative hypothesis that they are not independent.  In this problem does the null hypothesis of independence coincide with the hypothesis that the two authors are the same, or does it coincide with the hypothesis that they differ?

b) Conduct the chi-square analysis and summarize your conclusions.

c) Can we conclude that Mark Twain could have written the Q. C. Snodgrass letters?
Topic 8

Independence of Categorical Variables—Measures of Association

	OVERVIEW


In the first course you were introduced to segmented bar charts as a tool to determine if there appeared to be a relationship between two categorical variables.  In Topic 7 you learned how to test whether or not two categorical variables are independent of each other.  If you conclude that there is an association between the row and column variables you would want to determine what shape the association takes.  In addition, you would like to know how strong the association is.  In order to do the former we will look at analyzing the conditional distributions in the form of column percents in a two-way table.  For the latter, we would like to compute measures that we can interpret in a manner similar to that of the correlation coefficient you learned about in the first course.  To that end we will look at a number of measures of association.  Some will be based on the value of the chi-square test statistic.  They are known as phi and Cramér’s V.  We will look at two other measures that are based on the idea of proportional-reduction-in-error.  They are known as Lambda XE "Lambda"  and Gamma XE "Gamma" .  In this topic we will consider the column percent analysis, phi and Cramér’s V.  The next topic will discuss Lambda and Gamma.

	OBJECTIVES


· Learn how to analyze the form an association takes by looking at column percentages.

· Learn how to calculate and interpret the chi-square based measures of association phi and Cramér’s V.

	PRELIMINARIES


a) Do you think that first-class passengers on the Titanic were more likely to survive than second-class passengers?  What about steerage class passengers?  If so, how strong do you think the association would be between survival and class?

	IN-CLASS ACTIVITIES


	Activity 8-1:  Estimating the Degree of Association


Consider the following three two-way tables.  They compare religion with political orientation.

Table 1

	
	Protestant
	Catholic
	Other

	Liberal
	100
	75
	50

	Moderate
	50
	40
	25

	Conservative
	50
	35
	25


Table 2

	
	Protestant
	Catholic
	Other

	Liberal
	100
	35
	25

	Moderate
	75
	75
	50

	Conservative
	25
	40
	25


Table 3

	
	Protestant
	Catholic
	Other

	Liberal
	100
	35
	25

	Moderate
	75
	75
	25

	Conservative
	25
	40
	50


a) Which of the three tables shows the least degree of association between religion and political orientation?  How would you describe the relationship?

b) Which of the three tables shows the greatest degree of association between religion and political orientation?  How would you describe the relationship?

In the first course you would have used a segmented bar chart to answer these questions.  The only issue in constructing a segmented bar chart is which categorical variable should be used to define the bars and which one should be used to segment the bars.  Recall that the explanatory variable defined the bars, and each bar was segmented using the response variable.  In a properly set up table the column variable is the explanatory variable, and the row variable is the response variable.  Thus, in the tables shown in Activity 8-1religious affiliation would be the explanatory variable, and political view would be the response.  Recall, that in a segmented bar chart association was assessed by seeing the degree to which the relative thickness of the segments differ from bar to bar.

The segments in each bar correspond to the percentages of each bar for each response category.  This means that we can perform similar analysis by simply computing and comparing the percent the cells are of the total in the cell’s column.  

	Activity 8-2:  Column Percentage Analysis XE "Column Percentage Analysis" 


a) For Table 1 of Activity 8-1 complete the computation of the column percentages begun below.

	
	Protestant
	Catholic
	Other

	Liberal


	(100/200)100 = 50%
	50%
	

	Moderate


	25%
	26.7%
	

	Conservative


	25%
	
	

	Total


	100%
	100%
	100%


b) What do the column percentages say with regard to the strength of association between religion and political orientation?  Do they confirm your assessment in the previous activity?

c) For Table 3 of Activity 8-1 compute the remaining column percentages.

	
	Protestant
	Catholic
	Other

	Liberal


	50%
	23.3%
	

	Moderate


	37.5%
	
	25%

	Conservative


	
	26.7%
	50%

	Total


	100%
	100%
	100%


d) What do these column percentages say with regard to the strength of association between religion and political orientation?  Do they confirm your assessment in the previous activity?

SPSS’s cross-tabulation feature will compute column percentages for you.  You were introduced to this in the first course.  Remember it is found in Analyze > Descriptive Statistics > Crosstabs.  The SPSS data set HYPOTBL.SAV XE "HYPOTBL.SAV"  contains simulated raw data that will recreate Tables 1-3 from Activity 8-1.  Recall that you obtain column percentages by clicking on Cells and check Column in the Percentages area.

	Activity 8-3:  Using SPSS


Have SPSS create the table of column percentages you computed in Part (c) of Activity 8-2.  Do they agree with the ones you calculated by hand?

	Activity 8-4:  Using Chi-square XE "Chi-square"  to Measure the Strength of Association


a) Have SPSS compute chi-square for Table 1 in Activity 8-1.  Record the value below.

b) Have SPSS compute chi-square for Table 3 in Activity 8-1.  Record the value below.

c) In the light of the work you did in Activity 8-1 and Activity 8-2 how does the value of chi-square change as the degree of association between the row and column variables changes?

The chi-square statistic is used as to test whether or not the row and column variables in a two-way table are related.  It, therefore, would seem to be reasonable that it could be used to assess the strength of the relationship.  There is, however, a problem in doing this.

d) Look at the tables in HYPOTBL2.SAV XE "HYPOTBL2.SAV" .  The variable Row gives the row number of a cell, and the variable Column gives the column number of a cell.  The observed counts are shown in Count 1 and Count 2.  How do the two tables differ?

e) Have SPSS compute chi-square for each of the tables in Part (d).  How do they compare with each other?

It should be clear that the pattern of relationship in the two tables is the same.  The only difference is the individual cell counts differ by a factor of 10.  The value of chi-square increases merely because of the increase in counts and not because the pattern of relationship changes.  In order to compensate for this phenomenon a number of measures based on the value of chi-square have been proposed.

	Activity 8-5:  Chi-square XE "Chi-square"  Based Measures of Association


a) Record the total number of observations in the table using the observed counts in Count 1 shown in HYPOPTBL2.SAV.  Record the value below. 

b) Record the total number of observations in the table using the observed counts in Count 2.  Record its value below.

c) Divide the chi-square value for the table using the observed counts in Count 1 by the total number of observations for that table.  Tale the square root.  Record the value below.  

d) Divide the chi-square value for the table using the observed counts in Count 2 by the total number of observations for that table.  Take the square root.  Record the value below.

e) How do the results of parts (c) and (d) compare?

Dividing by the total number of observations in the table compensates for the effect of sample size on the value of chi-square.  This computation gives a measure of association known as phi-squared.  It is denoted by
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is the value of the chi-square statistic for the table, and N is the total number of observations in the table.  Now taking the square root of 
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 gives the measure of association phi, 
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 whose formula is
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Phi XE "Phi"  has some other desirable properties. 

· When chi-square is equal to 0, phi-squared will have a value of zero.  

· The value of phi never exceeds one. 

· Larger values of phi indicate a stronger association between the row and column variables.

	Phi XE "Phi" , 
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The formula for the measure of association 
[image: image331.wmf]j

is


[image: image332.wmf]2

N

c

j

=


where


[image: image333.wmf]2

 the value of the chi-square test statis

tic, and

 the total number of observations in the

 two-way table.

N

c

=

=




Phi XE "Phi" , however, has the undesirable property that it does not, in general have an attainable upper value of one.  This makes it difficult to interpret the meaning of any given non-zero value.  It should be noted that the upper limit on values of phi-squared is one for tables having two rows and two columns.  For this reason it is often used in that situation.  

f) For the table shown using the observed counts in Count 1 compute the smaller of the number of rows minus 1 and the number of columns minus 1.  Call it m. Record the value below.

g) Divide the value of phi-squared by m.  Take the square root.  Record the value below.

h) For the table using the observed counts in Count 2 compute the value of m.  Record the value below.

i) Divide the value of phi-squared for this table by m.  Take the square root.  Record the value below.

j) How do the results of parts (g) and (i) compare?

The statistic you computed in parts (g) and (i) is called Cramér’s V.  Cramér’s V as calculated in SPSS is actually found by taking the square root of this quantity.  Note that the values in parts (g) and (i) are the same.  This means that this computation also removed the effect of increased sample size.  The main difference in using chi-square in this manner is that this statistic has an attainable upper limit of one for tables with any number of rows and columns.  A formula for this computation is
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is the value of chi-square for the table, N is the total number of observations in the table, and m is the minimum of the number of rows, r, minus 1, (r –1) and the number of columns, c, minus 1, (c –1).  

	Cramér’s V XE "Cramér’s V" 
For a two-way table with r rows and c columns, the formula for Cramér’s V is
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SPSS computes Cramér’s V and phi.  In Analyze > Descriptive Statistics > Crosstabs click on Statistics to bring up the dialog box you use to request chi-square.  In the Nominal XE "Nominal"  area check Phi XE "Phi"  and Cramér’s V as shown below.  Then click Continue and OK to create the table and compute the requested measures of association. 
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	Activity 8-6:  Using SPSS to Compute Chi-square XE "Chi-square"  Based Measures of Association


a) Have SPSS compute the chi-square based measures for the two tables in HYPOTBL2.SAV XE "HYPOTBL2.SAV" .  Record the values below.  What do they tell you about the strength of association between the row and column variables?

	Count 1
	Count 2
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b) Have SPSS compute the chi-square based measures for Table 1, Table 2, and Table 3 in Activity 8-1.  Record the values below.  What do they tell you about the strength of association between religion and political orientation in each case?

	Table 1
	Table 2
	Table 3
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	Table 1:



	Table 2:



	Table 3:




	Homework Activities


	Activity 8-7:  Pet Birds and Lung Cancer (cont’d.)


Recall that the purpose of the study described in Activity 7-7 was to see if owning a pet bird was a risk factor for contracting lung cancer.

a) What is the explanatory variable?  The response variable?

b) Perform column percentage analysis and report your findings.  

c) Is keeping a pet bird a risk factor for lung cancer?

d) Compute the chi-square based measures of association.  What do you conclude from these values?

e) What is the relation between the values of phi and Cramér’s V.  How do you account for this?

	Activity 8-8:  High School Graduates (cont’d.)


Recall that the purpose of the study described in Activity 7-8 was to see if what a person did after leaving high school was related to the number of advanced level examinations passed.

a) What is the explanatory variable?  The response variable?

b) Perform the appropriate percentage analysis and discuss your findings.

c) Compute the chi-square based measures of association for the table you finally analyzed in Activity 5-8.  Which measure should you use in this case?  How would you describe the strength of the relationship between the two variables?

	Activity 8-9:  Religion and Marriage (cont’d.)


Recall that the purpose of the problem described in Activity 7-10 was to see if there was a difference in marital status depending on how often one goes to church.

a) What is the explanatory variable?  The response variable?

b) Have SPSS create a two-way table for comparing these two variables.

c) Perform column percentage analysis and summarize your conclusions.

d) Compute the chi-square measures of association for the table you created in part (a).  Which measure should you use in this case?  How would you describe the strength of relationship between these two variables?

	Activity 8-10:  The Titanic Disaster


The SPSS data set TITANIC.SAV XE "TITANIC.SAV"  contains data from the Titanic’s disastrous maiden voyage.  The data are in the following format.  These data were originally collected by the British Board of Trade in their investigation of the sinking.  

The sinking of the Titanic is a famous event, and new books are still being published about it.  Many well-known facts—from  the proportions of first-class passengers to the "women and children first" policy, and the fact that that policy was not entirely successful in saving the women and children in the third class—are reflected in the survival rates for various classes of passenger.  

	Column
	Variable

	Class

Age

Sex

Survived
	Class (0 = crew, 1 = first, 2 = second, 3 = third)

Age   (1 = adult, 0 = child)

Sex   (1 = male, 0 = female)

Survived (1 = yes, 0 = no)


a) What is the explanatory variable here?  The response variable?

b) Do the data indicate that the proportion surviving varied according to the status of the passenger?  How do you justify your conclusion?

c) Using the two-way table you created in part (a), perform column percent analysis to see how a person’s survival differed according to his/her class.

d) Which chi-square based measure of association should you compute to assess the strength of the relation?  

e) Compute the most appropriate chi-square based measure of association and comment on what it tells you.

	Activity 8-11:  The Titanic Disaster (cont’d.)


The description of the data in TITANIC.SAV XE "TITANIC.SAV"  in Activity 8-10 states that the “women and children first” policy was not entirely successful.  This activity will investigate this statement.

a) Create a new variable so that a 1 represents a person was either a woman or a child and a 0 indicates that a person was not.

b) Do the data indicate that there was a “women and children” first policy?  Justify your conclusions with chi-square and percentage analysis.

c) The data indicate that the policy was not entirely effective, but do the data indicate that the policy was pretty effective?  What can the chi-square based measures of association tell you in this regard?  What do they tell you?

Topic 9

Measures of Association—Lambda XE "Lambda"  and Gamma XE "Gamma" 
	OVERVIEW


We have seen in Topic 7 how to test whether two categorical variables are independent.  In Topic 8 we investigated how to use column percents to ascertain the form of relationship between two dependent categorical variables.  We also introduced two measures of association that are based on the value of the chi-square statistic.  Social scientists have proposed a wide variety of other measures of association.  One popular class of measures is based on the notion of proportional-reduction-in-error.  In this topic we will look at two of these—Lambda XE "Lambda"  and Gamma XE "Gamma" .

	OBJECTIVES


· Introduce the concept of proportional-reduction-in-error.

· Learn how to compute and interpret Lambda XE "Lambda" .

· Learn how to compute and interpret Gamma XE "Gamma" .

	PRELIMINARIES


a) What is your response to the following statement?  Circle one.  “Gays and lesbians should be allowed to marry legally.”

Agree

Neutral

Disagree 

b) What is your response to the following statement?  Circle one.  “Unwed mothers should not be allowed to receive welfare benefits.”

Agree

Neutral

Disagree

Enter the responses for your class in the following table.

	Gays and

Lesbians
	Unwed

Mothers
	Gays and

Lesbians
	Unwed

Mothers
	Gays and 

Lesbians
	Unwed 

Mothers

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	IN-CLASS ACTIVITIES


	Activity 9-1:  Prediction Using Categorical Variables


a) Consider the two-way table from Activity 8-1.  It is reproduced below.  Fill in the blank spaces in the table.

	
	Protestant
	Catholic
	Other
	Total

	Liberal


	100
	35
	25
	

	Moderate


	75
	75
	25
	

	Conservative


	25
	40
	50
	

	Total


	
	
	
	450


b) If you only knew the values of the column totals which religious preference would you predict a randomly selected member of the sample would have in order to be correct most often?

c) How many of the 450 observations would be classified in error?  

d) We have seen that this table indicates that political orientation and religious preference are related to each other.  Do you think that, if you knew the political orientation of a person, you could be better able to predict that person’s religious preference?

e) Suppose that a person considered herself to be politically liberal.  Which religious preference would you predict for this person in order to be correct most often?   How many of the 160 liberals would be classified in error?

f) How would you answer part (e) if the person is politically moderate?

g) How would you answer part (e) if the person is politically conservative?

h) If you based your predictions on knowing the political orientation of the person, how many of the 450 observations would be classified in error?

i) How many fewer errors are made when political orientation is taken into account?  This difference in errors is what proportion of the number or errors from part (b)?

The proportion calculated in part (i) is what is referred to as the proportional-reduction-in-error XE "Proportional-reduction-in-error" .  Many social scientists consider it to be important that a measure of association reflects the proportional-reduction-in-error.  In fact, some go so far as to feel that the only measures worth using are those that can be interpreted as somehow measuring the proportional-reduction-in-error.  It should be pointed out here that the chi-square based measures of association discussed in Topic 8 do not have a proportional-reduction-in-error interpretation.

The process we went through in Activity 9-1 actually computes the measure of association known as Goodman and Kruskal’s Lambda, or simply Lambda XE "Lambda" .  It directly computes the proportional-reduction-in-error in the manner outlined above.  

For any two-way table there are three ways in which Lambda XE "Lambda"  can be calculated.  The manner we discussed in Activity 9-1 used knowledge of the row variable to improve predicting the column variable.  The other way, of course, is to use the column variable to improve predicting the row variable.  The former measure is known as Lambda for the columns, or 
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.  We will now take the procedure we followed in Activity 9-1 and summarize it in a formula.  First, let us define the following quantities.
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Then the formula for 
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is as follows.
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If we compute the proportional-reduction-in-error for using the column variable to improve predictions for the row variable, we obtain Lambda XE "Lambda"  for the rows, or
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.  First we define the following quantities. 
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The formula for 
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is given below.
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In general, Lr and Lc attain different values.  In order to have a single value for any two-way table there is a symmetric version of Lambda XE "Lambda"  that essentially combines the two.  We denote it by L.  The formula is given below.
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	Activity 9-2:  Computing Lambda XE "Lambda" 


Consider the two-way table given in Activity 9-1.

a) In terms of the formula for
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, compute the following quantities.
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b) Use the formula to compute the value of
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c) In terms of the formula for
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, compute the following quantities.
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d) Use the formula to compute the value of
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e) Use the formula to compute the value of L.
Some of the properties of the Lambda XE "Lambda"  measures are listed below.

· The minimum value of Lambda XE "Lambda"  is 0.  It indicates that the use of the row or column variable to predict the other is of no use.

· The maximum value of Lambda XE "Lambda"  is 1.  It indicates that the use of the row or column variable to predict the other results in making no errors.

· The values of 
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are, in general different from each other.

SPSS also computes all three Lambda XE "Lambda"  measures.  In Analyze > Descriptive Statistics > Crosstabs you set up your two-way table in the usual manner and click on Statistics.  In the Nominal XE "Nominal"  area check Lambda.  

	Activity 9-3:  Using SPSS


a) Enter the table given in Activity 9-1 directly into an empty SPSS.  Use Analyze > Descriptive Statistics > Crosstabs to compute the values of Lambda XE "Lambda" .  Write the values returned below.

b) Compare the computer results with your hand calculations.

We summarize the procedure below.

	Goodman and Kruskal’s Lambda XE "Lambda" 
 Let
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Calculate 
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Calculate 
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Calculate L by
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Categorical variables where the categories have no inherent order are often referred to as being nominal XE "Nominal"  variables.  Gender and religious affiliation are examples of nominal variables.  Categorical variables where the categories have a natural ordering are referred to as being ordinal XE "Ordinal"  variables.  Categories like “good,” “better,” and “best” or “most prefer” 
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 “least prefer” are examples of ordinal variables.  Rankings on most teaching evaluation forms are also ordinal scales.   We should note that it is possible to consider political orientation to be an ordinal variable.  This can be done if we view the categories as being the degree of, say, political conservatism possessed by the person.  

When dealing with ordinal variables it is possible to not only measure the strength of association, but also the direction.  This means that we can get a measure that looks similar to, and has properties similar to, the correlation coefficient we used in the first course to measure the strength of association between two quantitative variables.  The measure we will consider is known as Goodman and Kruskal’s Gamma XE "Gamma" , or simply Gamma.  In order to compute it we define the following terms.  Let us call two ordinal variables X and Y.

· Two observations, A and B, are said to be concordant XE "Concordant"  if when A is higher in X than B, then A is also higher in Y than B, or vice versa.

· Two observations, A and B, are said to be discordant XE "Discordant"  if, when A is higher in X than B, then A is lower in Y than B, or vice versa.

· Two observations, A and B, where either is the same in X or Y are neither concordant nor discordant.

	Activity 9-4:  Concordant XE "Concordant"  and Discordant XE "Discordant"  Observations


Consider the following table of hypothetical observations.

	Interest in
	Degree of Desire to Help Others

	Student

Government
	High
	Mod.

High
	Mod.

Low
	Low

	High
	18
	19
	12
	8

	Mod. High
	16
	16
	12
	10

	Mod. Low
	11
	14
	18
	16

	Low
	5
	5
	15
	22


a) Observations in which cells would be concordant with an observation that is “moderately high” in degree of desire to help others and “moderately low” in interest in student government?  Record their cell counts below.

b) How many observations are in those cells?

c) Observations in which cells would be discordant with an observation that is “moderately high” in degree of desire to help others and “moderately low” in interest in student government?  Record their cell counts below.

d) How many observations are in those cells?

e) Observations in which cells would be neither concordant nor discordant with an observation that is “moderately high” in degree of desire to help others and “moderately low” in interest in student government?  Record their cell counts below.

f) How many observations are in those cells?

Gamma XE "Gamma"  computes the total number of concordant pairs of observations and the total number of discordant pairs of observations in a two-way table.  These calculations are made easier if the table is organized so that both the row and column variable are increasing starting in the upper left corner of the table or both decreasing starting in the upper left corner of the table.  Then, the number of concordant pairs using the observations in a given cell would be the number of observations in that cell times the total number of observations that are in cells below and to the right of it.  Thus, using observations which are “moderately high” in degree of desire to help others and “moderately low” in interest in student government would be
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You may wonder why we do not also use the number of observations above and to the left.  This is because those pairs will be counted when we do the other cells.  

The number of discordant pairs for that cell would be the number of observations in that cell times the total number of observations below and to the left of it.  For the cell which is “moderately high” in desire to help others and “moderately low” in interest in student government would be
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Again, we do not use the cell above and to the right because they will be counted when the other cells are done.

Gamma XE "Gamma"  considers all of the pairs that are either concordant or discordant.  Let
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Gamma XE "Gamma" , G, is then defined to be 
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We outline the procedure below.

	Goodman and Kruskal’s Gamma XE "Gamma" 
1) If necessary, rewrite the table such that both the row column variables go in ascending  order starting from the upper left corner or both row and column values go in descending order from the upper left corner.  

2) For each cell multiply the entry in the cell by the sum of the values in all cells that are below and to the right of that cell. Add all of those numbers together to get C. 

3) For each cell multiply the entry in the cell by the sum of the values in all cells that are below and to the left of that cell. Add all of those numbers together to get D. 
4) Calculate G by 
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	Activity 9-5:  Calculating Gamma XE "Gamma" 


a) Fill in the missing cells to calculate the number of concordant pairs associated with it.  Then add the totals for each cell to calculate C for the table given in Activity 9-3.
	Interest in
	Degree of Desire to Help Others

	Student

Government
	High
	Mod.

High
	Mod.

Low
	Low

	High
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	Mod. High
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	Mod. Low
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	0

	Low


	0
	          0
	0
	0


C =
b) Fill in the missing cells to calculate the number of discordant pairs associated with it.  Then add the totals for each cell to calculate D for the table given in Activity 9-3.

	Interest in
	Degree of Desire to Help Others

	Student

Government
	High
	Mod.

High
	Mod.

Low
	Low

	High
	0
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c) Use your values of C and D to compute the value of Gamma XE "Gamma" , G.

Gamma XE "Gamma"  has the following properties.

· The maximum value of G is +1.  It occurs when all of the pairs that are either concordant or discordant are concordant.

· The minimum value of G is –1.  It occurs when all of the pairs that are either concordant or discordant are discordant.

· G is not defined if all of the observations lie entirely in one row or in one column.

· G has a proportional-reduction-in-error interpretation.

SPSS also computes Gamma XE "Gamma" .  Select Analyze > Descriptive Statistics > Crosstabs and set up your table in the usual manner.  Click Statistics and check Gamma in the Ordinal area.  Click Continue and then OK to create the table and compute the value of Gamma. 

	Activity 9-6:  Using SPSS to Compute Gamma XE "Gamma" 


a) Enter the table given in Activity 9-4 directly into an empty SPSS data view.  Use Analyze > Descriptive Statistics > Crosstabs to compute the value of Gamma XE "Gamma" .  Write the value returned below.

b) Compare the computer results with your hand calculations.

	Homework Activities


	Activity 9-7:  Selecting a Measure of Association


Specify which measure of association, of those discussed in this topic, is most appropriate for the following pairs of variables.

a) Socioeconomic class and Educational level. 

b) Profession and Income. 

c) Profession and Religion. 

d) Race and IQ. 

e) Income and IQ. 

f) Political party and Marital status.

	Activity 9-8:  Creating Tables


Give an example of a table having three rows and three columns where each of the following occurs.  That is, create a separate table for each part.

a) G = +1,

b) G = -1, and

c) G = 0.

	Activity 9-9:  Creating Tables (cont’d.)


Give an example of a table having 3 rows and 3 columns where each of the following occurs.  Give a separate table for each part.  You may use the same table for an answer to more than one part.

a) LR = 0,

b) LR = 1,

c) LC = 0, 

d) LC = 1,

e) L = 0, and 

f) L = 1.

	Activity 9-10:  Education and Health


In a survey respondents were asked about their level of education and how, compared with other people their age, they would describe their overall health.  The raw data are stored in the SPSS data set ED_HEALTH.SAV XE "ED_HEALTH.SAV" .  They are a portion of the National Survey of Families and Housing (NSFH).  In the variable Education, NOHS = respondent has at most some elementary school, HS = respondent has some high school education, COLL = respondent has some education beyond high school.  The codes for Health are self-explanatory.

a) Does there appear to be a relationship between a person’s education and their perception of their overall health?  Justify your conclusion.

b) Of the two measures of association discussed in this topic, which one is the most appropriate?  If you choose Lambda XE "Lambda" , which of the two Lambda measures is more appropriate?  Explain your reasoning.

c) Compute the measure of association you chose in part (b) and interpret its value.

	Activity 9-11:  Religion and Religiosity


We are interested in whether or not there is a relation between the number of times one attends church varies according to one’s religion.  The SPSS data set RELIGION.SAV XE "RELIGION.SAV"  contains a portion of the National Survey of Families and Housing (NSFH).  The variable Religion is self-explanatory.  The variable Often  is interpreted as 1 = attends religious services less than once a week, 2 = attends religious services at least once a week but less than twice a week, and 3 = attends religious services at least twice a week.

a) Does there appear to be a relation between religion and religiosity?  Justify your conclusion.

b) Of the two measures of association discussed in this topic, which one is the most appropriate?  If you choose, Lambda XE "Lambda" , which of the two Lambda measures is most appropriate for determining the degree to which how often one attends religious services depends on one’s religion?  Explain your reasoning.

c) Compute the measure of association you chose in part (c) and interpret its value.

	Activity 9-12:  Social Attitudes


a) Create a two-way table for the data collected in the preliminaries.

b) Which of the measures of association discussed in this topic is most appropriate for assessing the strength of relationship between the two variables?  Explain your reasoning.

c) Compute the measure of association you chose in part (b) and interpret its value.

	Activity 9-13:  Predicting Basketball Success


Each year the basketball coaches in the Big East Conference predict the finishing place for the teams in the conference.  These are collated into a coach’s poll as to the final finishing place when the year is completed.  The table below gives the projected finishing place for teams in the Big East as compared to their actual finishing position.

	
	Predicted Finish

	Actual Finish
	First
	Second
	Third or Worse

	First
	3
	2
	2

	Second
	0
	2
	2

	Third or Worse
	3
	1
	5


a) Which of the measures of association discussed in this topic is most appropriate for measuring the strength of relationship between the predicted finish and the actual finish?  Explain your reasoning.

b) Compute the measure you chose in part (a) and use it to describe how well the predicted finish coincides with the actual finish.

	Activity 9-14:  Gender and Salary


The SPSS data set SAL_MAR_GEN.SAV XE "SAL_MAR_GEN.SAV"  contains a portion of the National Survey of Families and Housing (NSFH).  The variable Salary is interpreted as 1 = Respondent’s salary is at the median level or less, 2 = Respondent’s salary is above the median level but not more than the third quartile, and 3 = Respondent’s salary is above the third quartile.  The variable Marital gives the Respondent’s marital status at the time of the interview and is self-explanatory.  The variable Gender gives the Respondent’s gender and is self-explanatory.  We wish to see if the conventional wisdom that women tend to earn less than men is supported by this sample.

a) Does there appear to be a relationship between gender and income?  Justify your conclusion.

b) Of the measures of association discussed in this topic which one is the most appropriate for measuring the strength of relationship between a person’s gender and that person’s income?  Explain your reasoning.

c) Compute the measure you chose in part (b) and interpret its value.

d) Do the data support the hypothesis that women tend to earn less than men?  Explain your reasoning.

Topic 10

Regression Analysis—Estimation XE "Regresssion analysis, estimation" 
	OVERVIEW


In the first course you learned to construct scatter plots to investigate relationships between two measurement variables.  In those cases where there appeared to be a linear relationship you were shown how to use least squares curve fitting methods to arrive at a linear equation that “best” summarized that relationship.  This was called a regression line.  The equation for the line was called a regression equation.  At that time the regression line was intended to describe a linear relationship that existed in a given set of data.  If the data constitute a random sample from a larger population, it is natural to ask to what degree a sample regression equation represents an actual relationship in the population at large.  In this topic we shall begin to address this question.

	OBJECTIVES


· Investigate a population model for the regression problem.

· Learn how to use sample data to estimate the values of the parameters of the regression model.

· Learn how to construct confidence intervals for the parameters of the regression model.

· Use the regression equation to estimate values of the dependent variable.

· Learn how to construct confidence intervals for the predictions made by a regression equation.

	PRELIMINARIES


a) Measure and record the following measurements for members of your class.

	Height(in)
	Forearm

Length(in)
	Height(in)
	Forearm

Length(in)
	Height(in)
	Forearm Length(in)

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	


b) Do you feel that a sample regression line is a reliable indicator of a linear relationship between two variables in a population?

	IN-CLASS ACTIVITIES


	Activity 10-1:  Computing a Sample Regression Line  


a) Open the SPSS data set SAT99.SAV XE "SAT99.SAV" .  It contains 1999 data on the percent of high school seniors in each of the 50 states and the District of Columbia who took the SAT examinations along with the average scores for the Verbal and Math tests.  Have SPSS draw a FITTED LINE PLOT using percent taking the examination as the explanatory variable and average Math SAT as the response variable.  Recall this is found in Graphs > Interactive > Scatterplot. XE "Fitted line plot"   Make sure that regression is selected under the Fit tab.  Record the regression equation and 
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below.

b) Does a linear relationship between percent and Math SAT appear to be justified?

c) Use the regression equation to predict what the average Math SAT score should be for a state where 50% of the students take the examinations.

d) Which state(s) actually had 50% take the examinations?  Do their actual average Math SAT scores agree with your prediction?

It is rare that the predictions made by a regression equation agree with the actual observed values.  Recall that the difference between the actual and predicted values was called a residual XE "Residual" .  If we let 
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 be the observed value of the response for a specified value of the predictor, 
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, and 
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 be the predicted value of the response for that same value of the predictor, then the residual is computed by 


Ri = 
[image: image394.wmf]ˆ

.

ii

YY

-


When the data are a random sample from a population where X and Y have a linear relationship we describe the population by what is known as a statistical model.  In this case the model has the following form.
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Here, 
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 is the population y-intercept, 
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is the population slope and 
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is called the error term.  The error term is a random quantity that generates the different values of Y for a given value of X.  Note in Activity 10-1 the two states that had 50% take the examination had different average Math SAT scores.  This fact is accounted for by this error term. In the model we are considering this error term will have a normal distribution with a mean of 0 and a standard deviation of
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.  For a given population we do not know the values of
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, 
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, or
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.  These three quantities are the parameters of our model.  To summarize, the regression model is as shown below.

	Regression Model XE "Regression model" 
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where

a) 
[image: image404.wmf]i

e

 has a normal distribution with a mean of 0 and a standard deviation of 
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b) 
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 is the same for all values of X.


Recall from the first course that the sample slope XE "sample slope" , 
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, was calculated by
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where r is the sample correlation between X and Y, 
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is the sample standard deviation of the X values, and 
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is the sample standard deviation of the Y values.  Also, the sample intercept XE "sample intercept" , 
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was calculated by 
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where
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is the sample mean of the X values and 
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is the sample mean of the Y values.

It turns out that we can compute the sample statistic that corresponds to the parameter 
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in our model by using the residuals in the following formula.  
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It says that you square each residual, sum these squares, divide by the quantity n-2, and then take the square root.  This quantity is commonly referred to as the standard error of the estimate XE "Standard error of the estimate" . You will not be expected to perform this calculation in this course.
To summarize, we have the following correspondence between parameters and statistics in the regression model.

	Parameter
	Statistic
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SPSS’s fitted line plot output gives the values of b0 and b1 as well as the value of
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.   Recall that 
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measures the proportion of the observed variation in Y that is “explained” by the regression equation.  It is computed by 
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The values of  
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 and 
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 are what are called point estimates of 
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and
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, respectively.  This means that we use the sample data to make the best single number guess of the true values of the parameters.  Since sampling variability makes it highly unlikely that these point estimates will be exactly equal to the actual value of the parameter, we would like to construct confidence intervals for 
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.  SPSS can compute 95% confidence intervals for these two parameters.  If you want some other confidence level, then you must do them by hand.  In the latter case SPSS will provide most of the quantities that we need.  Recall that the general form for all of the confidence intervals we will consider in this course have the following form.

(Statistic) 
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 (Critical Value)(Standard Error of statistic).

Using this template, the formula for a confidence interval for 
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is given by 



[image: image433.wmf]1

1

*..,

b

btse

±


where



[image: image434.wmf]1

1

1

 sample slope statistic,

* critical value from the  tables for 2 

degrees of freedom, and

.. standard error of .

b

b

ttn

seb

=

=-

=


We obtain 
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from the SPSS regression output.  The value of 
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is obtained from the t tables in the same way as when we constructed confidence intervals for a population mean.  Note, however, that this time the degrees of freedom are n-2 instead of n-1.  The value of n-2 is also available in SPSS’s regression output.  In the ANOVA table, the number in the df column in the Residual XE "Residual"  row is n-2.
Similarly, the equation for a confidence interval for 
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Again, 
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are obtained from the SPSS regression output.

The output shown below is the standard regression output for the problem of estimating Math SAT using percent taking from SAT99.SAV XE "SAT99.SAV" .  We annotate the pieces as to what the entries represent.

Regression
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Dependent Variable: Math SAT

b. 


This section shows that the independent variable (explanatory variable) is Percent and the dependent variable (response variable) is Math SAT.  The remainder of this table will be of no interest to us.
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· The entry under R is the value of the correlation between Percent and Math SAT. 

·  The entry under R Square is the value of 
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.  

· The entry under Adjusted R Square will be considered when we take up regressions using more than one explanatory variable.  

· The entry under Std. Error of the Estimate is the value of s, the statistic for
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Most of the entries in this table will be considered in the next topic.  However, we can point out the following.  

· The entry in the Residual XE "Residual"  row of the Sum of Squares is the sum of the squares of the residuals that is used in the numerator of the formula for s and 
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· The entry in the Total row of the Sum of Squares column is 
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that is used in the denominator of the formula for 
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· The entry in the Total row of the df column is the value of n-1.

· The entry in the Residual XE "Residual"  row of the df column is the value of n-2.

· The entry in the Regression row of the df column is the number of explanatory variables in your model.
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Many of the entries in this table will be of no interest to us or will be considered in the next topic.  The items of relevance to the current discussion are the following.

· The entry in the (Constant) row of the B column is the value of b0, the sample y-intercept.  This will be the case for all regressions that you will conduct.

· The entry in the Percent row of the B column is the value of b1, the sample slope coefficient.  The label for this row will be whatever you enter in variable view as the Label for your explanatory variable.  If there is no label, then this will be blank.  For this reason you should be careful to always give all of your variables labels.

· The entry in the (Constant) row of the Std. Error column is the value of
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· The entry in the Percent row of the Std. Error column is the value of
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We can summarize the above results as follows.

	Confidence Intervals for XE "Regression parameters, confidence interval"  
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A confidence interval for 
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Technical Requirements:
a) Random Sample
b) Error term has a normal distribution
c) Standard deviation of the error term is the same for all values of the predictor.


For the sake of completeness, we present the formulas for calculating 
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.  You will have no need to compute them in this course.
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	Activity 10-2:  Constructing Confidence Intervals for 
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a) Use Analyze > Regression > Linear to produce output for the regression that uses percent to predict average Math SAT scores in SAT99.SAV XE "SAT99.SAV" .  Record the values for
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b) Use a 95% confidence level to obtain the value for
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.  Record that value below.

t* = 
c) Use the formula to construct a 95% confidence interval for
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. 

d) Does your confidence interval contain 0?  What do you think this means about the ability of percent taking the examination to improve predicting average Math SAT scores for a given state?

e) Use the formula to construct a 95% confidence interval for
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.

f) Does this confidence interval contain 0?  What significance, if any, does this have?

h) SPSS can construct 95% confidence intervals for both 
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and 
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.  If you want a different confidence level, then you must do the computations by hand.  You proceed as follows.

· Select Analyze > Regression > Linear and set up the regression in the usual manner.

· Click Statistics.

· In the Regression Coefficients area check Confidence intervals.

· Click Continue followed by OK to run the regression.  The two confidence intervals will be added to the right end of the Coefficients table.

Have SPSS construct 95% confidence intervals for both 
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and 
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.  Record the intervals below.  How do the SPSS results compare with those you did by hand?

When we use a regression equation to compute a response for a given value of the predictor we can interpret that value in one of two ways.  It can be viewed as a prediction of the mean value of the response for that value of the predictor, or it can be viewed as a prediction of an individual value of the response for that value of the predictor.  In either case, sampling variability means that, for a given population, the sample regression lines we compute will vary from sample to sample.  This means that the predictions for the response will vary from sample to sample.  For this reason we want to construct confidence intervals for these predictions.  Traditionally, confidence intervals for the mean response are called confidence intervals, and confidence intervals for the individual response are called prediction intervals XE "Prediction intervals" .  

SPSS computes intervals for both interpretations of the predicted response.  In order to construct them click SAVE from the regression dialog box.  This opens the dialog box shown below.  This is the same dialog box you used in the first course to compute and save values for the fits and residuals.
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In the Prediction Intervals area check Mean and Individual.  Make sure that the desired confidence level is in the Confidence Interval: box and click Continue.  If you want intervals for values of the explanatory variable that are not in the original data, simply enter them in the explanatory variable at the end of the data leaving the response variable blank.  Running the regression will add new variables to the data view that look like the following.
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The variables LMCI_1 and UMCI_1 are the lower and upper confidence bounds for predicting the mean response, respectively.  The variables LICI_1 and UICI_1 are the lower and upper confidence bounds for predicting the individual response, respectively. 

	Activity 10-3:  Prediction Intervals


a) Have SPSS compute 95% prediction intervals for all of the states as well as for a state where 75% took the SATs.  Record the confidence intervals and prediction intervals below for the state where 75% took the SATs.

b) To get a picture of what is going on we will plot the four sets of confidence limits in a single scatter plot.  

· Select Graphs > Scatter.  

· Click Overlay followed by Define to bring up the following dialog box.

· Select Percent and each confidence bound individually.

· Highlight all four pairs and click Swap Pair.

· Click OK to produce the plot.
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c) Briefly describe what you see.

You will see that the confidence limits grow farther apart as you approach the left and right ends of the plot.  This reflects the fact that predictions using regression lines tend to be more accurate for X values near the mean value of X.  The accuracy diminishes as you move away from
[image: image480.wmf]X

.  In addition, the intervals for predicting the mean response have widths that are smaller than for those for predicting an individual response.  This reflects the fact that means tend to be less variable than individual observations.

Again, for the sake of completeness, we provide the formulas that are used to construct these confidence intervals.  As was the case for the standard errors of the regression coefficients, you will have no need to perform these calculations.

Confidence Interval for Predicting the Mean Response:
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Confidence Interval for Predicting the Individual Response:
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Here, t* uses n-2 degrees of freedom, and x* is the value of the explanatory variable for calculating the value for 
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	Homework Activities


	Activity 10-5:  Verbal SAT Scores


Use the data in the SPSS data set SAT99.SAV XE "SAT99.SAV" .  

a) Does there appear to be a linear relation between the percentage taking the examination and the average Verbal SAT score?

b) Compute a regression line that uses percentage taking the examination to predict the average Verbal SAT score.  Report your regression equation.
c) What would you predict for the average Verbal SAT score for a state where 50% take the examination.

d) What would be the change in the average Verbal SAT score for a state where the percentage taking the examination increased by 10 percent?

e) Construct a 99% confidence interval for
[image: image484.wmf]1
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.  Does it indicate that percentage taking the examination is a useful predictor for the average Verbal SAT score?

	Activity 10-6:  Physical Measurements


a) Enter the physical measurements taken on members of your class in an SPSS data set.  Do the two measurements appear to be linearly related?  

b) Compute a regression line that uses forearm length to predict height.  Report your regression equation.
c) What would you predict would be the height for a person whose forearm measures 17.5 inches?

d) Construct a 90% confidence interval for
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.

e) Construct a 95% confidence interval for predicting the average height of people whose forearm measures 19 inches.

f) Construct a 99% confidence interval for predicting the height of an individual whose forearm measures 15 inches.

	Activity 10-7:  Aircraft Operating Costs


The SPSS data set AIRCRAFT.SAV XE "AIRCRAFT.SAV"  contains data on a number of commercial aircraft.  The variables are described in the variable view.

a) Does there appear to be a linear relation between fuel consumption and operating cost?

b) Compute a regression line that uses fuel consumption to predict operating cost.  Report your regression equation.
c) If the fuel consumption for an aircraft increases by 50 gallons per hour, by how much would you predict that the operating cost would change?

d) Construct a 99% confidence interval for
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.  Does it indicate that fuel consumption is a useful predictor for operating cost?

e) Construct a 90% confidence interval for the average operating cost for airplanes that consume 2500 gallons per hour.

	Activity 10-8:  Measuring Cherry Trees


The SPSS data set CHERRY_TREES.SAV XE "CHERRY_TREES.SAV"  contains the diameter, height, and volume of a sample of black cherry trees.  

a) Do the height and volume appear to be linearly related?

b) Fit a regression line that uses height to predict the volume.  Report your regression equation.
c) What would you predict the volume to be for a tree that is 77 feet tall?

d) By how much will the volume change if a tree’s height increased by 2 feet?

e) Construct a 95% confidence interval for predicting the volume of an individual tree with a height of 65 feet.

f) Create a new variable that is the height times the square of the diameter.  Use your new variable as the explanatory variable to fit a regression that uses it to predict volume.  Report your regression equation.
g) Which of these two regression models does the better job of predicting volume?  Explain your reasoning.

	Activity 10-9:  Aircraft (cont’d.)


a) Describe the relationship between Speed and Range for the aircraft listed in the SPSS data set AIRCRAFT.SAV XE "AIRCRAFT.SAV" .  Is it strong or weak?  Linear or non-linear?

b) For non-linear relationships practitioners use mathematical transformations to “linearize” the relationship.  Frequently used transformations are logarithms and square roots.  Try various combinations of logarithms and square roots on the variables Speed and Range.  Which one gives the most linear relationship?  You can find these functions in the Functions box in Transform > Compute.  The logarithm function is LG10, and the square root function is SQRT.  The combinations you should try are

	Speed vs. log Range

Log Speed vs. Range

Speed vs. Square Root Range

Square Root Speed vs. Range


c) Fit a regression line using the transformation you chose in part (b).  Report your regression equation.
d) What would you predict as the range for an aircraft having a speed of 500 miles per hour.  .  If the response variable is Log Range you will need to raise 10 to the power of your prediction.  If the response is Square Root Range you will need to square your prediction.

Topic 11

Regression Analysis—Testing XE "Regression analysis, testing" 
	OVERVIEW


In Topic 10 we presented the population model used for regression analysis.  We also saw how to construct confidence intervals for the population slope and intercept.  In addition, we showed how SPSS computes confidence intervals on the predictions made by using a sample regression line.  In this topic we shall investigate testing hypotheses regarding the population slope and intercept.  In addition, we shall show how residuals can be used to determine if the assumptions in the population model are reasonable.

	OBJECTIVES


· Learn how to test hypotheses regarding 
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 and
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· Learn how to use residuals to assess the validity of the assumptions in the regression model.

	PRELIMINARIES


a) Look back at your confidence interval for 
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in Topic 10.  Do you feel that it gives evidence that the percent taking the examinations is useful in improving predictions regarding the average Math SAT score for a given state?

b) Does the fitted line plot you drew in Topic 10 give indication that the assumptions about a linear relation, the normality of the error term and the constant standard deviation of the error term are met?

	IN-CLASS ACTIVITIES


	Activity 11-1:  Testing the Slope Coefficient  


a) Open the SPSS data file SAT99.SAV XE "SAT99.SAV" .  Use Analyze > REGRESSION > Linear to use percent taking the SAT examinations to predict the average score for the MAT SAT.  Verify that you get output like that shown below.
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b) The line of output beginning with Percent is for the slope coefficient.  In general, the row beginning with the name of the predictor is for the slope coefficient for that regression.  The first entry shows that
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 and record the value you get below.

c) Does this value appear in the SPSS output?  If so, where?

The most commonly conducted test regarding the population slope coefficient,
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, has the null hypothesis of
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The test is usually run against the alternative hypothesis of 
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If the error term in the regression model,
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, has a normal distribution with mean 0 and a constant standard deviation of 
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 then the ratio
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has a t distribution with d.f. = n-2.  This ratio appears in the t column of the SPSS regression output.  It is used to compute the p-value of our test.  The p-value is computed in the same manner as we did when we were testing population means.  We summarize the calculation below.

	Testing XE "Regression parameters, testing" 
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	d.f. = n – 2

	p-value:


[image: image506.wmf]1

:0

Pr()

a

H

pTt

b

>

=³


	
[image: image507.wmf]1

:0

Pr()

a

H

pTt

b

<

=£


	
[image: image508.wmf]1

:0

2Pr()

a

H

pTt

b

¹

=³



	Technical requirements:
a) Random Sample

b) Error term has a normal distribution with mean 0.
c) Standard deviation of the error term is the same for all values of the predictor.


d) How many degrees of freedom are there for this test on
[image: image509.wmf]1

b

?

e) Use Table II to compute the p-value for the test of 
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In the SPSS regression output the column labeled Sig computes the exact value for the two-sided test.  It should compare favorably with the answer you just got.  If you are interested in conducting one of the one-sided tests you can use the p-value returned by SPSS in the following manner.  
	
[image: image511.wmf]1

:0

a

H

b

>


	If 
[image: image512.wmf]0

t

>

, p-value = Sig./2
If 
[image: image513.wmf]0

t

£

, p-value = 1 - Sig./2

	
[image: image514.wmf]1

:0

a

H

b

<


	If 
[image: image515.wmf]0

t

³

, p-value 1 - Sig./2
If t < 0, p-value = Sig/2


	Activity 11-2:  Testing the Intercept XE "Intercept" 


a) The line of output beginning with Constant is for the Intercept XE "Intercept" .  This is the case in all regressions.  The first entry shows that
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b) Does this value appear in the SPSS output?  If so, where?

The most commonly conducted test regarding the population intercept,
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, has the null hypothesis of
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The test is most usually run against the alternative hypothesis of 
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If the assumptions that the error term in the regression model,
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, has a normal distribution with mean 0 and a constant standard deviation of 
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 are met then the ratio
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has a t distribution with d.f. = n-2.  This ratio is what the value that appears in the t column of the SPSS regression output.  It is used to compute the p-value of our test.    The p-value is computed in the same manner as we did when we were testing slope coefficient.  We summarize the calculation below.

	Testing XE "Regression parameters, testing" 
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	p-value:
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	Technical requirements:
a) Random Sample

b) Error term has a normal distribution with mean 0.
c) Standard deviation of the error term is the same for all values of the predictor.


c) How many degrees of freedom are there for this test on 
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d) Use Table II to compute the p-value for the test of
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.  Record you value below.

The column labeled Sig in the SPSS regression output computes the exact value for the two-sided test.  It should compare favorably with the answer you just got.  If you are interested in conducting one of the one-sided tests you can use the p-value returned by SPSS in the following manner.  
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SPSS gives a second way to test
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.  This is done by using the part of the results labeled ANOVA.  ANOVA stands for ANalysis Of VAriance.  We will see more Analysis of Variance XE "Variance"  tables XE "Analysis of Variance table for regression"  like this in subsequent topics.  Anyway, let’s begin by defining the following quantities known as sums of squares XE "Sums of squares" .  

	Total sum of squares: XE "Total sum of squares" 
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	Sum of squares due to regression XE "Regression sum of squares" :
	
[image: image540.wmf](

)

2

ˆ

i

SSRYY

=-

å



	Error sum of squares: XE "Error sum of squares" 
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You will not be asked to compute these in this course.  For a given regression these appear in the Sum of Squares column of the ANOVA section.  Using these we can then define the following quantities known as mean squares XE "mean square" .

	Mean square XE "Mean square"  due to regression:
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	Mean square XE "Mean square"  for error: XE "Mean square for error" 
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For a given regression these appear in the MS column of the Analysis of Variance XE "Variance"  section.  The column labeled df contains what are known as degrees of freedom.  If the same technical requirements that we needed for the t tests are met then it turns out that the ratio
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will have an F distribution XE "F distribution"  with 
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where f is the computed value for F.  We can now give the form that all Analysis of Variance XE "Variance"  tables will have for regressions with one predictor.  We list where the quantities we have defined can be found.

Source of        Sum of                  Mean

Variation       Squares       df        Square      F        P

Regression       SSR           1         MSR    MSR/MSE    p-value

Residual XE "Residual"          SSE          n-2        MSE

Total            SSTotal      n-1

	Activity 11-3:  Using the Analysis of Variance XE "Variance"  Table


a) Using the SPSS data file SAT99.SAV XE "SAT99.SAV"  use percent taking the SAT examinations to predict average Verbal SAT score.  Write the regression equation and the value of 
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 in the space below.

b) Transcribe the Analysis of Variance XE "Variance"  table in the space below.

c) What does this table lead you to conclude?

d) Square the value of the t statistic for testing
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.  Does this value appear anywhere in the SPSS output?  If so, where?

In this setting the t and F tests are identical.  Both test the two-sided alternative, and both give the same p-value.  That is, they are two different ways of running the same test.  At this point you may be wondering why we need two different tests on the slope coefficient.  As we shall see in Topic 12 when we consider models with multiple explanatory variables the ANOVA test and the t tests actually test different hypotheses.  

All of the tests we have been discussing and all of the confidence interval procedures we discussed in Topic 10 have been dependent on the satisfaction of the following requirements XE "Checking regression assumptions" .

· We have a random sample.

· The response and explanatory variables are linearly related.

· The error term in the regression model has a normal distribution.

· The standard deviation of the error term has the same value regardless of the value of the explanatory variable.

How do we assess whether or not these requirements have been met?

· There is no way to use the sample data to determine if the sample was random.  The experiment that generates the data must be designed in a manner to ensure the existence of a random sample.

· A fitted line plot is, perhaps, the easiest way to ascertain whether or not the predictor and response have a linear relationship.  The data points should be randomly scattered around the fitted line.  If there is a pattern present, then a linear relationship is questionable. 

· The residuals can be analyzed to assess the last two requirements.

Note from our discussion above that the sum of squares for error in the ANOVA table is computed by summing the squares of the residuals XE "residual analysis" .  Thus, the residuals give us information regarding the error term.  SPSS gives the option of drawing a number of graphs of the residuals.  

	Activity 11-4:  Analyzing Regression Residuals


a) Open the SAT99.SAV XE "SAT99.SAV"  data file.  In Analyze > Regression > Linear click the Plots button to get the dialog box shown below.  

[image: image550.png]inear Regression: Plots

Seatter 1 of 1

Roipren v [z ek
I | (N

Standardized Residual Plots
T~ Histogram

T~ Produce all parial plots

I Nomal probabilty plat





· A normal probability plot of the standardized residuals is like a Q-Q plot of the residuals.  Standardized residuals are simple the z scores for the residuals.  This means that the normal probability plot can be used to check that the error term has a normal distribution.

· A scatter plot of the residuals against the predicted values can be used to check that the relationship between the explanatory and response variables is linear and also that the standard deviation of the error term is constant.  Move *ZRESID to the Y box in the Scatter 1 of 1 area and *ZPRED to the X box of the Scatter 1 of 1 area.  These are the Z scores of the residuals and the 
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’s.  If the points in the scatter plot appear to be randomly scattered about 0, then a linear relationship is present.  If the dispersion pattern does not get wider or narrower as you move from left to right, then the standard deviation of the error term is constant.

· Set up the Plots dialog box to look like the one shown above.

b) Draw the residual plots using percent to predict average Math SAT score.  Does a linear relationship appear to be justified?

c) Does it appear that the error term has a normal distribution?

 XE "normal plot of  residuals" 
d) Does it appear that error term has a constant standard deviation?

	Homework Activities


	Activity 11-5:  Verbal SAT Scores (cont’d.)


Use the data in the SPSS data file SAT99.SAV XE "SAT99.SAV" .

a) Compute the regression using percentage taking the examinations to predict the average verbal SAT score.  Report your regression equation. 
b) How many degrees of freedom are associated with the t test on 
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c) Use Table II to compute the p-value for testing 
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d) What do you conclude?

e) Analyze the residuals to determine if the regression model technical requirements appear to be satisfied.  What are your conclusions?

	Activity 11-6:  Physical Measurements (cont’d.)


a) Enter the physical measurements taken on members of your class in a SPSS worksheet.  Do the two measurements appear to be linearly related?  

b) Compute a regression line that uses forearm length to predict height.  Report your regression equation.
c) How many degrees of freedom are associated with the t test on 
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d) Use Table II to compute the p-value for testing
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e) What do you conclude?

f) Do the residuals indicate that the regression model technical requirements are satisfied?

	Activity 11-7:  Aircraft Operating Costs (cont’d.)


The SPSS data file AIRCRAFT.SAV XE "AIRCRAFT.SAV"  contains data on a number of commercial aircraft.  The variables are described in the worksheet.

a) Compute the regression line for using fuel consumption to predict operating cost.  Report your regression equation.  
b) Use the Analysis of Variance XE "Variance"  table to test 
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.  What are the degrees of freedom and the p-value?

c) What do you conclude?

	Activity 11-8:  Measuring Cherry Trees (cont’d.)


The SPSS data set CHERRY_TREES.SAV XE "CHERRY_TREES.SAV"  contains the diameter, height, and volume of a sample of black cherry trees.  

a) Fit a regression line that uses height times the square of diameter to predict the volume.  Report your regression equation.
b) Test
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c) What do you conclude?  What does this mean?

d) Test
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e) What do you conclude?  What does this mean?

f) Do the assumptions of the regression model appear to be satisfied?  Explain your reasoning.

	Activity 11-9:  Ice Cream Consumption


The SPSS data file ICECREAM.SAV XE "ICECREAM.SAV"  contains data regarding the consumption of ice cream and other factors.  We wish to see if the price of ice cream has an effect on the amount that is consumed.

a) Fit a regression line that uses the price per pint to predict the per capita consumption of ice cream.  Report your regression equation.
b) What hypotheses should you test in order to see if the price of ice cream has an effect on the amount consumed?

c) Conduct the test you chose in part (b).  What do you conclude?

d) Do the regression model assumptions appear to be satisfied?  Explain your reasoning.

Topic 12
Multiple Regression XE "Multiple regression" 
	OVERVIEW


In Topics 10 and 11 we saw how to make inferences regarding the parameters of a regression model using a single predictor.  Many times we have information about more than a single quantity.  Each of these quantities may give unique information about the value of a response.  It would then make sense to try to use all of these quantities jointly to make better predictions of the value of a response variable.  This is accomplished using what is known as multiple regression analysis.  In this topic we shall see how this is done and learn how to test the model parameters.

	OBJECTIVES


· Learn how to use multiple regression to make better predictions of a response variable.

· Investigate the multiple regression population model.

· Learn how to test individual slope coefficients.

· Learn how test all slope coefficients.

· Learn how to build a regression model.

	PRELIMINARIES


a) What do think would be the most important characteristics in ranking a college?

b) What do you think would be the least important?

	IN-CLASS ACTIVITIES


In this topic we are interested in predicting the value of a response variable using multiple explanatory variables.  The idea is that if a single explanatory variable can help predict the value of a response variable, then including other explanatory variables can provide additional information regarding the response variable.  When this is the case we can make more accurate predictions.  Using multiple explanatory variables results in what is known as a multiple regression.  Using a single explanatory variable is commonly referred to as a simple regression.  As was the case in simple regression, there is a population model for multiple regression.  We shall assume that there are k predictors, 
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	Population Model for Multiple Regression XE "Multiple regression model" 
Given a response Y, and k predictors, 
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where each 
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is a random quantity having a normal distribution with a mean of 0 and a standard deviation of 
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If we compare this model with the model for simple regression given in Topic 10 there are a number of similarities.  There is an intercept XE "intercept" , 
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.  Each predictor has associated with it a slope coefficient XE "Slope coefficient" , 
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.  Finally, the error term has the same properties as in the simple regression model.  We let 
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 represent the sample intercept, 
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 represent the sample slope coefficient associated with predictor 
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 is called the standard error of the estimate.   It is denoted by s and is calculated by
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We have the following correspondence between parameter and statistic.

	Parameter
	Statistic
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There is no easy way to give formulas for the sample slope coefficients.  So we will not attempt to describe how they are calculated.  The method for calculating the sample intercept is not too bad once you have the sample slope coefficients, but since we will not ask you to calculate them there is no point in writing it down.  Ask your instructor if you are interested in seeing it.

	Activity 12-1:  Predicting College Rankings  


a) Open the SPSS data file COLLEGE2000.SAV XE "COLLEGE2000.SAV" .  It contains information from US News and World Report regarding small liberal arts colleges in the northeast.  We are interested in using more than one explanatory variable to predict the value of the Score variable.  

b) In Analyze > Regression > Linear use freshman retention, FrRet, and financial resources, Fin Res, as independent variables and Score as the dependent variable.  Freshmen retention is the percentage of incoming freshman that remain at the school for the next year.  Financial resources is a measure of the amount the school spends per student for the academic programs.  Your dialog box should look like the following.
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Click OK.  You should see output like that shown below. 
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This is an example of a multiple regression.  The term simply means that two or more variables are used as predictors for the response variable.  In principle, the number of predictors that can be used is unlimited.  In practice, it is generally desirable to use as few as possible.  In the regression output you will note that in the Coefficients section there is a row for the sample intercept, labeled Constant, and one row for each of the predictors that begins with the name of that predictor.  Please note that the explanatory variable rows show the label for that variable, not the variable name.  If there is no label, it will be blank.  Therefore, you always want to give each variable a label.  The information given in each row is the same as was the case in the simple regression output.  After the name the B column gives the sample value of the slope coefficient, 
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, for that variable.  The Std. Error column contains the standard error of the slope coefficient, 
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The final column contains the two-sided p-value for testing
[image: image580.wmf]0

:0 v.s :0

jaj

HH

bb

=¹

.  From the Coefficients area we see that the multiple regression equation is

Score = -23.254 + 1.366Freshman Retention - .116Fincial Resources.
c) In the regression you performed in part (b), what is the value of k?

d) Use the output to write below the value of the sample intercept, the slope coefficients and s.
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Confidence intervals for the
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are calculated in a manner similar to that shown in Topic 10.  The only change is that the critical value from the t tables is found using n-k-1 degrees of freedom instead of n-2.  There are just more of them.  SPSS will report 95% confidence intervals by checking Confidence intervals in the Regression Coefficients section of the Statistics dialog box.  Intervals for other confidence levels must be computed by hand.  The general procedure is outlined below.

	Confidence Interval for XE "Regression parameters, confidence interval"  
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where 
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 is the critical value for the desired confidence level using 
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Technical requirements:

a) Random Sample

b) Error term has a normal distribution with mean 0.
c) Standard deviation of the error term is the same for all values of the predictors.


	Activity 12-2:  Confidence Intervals for 
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a) What are the degrees of freedom for constructing a confidence interval for the slope coefficient associated with financial resources?

b) What is the critical value for constructing a 90% confidence interval for the slope coefficient associated with financial resources?

c) Use the formula just given and the information shown in part (b) of Activity 12-1 to construct a 90% confidence interval for the slope coefficient associated with financial resources.

Testing the null hypothesis that 
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is like what we saw in the case of simple regression.  The only difference is that the degrees of freedom are now n-k-1.  We shall show how it is done.
	Testing XE "Regression parameters, testing" 
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	Test Statistic:
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	Technical requirements:
a) Random Sample

b) Error term has a normal distribution with mean 0.
c) Standard deviation of the error term is the same for all values of the predictors.


If you are using SPSS output, the one-sided p-values are calculated in the same manner as you were shown in Topic 11.  That is,
	
[image: image595.wmf]:0

aj

H

b

>


	If 
[image: image596.wmf]0

t

>

, p-value = Sig./2
If 
[image: image597.wmf]0

t

£

, p-value = 1 - Sig./2

	
[image: image598.wmf]:0

aj

H

b

<


	If 
[image: image599.wmf]0

t

³

, p-value 1 - Sig./2
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	Activity 12-3:  Testing Hypotheses Regarding the
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a) What is the value of the test statistic for testing 
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b) Use the information given in the output shown in Activity 12-1 to compute the p-value for the test shown in part (a).

c) What does this p-value lead you to conclude?

The individual slope coefficient tests we have been discussing are not as straightforward in the multiple regression setting as they were in the simple regression case.  One phenomenon is that, depending on the set of explanatory variables chosen, the slope coefficients and individual test results typically vary from model to model.  The reason for this is that the individual tests assess the contribution a given predictor has on the value of the response in the presence of the other predictors in the model.

d) Conduct a multiple regression using freshmen retention, financial resources and alumni rank to predict the score.  Record the slope coefficient for financial resources and the p-value associated with testing whether or not the slope coefficient associated with financial resources is negative.  

e) Did the slope coefficient for financial resources and the strength of evidence against 
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f) Compare the 
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 values for the two-predictor model in Activity 12-1 with the one you just conducted.  What is the difference?

This last part illustrates a phenomenon that always takes place in multiple regression.  The t test for alumni rank indicates that this variable does not contribute to predicting the scores, but the 
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value increased.  Including new predictors in a multiple regression, useless or not, will always result in higher 
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 values.  This is the reason for also computing the 
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 value.  It takes into account the number of predictors in a model.  The formula for it is
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When you are comparing models with different numbers of predictors, the adjusted 
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values should be used to compare the degree of fit.

g) Compare the 
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 values for the model in Activity 12-1 and this activity.  Based on these values, which model has the better degree of fit?

In addition to the individual tests for the slope coefficients, SPSS also lets you test the hypothesis that all of the slope coefficients are zero.  Specifically, we can test
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In words, the null hypothesis is that all slope coefficients are zero, the alternative hypothesis is that at least one of the slope coefficients is not zero.  This is done in the Analysis of Variance XE "Variance"  table XE "Analysis of Variance table"  of the standard regression output.  If you were wondering in Topic 11 why the table was even there, now you know.  It is useful in multiple regressions.  

Except for the degrees of freedom column, the description of the Analysis of Variance XE "Variance"  table is like that for the simple regression case.  In the degrees of freedom the degrees of freedom for regression is equal to the number of predictors in the model, k, and the degrees of freedom for the residual error is now n-k-1.  The sums of squares are computed exactly as we showed in Topic 11.  The mean squares are still the sums of squares divided by their respective degrees of freedom.  The F statistic is still the ratio of MSR/MSE, and the p-value is calculated in the same manner.  Thus, we summarize the procedure below.

	Testing XE "Regression parametersm, testing" 
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	Test Statistic:
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	Technical requirements:
a) Random Sample

b) Error term has a normal distribution with mean 0.
c) Standard deviation of the error term is the same for all values of the predictor.


	Activity 12-4:  Using the Analysis of Variance XE "Variance"  Table


a) Use the regression results from Activity 12-3.  In the space below write down the values for MSR, MSE and F.
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b) What are the degrees of freedom for the F statistic?

c) Use Table IV to compute the p-value for the F test.

d) What do you conclude?

When there are a large number of potential predictors for a given response, the problem of selecting the “best” set of them becomes important.  In the college data set there are 15 variables that we can use as predictors.  This means that there are an extremely large number (32,767) of potential multiple regression models to choose from.  We shall try to give some guidance in approaching the problem.  

· First you want to find variables that have high correlations with the response.  Recall that correlation measures the degree to which two variables are linearly related to each other.

· You want predictors that have relatively low correlations with each other.  This is because you want the predictors to account for different aspects of the observed variability of the response.

· You want a high a value for the 
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.  

· You want to use the fewest number of predictors that gives a good value of 
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.  This is called the principle of parsimony.  

· You do not want to include predictors that do not contribute to the ability to predict the response.

	Activity 12-5:  Selecting a Multiple Regression Model XE "Selecting a Multiple Regression Model" 


a) Have SPSS generate models for the following sets of predictors.  Write down the quantities indicated.  For each model the response variable is Score.
	Predictors:
	Individual t Test

p-value
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	Reputation


	
	

	Reputation

S/F Ratio


	
	

	Reputation
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Fin. Res.


	
	


b) Based on the principles given above which of these models would you recommend?  Briefly explain your reasoning.  What is the regression equation for this model?
	Homework Activities


	Activity 12-6:  Ice Cream Consumption (cont’d.)


a) Use the data in the SPSS worksheet ICECREAM.SAV XE "ICECREAM.SAV" .  Fit a multiple regression model using price, family income and mean temperature to predict consumption.  Write a summary of your findings including what your regression equation is.
b) Do you like this model?  If so, why do you like it?  If not, what would you recommend doing next?

	Activity 12-7:  Rating Supervisors


The SPSS data file SUPERVISOR.SAV XE "SUPERVISOR.SAV"  contains the results of clerical employees of a large financial organization rating the performance of 30 supervisors.  The data come from Regression Analysis by Example, by Chatterjee and Price, Wiley, 1977.  Questions covered six different aspects of supervisor characteristics.  They were the following.

· Handles employee complaints

· Does not allow special privileges

· Opportunity to learn new things

· Raises based on performance

· Too critical of poor performance

· Rate of advancement to better jobs

a) Fit the following three models for predicting rating.  Summarize your findings for each model including what your regression equation is.

· Handles employee complaints

· Does not allow special privileges

· Handles employee complaints and Does not allow special privileges

b) How do you account for the fact that, taken individually, both predictors are significant, but taken together one predictor is significant and one is not?

	Activity 12-8:  Rating Supervisors (cont’d.)


Use the SPSS data file SUPERVISOR.SAV XE "SUPERVISOR.SAV" .  Use the principles outlined in this topic to find the “best” multiple regression that uses one, two, or three explanatory variables to predict the supervisor rating.  Show which models you tried and explain why you chose the model you did.  Restrict your investigation to the three questions “Handles employee complaints,”  “Raises based on performance,” and “Too critical of poor performance.”  Give the regression equation for each model that you tried.  There are seven different models here.
	Activity 12-9:  Aircraft Operating Costs (cont’d.)


a) Use the data in the SPSS worksheet AIRCRAFT.MTW XE "AIRCRAFT.SAV"  to find the “best” regression model for predicting aircraft operating costs.  There are 15 possible models here. 
b) Create a table like the one in Activity 12-5 to summarize your findings.  

c) Indicate which model you finally choose and describe why you feel it is preferable to the others.  Give the regression equation for that final model.
	Activity 12-10:  Predicting College Rankings (cont’d.)


The SPSS data file COLLEGE2000.SAV XE "COLLEGE2000.SAV"  contains data on liberal arts colleges in the Northeast.  It contains the overall rating score assigned by US News and World Report and 15 possible explanatory variables.  
If we tried to find the best set of these 15 variables for predicting the score, we would have to consider a large number of different multiple regression models.  There are actually 32,767 possible combinations of predictors.  One method that is used to speed up the process is to employ what is called a step-wise  XE "Step-wise regression" approach.  You will note that there is a stepwise option in the regression menu.  We will not use that technique, but we shall employ the idea of that approach.

a) Fit a regression model that uses all 15 variables as predictors.

b) Begin with the predictor that has the highest p-value that is higher than 0.05 and eliminate it from the model.  Fit the model with fourteen predictors.

c) Continue as above until you have a set of predictors where each has a p-value less than 0.05.

d) What is your final model?  What is the associated regression equation?
e) Look at the coefficients for the predictors.  Given what you know, do they make sense? Briefly explain why you think they do or why you think they do not.
f) Why will this approach not always result in the “best” set of predictors?
Topic 13
Logistic Regression XE "Logistic regression" 
	OVERVIEW


We have been investigating regression models where the predictor and response variables are quantitative variables.  In the social sciences the use of categorical variables is quite common.  It frequently occurs that investigators are interested in determining what characteristics make it more likely for a person to belong to one category as opposed to another.  For example, an investigator may wish to know if people who go to church frequently are less likely to end a marriage in divorce than people who go to church less frequently.  When both the explanatory and response variables are categorical it is possible to approach such a question by constructing and analyzing two-way tables.  Another approach that is used is to construct a regression model where the response measures the likelihood of divorce and the predictor is the number of times per month that a person goes to church.  Such models are known as logistic regression models.  We wish to introduce you to some of the basics behind this analytic tool.

	OBJECTIVES


· To learn how to recode variables using SPSS.

· Introduce the basic ideas in building simple logistic regression models.

· See how SPSS performs logistic regression.

· See how to interpret the coefficients that result from a logistic regression.

	PRELIMINARIES


a) Do you feel that women are more likely than men to believe that marriage is a lifetime relationship that should be ended only under extreme circumstances?
b) Do you feel that people who go to church frequently are less likely to end a marriage in divorce than people who do not go to church frequently?

	IN-CLASS ACTIVITIES


	Activity 13-1:  Odds  


a) Open the data file NSFH.SAV XE "NSFH.SAV" .  The variable E1295E gives the responses to the statement “Marriage is a lifetime relationship and should never be ended except under extreme circumstances.”  Recode the variable E1295E so that 1 and 2 have a value of 1 and all other non-missing values become 0.  Store the recoded values in a new variable.  You do this as follows.

· Click Transform > Recode > Into different variables to bring up the following dialog box.
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· Place the variable to be recoded in the Numerical Variable -> Output Variable box.  The right side of the arrow will show a question mark.

· In the Output Variable area enter a name for the new variable in the Name box, a label for the new variable in the Label box and click Change.  The name of your new variable will replace the question mark.

· Click Old and New Values to bring up the following dialog box.
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· Check Value in the Old Value area and in the New Value area.  One at a time enter the values to be changed one at a time in the Value box in the Old Value area followed by the new value in the Value box in the New Value area, and click Add.  The dialog box shows that we want a 1 to be changed to a 1, and a 2 to be changed to a 2.  Since all the other old values are to become 0, we check All other values in the Old Value area, enter 0 in the Value box in the New Value area, and click Add.

· Finally, click Continue and then OK. 
This new variable is binary where a 1 represents that the respondent agreed with the statement and a 0 represents the respondent either disagreed with the statement or was neutral.  Now to get the proportion of men and women who agreed with the statement, split the file using the gender of the respondent, M2DP01, as the grouping variable.  Now use, Analyze > Descriptive Statistics > Frequencies to compute the proportion of men that agreed with the statement and the proportion of women that agreed with the statement.  Call them 
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, respectively.  Record these proportions below.
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We will now compute the odds XE "Odds"  that a man will agree with the statement.  In general, odds is defined to be
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b) Compute and record below the following odds.
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The odds for the men should be about 2.3.  This means that, based on this sample, men are about 2.3 times more likely to agree with the statement than not.  The odds for women should be about 1.9.  Similarly, this means that women are about 1.9 times more likely to agree with the statement than not.

In a regression setting we wish to use some predictor variable, call it x, to predict the mean value of some response variable, call it y.  It would seem desirable in our context to let the response be the proportion of the time a respondent would agree with the statement regarding the sanctity of marriage.  The problem with this is that a regression equation of the form 
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can, for some values of x, result is predictions less than 0 or greater than 1.  In other words, predictions may not be valid values for a proportion. 

A possible fix to this problem is to let the response variable be the odds.  If you look at the formula for calculating odds, you will see that odds can, depending on the value of 
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, take on any value greater than or equal to 0.  Again, the problem with using odds is that some values of x may result in negative predictions.  

This problem is overcome by taking the natural logarithm of the odds.  This transformation is called, naturally enough, log odds XE "Log odds" .  It is also commonly referred to as the logit XE "Logit" .  Thus, our response variable in logistic regression is 
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This, finally, gives us our model for logistic regression.  

	Logistic Regression Model XE "Logistic regression model" 
The model for logistic regression is
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where p is the proportion of the population having a certain attribute and x a predictor variable.  The parameters of the model are 
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We will be using sample data to estimate
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.   The estimators are called 
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.  The correspondence is shown in the following table.

	Parameter
	Statistic
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	Activity 13-2:  Estimating Logistic Regression Parameters


a) Compute and record below the log odds for men and for women.  Most scientific hand calculators have a ln key that can do this.  In SPSS you can use the ln function in Transform > Compute.

	Men:
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	Women:
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· Let x be defined as follows


[image: image643.wmf]0,if male

1,if female.

x

ì

=

í

î


· This will be our predictor variable.

b) We now use the results in part (a) to write two logistic regression model equations, one for each value of x.  For example the one for the men would be 
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In the space below write the equation for the women.

c) The equation for the men gives you a value for 
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.  Use 
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 in the equation for women to obtain a value for 
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.  Write these two values in the space below.

d) Write the logistic regression equation in the space below.

Like all slope coefficients XE "Slope coefficients" , 
[image: image648.wmf]1

b

represents the change in the response for a one unit increase in the explanatory variable.  In this case this represents the difference in the log odds for men and women.  The only problem is how to interpret exactly what that means.  Fortunately, we can use this result to get an interpretation in terms of odds.  It is possible to show that 
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This is known as the odds ratio.
e) Use the above equation to compute 
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This means that the odds of a woman agreeing with the statement are about 82% of those for a man.

Having a binary predictor is an important special case of logistic regression.  It allows us to compute estimates for the model parameters easily.  It also makes interpretation of the estimates relatively easy.  We will now look at the more general situation where the predictor is a quantitative variable.  The procedure is rather complicated.   So we shall use the logistic regression capabilities of SPSS.  Click Analyze > Regression you will see that there are two logistic regression options.  Binary Logistic is to be used when the response is binary.  Multinomial Logistic is to be used when the response has more than two categories.  We will only consider binary responses in this introduction to the topic.  To conduct a logistic regression, proceed as follows.

· Click on Analyze > Regression > Binary Logistic to get the following dialog box.
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· Enter the variable containing your binary response variable in the Dependent XE "Dependent"  box.  

· Enter the column name for your explanatory variable in the Covariates box.  If you are using more than a single explanatory variable, enter all of them in the Covariates box.

· Then click OK to run the regression.

	Activity 13-3:  Using SPSS for Logistic Regression


a) We wish to run a logistic regression to use the level of educaton of the respondent to predict his/her gender.  The relevant variables are COMPLED and M2DP01, respectively. XE "NSFH.MTW" 
b) Run the binary logistic regression procedure using M2DP01 as the dependent variable and COMPLED as the covariate.  You should get results that look like the following.

Logistic Regression
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There is a lot of stuff here.  So, let’s go through it in order.  

· The first block is the usual case processing summary.  The first table is just an accounting of how many cases were used in the analysis.  The second table shows what the values of the response variable were.

· The calculation process to get the final regression is an iterative one.  SPSS gives statistics at the start of the process (Step 0) and after completing the process (Step 1).  We will concentrate on the final results.

· The Omnibus Tests of Model Coefficients table contains three chi-square tests of the null hypothesis that all slope coefficients are zero.  This is analogous to the ANOVA F test in an ordinary regression.

· The Model Summary table contains what is called -2 Log likelihood.  Recall that ordinary regression tries to minimize the sum of the squared residual (least squares).  In logistic regression the quantity -2 Log likelihood is what we are trying to minimize.  The other two entries are quantities that have an interpretation similar to R2 in ordinary regression.
· The Classification Table is what you might expect.  It is a summary of what the actual values of the response variable were compared to what the logistic regression equation predicts.  Predictions in logistic regression are made so that a predicted value of log odds less than zero are assigned to the category with lower number.  Otherwise, a case is assigned to the category with the higher number.
· The Variables in the Equation table is analogous to the Coefficients table in an ordinary regression.  The entry in the B column gives the b for the slope coefficient and the intercept.  As before the slope coefficient is in the row containing the name of the explanatory variable, and the intercept is in the row labeled Constant.  So, in this case, the logistic regression equation is 
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· The SE results are the standard errors associated with the b’s.  In logistic regression the ratio 
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 has a normal distribution.  

· The Wald column gives the value the squares of these ratios.  It has an approximate chi-square distribution.  

· The Sig column gives the p-value for testing 
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· The Exp(b) column shows 
[image: image665.wmf]b

e

.  Here we see that 
[image: image666.wmf]0

.869

b

e

=

 and 
[image: image667.wmf]1

2.266

b

e

=

. 

c) Perform a logistic regression using the education level of the respondent to predict whether the respondent has an income above the median income.  Use Transform > Compute and IREARN to create a variable where a respondent with an income above the median value of $8000 gets a 1 and all other respondents get a 0.  Look at the SPSS results and briefly describe what you see.

	Homework Activities


	Activity 13-4:  Gender and the Death Penalty


As part of the Religion and Politics Survey in 1996, the Pew Center for The People and The Press, asked respondents about whether or not they favored the death penalty.  85.6% of 918 men having an opinion stated they were in favor of the death penalty to some degree.  77.9% of 974 women having an opinion stated they were in favor of the death penalty to some degree.

a) Calculate the odds for a man to favor the death penalty and the odds for a woman to favor the death penalty.  Give an interpretation of what these mean.

b) Calculate the log odds of each of the odds found in part (a).

c) Let x = 0 for a man and x = 1 for a woman.  Find a logistic regression equation for predicting the log odds of a person to favor the death penalty.

d) Use your logistic regression equation to compute 
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	Activity 13-5:  Political Views and Gun Control


In the same survey cited in Activity 13-4, 42.3% of 736 respondents who identified themselves as political conservatives favored some form of hand gun control and 62.6% of 1153 respondents who identified themselves as political moderates or liberals favored some form of hand gun control.

a) Calculate the odds for a conservative to favor hand gun control and the odds for a moderate or liberal to favor the hand gun control.  Give an interpretation of what these mean.

b) Calculate the log odds of each of the odds found in part (a).

c) Let x = 0 for a conservative and x = 1 for a moderate or liberal.  Find a logistic regression equation for predicting the log odds of a person to favor the hand gun control.

d) Use your logistic regression equation to compute 
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.  Give an interpretation for what this quantity means.

	Activity 13-6:  Age and Heart Transplant Survival


The Stanford Heart Transplant Program began in 1967.  Data from the program include the age at the time of transplant and whether or not the patient was alive in February, 1980.  The data are stored in the SPSS data file TRANSPLANT.SAV XE "TRANSPLANT.SAV" .  The variable Survival has a value of 0 if the patient is still alive and a value of 1 if not.

a) Have SPSS perform a logistic regression using age to predict survival.

b) Give a brief interpretation of what you find from the results.

c) Is the age at the time of transplant a useful predictor of the likelihood of survival?  Explain your reasoning.

	Activity 13-7:  Age and Political Views


Do people tend to earn more as they become older?  These data can be found in the SPSS data file NSFH.SAV XE "NSFH.SAV" .  As you did in Activity 13.3 create a variable so that a respondent above the median income of $8000 gets a 1, and one with an income of $8000 or less gets a 0.

a) Have SPSS perform a logistic regression using age to predict income.

b) Give a brief interpretation of what you learn.

c) Do the data indicate that there is a tendency for older people to earn more?  Explain your reasoning.

	Activity 13-7:  Gender and Income


Do women tend to earn less than men?  In the SPSS data file NSFH.SAV XE "NSFH.SAV"  the variable IREARN gives the respondents income, and the variable M2DP01 gives the respondent’s gender—1 = male, and 2 = female.

a) Create a new variable containing income divided by 1000.  Call it INCOME.  

b) Have SPSS perform a logistic regression using income to predict gender.

c) Summarize what you find.

d) Do women tend to earn less than men?  Justify your conclusion

Topic 14
Correlation Analysis XE "Correlation analysis" 
	OVERVIEW


For the past few topics we have been investigating the relationship between variables where the ultimate aim is to use one or more predictor variables to estimate the value of a response variable.  In many instances the primary interest is in simply determining if two variables are related to each other.  This was the goal of the two-way table analyses we discussed in Topics 7, 8 and 9.  We now look at determining if there is a relationship between two measurement variables.  This analysis is referred to as correlation analysis.

	OBJECTIVES


· See how to test whether a relationship exists between two measurement variables.

· Learn how to compute the Fisher z transformation XE "Fisher z transformation" .

· See how to test whether a given strength of relationship exists between two measurement variables.

· Lear to use SPSS to test correlations.

	PRELIMINARIES


a) Do you feel that there is a relationship between a person’s height and forearm length?  Will it be positive or negative?

b) Do you feel that, if such a relationship exists, it will be a strong one?

	IN-CLASS ACTIVITIES


	Activity 14-1:  Aircraft Speed and Fuel Consumption


a) Open the SPSS data file AIRCRAFT.SAV XE "AIRCRAFT.SAV" .

b) Have SPSS compute the correlation between aircraft speed and fuel consumption.  Record the value you get in the space below.  You use Analyze > Correlate > Bivariate in the same as you did in the first course.  The dialog box should look like the one shown below.  In the resulting output the value in the Pearson Correlation row of the cell in the Speed row and Fuel Consumption column is the value of r. 
[image: image670.png]e Correlat

[ Number ofseats [seats Variabes:
& Range (mi) range] Spesd (mph [speed]
& Operating Cost (31 & Fuel Consumption (gal/

o

- Conelaion Coeficients
IV Peason [ Kendaltstawb [~ Speaman

[ Testof igrifcance.
& Twotaled © Onetaikd

¥ Flag sigifcant corelations

Resel

|
[
|

Cancel

Help

Opiins.





The sample correlation coefficient XE "Correlation coefficient" , r, describes the strength of linear relationship that exists between two measurement variables that is observed in a sample.  If the sample is a random sample, this quantity gives us information regarding the existence of a linear relationship in the population from which the sample was drawn.  This population correlation coefficient is designated by the Greek letter rho, 
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.  So, in correlation analysis the parameter is
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 , and the statistic is r.  Recall from the first course that the formula shown below is used to compute r.  We assume generically that the two measurement variables are X and Y.
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where 
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 is the sample mean for X, 
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is the sample mean for Y, 
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is the sample standard deviation for X, 
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is the sample standard deviation for Y, and n is the sample size.

We would like to determine if a linear relationship exists between X and Y in the population.   To do this we will conduct a test of the hypothesis that
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.   The test will determine if a non-zero value for the sample correlation coefficient is evidence that 
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 is different from 0 or if the observed non-zero value is attributable to sampling variability.  It turns out that, if both X and Y have normal distributions then the quantity
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will have a t distribution with n-2 degrees of freedom when 
[image: image681.wmf]r

=0.  Thus, we get the following test procedure.
	Testing the Correlation XE "Correlation, testing" 
When testing
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the test statistic is
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   d.f. = n-2.

If t is the computed value for T, the p-value is computed by
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	Technical requirements:

a) Random sample
b) Both X and Y have normal distributions


	Activity 14-2:  Testing for Zero Correlation


a) Construct normal Q-Q plots on aircraft speed and fuel consumption.  Does the requirement for both variables having a normal distribution appear to be justified?

b) What are the degrees of freedom associated with the sample of aircraft?

c) Calculate and record below the value of the T statistic.

d) Calculate the p-value for testing 
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e) What do you conclude?

SPSS conducts this test.  If Two-tailed is checked in the Test of Significance area SPSS will report the p-value for testing 
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.  It is in the row labeled Sig. (2-tailed)  If One-tailed is checked in the Test of Significance area will report the p-value for testing 
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 against a one tailed alternative.  The alternative hypothesis being tested depends on the sign of r.  If r > 0, the alternative hypothesis is
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The test we have been discussing can be used for testing the null hypothesis that
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.  It cannot be used for any other null hypothesis or for constructing confidence intervals for
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.  In order to tackle these problems we can make use of a result developed by R. A. Fisher XE "Fisher z transformation" .  He observed that 
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has an approximate normal distributed with a mean of 
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and a standard deviation of 
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for all values of 
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.  
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is the natural logarithm.  We encountered it in Topic 13.  The formula for converting a Fisher Z score back to a correlation is
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where z is the Fisher Z score.  The number e is the base of the natural logarithms and is equal to about 2.71828.
Through the use of this transformation we can construct confidence intervals for 
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 in the manner described below.

	Confidence Intervals XE "Correlation, confidence interval"  for 
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a) Compute 
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b) Construct a confidence interval for z by
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· where z* is the critical value from the normal tables for the desired confidence level.

c) Let 
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d) Then the desired confidence interval for 
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Technical requirements:

a) Random sample.

b) Both X and Y have a normal distribution.


We provide the SPSS script CORRELATION.SBS XE "CORRELATION.SBS"  to do these computations.  Select Utilities > Run Script and run CORRELATION.SBS to bring up the dialog  box shown below.  Enter the sample correlation, r, in the Sample Correlation box.  Leave the Test Correlation box alone.  Enter the sample size, N, in the Sample Size box.  Enter the desired confidence level, in percent, in the Confidence Level (%) box.  Click OK to run the script.  The confidence interval will be the second table in the resulting output.
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	Activity 14-3:  Constructing a Confidence Interval for 
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Use the script CORRLEATION.SBS XE "CORRELATION.SBS"  to construct a 95% confidence interval for the population correlation between speed and fuel consumption.  Record the confidence limits in the space below.
Testing hypotheses regarding values other than 
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It turns out that 
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has an approximate standard normal distribution.  This means that we have a test statistic that has a normal distribution.  The testing procedure is summarized below.

	Testing XE "Correlation, testing" 
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a) Compute r.  Then obtain
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b) Compute
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c) The value of the test statistic is 
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d) The p-value is computed by the following.
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	Technical Requirements:

a) Random sample.

b) Both X and Y have normal distributions.


The script CORRELATION.SBS XE "CORRELATION.SBS"  also conducts the test just described.  In the dialog box for the script enter the sample correlation, r, in the Sample Correlation box, enter the population correlation being tested in the null hypothesis, 
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, in the Test Correlation box, enter the sample size, N, in the Sample Size box, leave the Confidence Level (%) alone, and click the appropriate alternative hypothesis in the Alternative box.  Click OK to run the script.  The test results will appear in the first table in the resulting output.
	Activity 14-4:  Testing 
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a) Use the script CORRELATION.SBS  to test 
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.  Record the value of z and the p-value in the space below.
b) What do you conclude?
	Homework Activities


	Activity 14-5:  Physical Measurements


Open the SPSS data file containing the data collected in the preliminaries to Topic 10.  

a) Compute the correlation between height and forearm length.

b) How many degrees of freedom are associated with these data for testing 
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c) What is the t value for testing 
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d) Compute the p-value for testing 
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e) What do you conclude?  State, in English what this tells you about any relation between height and forearm length.

	Activity 14-6:  Test Scores


The SPSS data file SCHOOLTESTS.SAV XE "SCHOOLTESTS.SAV"  contains data on the average score of participating states on tests of mathematics and reading for 4th and 8th graders.  The correlation between 4th grade mathematics scores and 4th grade reading scores is 0.893.  The number of states that reported both scores is 37.

a) Compute the Fisher Z value for this correlation.

b) What is the critical value for a 99% confidence interval for
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c) Construct a 99% confidence interval for
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	Activity 14-7:  Body Mass in Anorexic Patients


Is there a relation between the preferred body mass for patients with anorexia and the body mass at the time of discharge from a treatment program?  A sample of 20 patients in a treatment program showed a correlation of 0.192 between the preferred body mass and the body mass at the time of discharge.  

a) Use these data to test for the existence of a correlation, 
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, in the population of all patients in treatment for anorexia.  

b) What are your findings?

	Activity 14-8:  College Spending


Do colleges that spend more on faculty related items also spend more on academically related student items?  A sample of 27 liberal arts colleges in the Northeast showed a correlation of 0.591 between spending per faculty member and spending per student.

a) Do these data indicate that there is a positive correlation between these two types of spending?  Justify your conclusion.

b) Do the data indicate that there is a correlation that is stronger than 0.5?  Again, justify your reasoning.

	Activity 14-9:  A Perception Experiment


A psychological experiment asked 24 blindfolded subjects to walk an irregularly curved track.  At various points they were asked to estimate the angular position of the shortest line to their starting point.  The question was whether or not the error in their estimated angle depends on the true angle.

a) Formulate this as a test of hypotheses.

b) Use the data in the SPSS data file PERCEPT.SAV XE "PERCEPT.SAV"  to compute the sample correlation between the true angle. TRUE, and error, ERROR.

c) Conduct the test you formulated in part (a).

d) What do you conclude?
Topic 15
Correlation Analysis—Rank Correlation XE "Rank correlation" 
	OVERVIEW


We have seen how to construct confidence intervals and test hypotheses regarding a population correlation when both variables have a normal distribution.  There are situations, however, when we cannot safely assume normal distributions or where a non-linear relation may exist between two variables.  In such cases it can be useful to assess the degree of relation between two quantitative variables by using ranks instead of the raw observations.  One of the most popular rank-based correlation measures is known as Spearman’s Rho.  That will be the subject of this topic.

	OBJECTIVES


· Learn how to compute Spearman’s Rho.

· Learn how to test hypotheses regarding Spearman’s Rho.

· Learn how to use SPSS to compute Spearman’s Rho.

	PRELIMINARIES


a) Do you feel that there is a relation between the cruising speed of a jet airliner and its range?

b) Would such a relation be linear?

	IN-CLASS ACTIVITIES


	Activity 15-1:  Aircraft Speed and Range


a) Load the SPSS data file AIRCRAFT.SAV XE "AIRCRAFT.SAV" .  Have SPSS draw a scatter plot between speed and range.  How would you describe the relationship between the two variables?  

b) Have SPSS calculate the correlation between speed and range.  Record the value below.

c) Do you feel the value of this correlation accurately describes the direction and strength of relation between the two variables?

The scatter diagram shows a very strong relationship between speed and range.  The scatter diagram clearly shows that the relationship is not a linear one.  This has the effect that the correlation coefficient we have been discussing will underestimate the strength of the relationship between the two variables.  In situations such as this calculating the correlation coefficient between the ranks of the observations can give a better estimate of the strength of relationship between two measurement variables.

	Activity 15-2:  Calculating the Correlation Between Ranks


a) Have SPSS calculate and store the ranks for speed and for range.  It is done as follows.

· Click Transform > Rank Cases to bring up the following dialog box.
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· Make sure that Smallest value is checked in the Assign Rank 1 to area.  Select the variable(s) for which you want ranks in the Variable(s) box.

· Click OK.  The ranks will be stored in new variables and be given the name of the original variable preceded by an R.  
b) Have SPSS calculate the correlation between these two columns of ranks.  Record the value below.

c) Do you think this value is a more accurate measure of the relationship between speed and range?

The correlation we get by computing the ordinary correlation coefficient on the ranks instead of the original data is known as Spearman’s Rho.  It is designated by 
[image: image731.wmf]S

r

.  If you use SPSS to calculate it following the procedure of Activity 15-2, be sure to eliminate any pairs of observations that contain missing data before ranking them.  The procedure for calculating Spearman’s Rho by hand is given below.

	Spearman’s Rho XE "Spearman’s rho" 
a) Given observations 
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d) Then 
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d) SPSS can also compute Spearman’s Rho directly.  Look at the Correlate > Bivariate dialog box shown below.
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You will see that there is a check box for Spearman’s Rho in the Correlation Coefficients area.  Select Speed and Range, check Spearman, and compute the correlations.  How does the value returned compare with what you obtained in part (c)?
Spearman’s Rho is a statistic.  It begs the question as to whether there is a population parameter to which it corresponds?  Researchers refer to the property in the population that 
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measures as 
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.  It must be pointed out that, although Spearman’s Rho is a measure of the strength of relationship between two quantitatve variables, it is difficult to interpret exactly what type of relationship is being assessed.  For this reason many prefer to refer to
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without going into any detail about exactly what that quantity represents.  What this means is that Spearman’s Rho should not be viewed as a rank-based alternative to the ordinary correlation coefficient, r.  
The procedures for testing hypotheses regarding 
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has an approximate t distribution with n-2 degrees of freedom.  This means that we can use a t distribution to test 
[image: image746.wmf]0

:0

S

H

r

=

.  We summarize it below.

	Testing the Correlation XE "Rank correlation, testing" 
When testing
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If t is the computed value for T, the p-value is computed by
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	Technical requirements:

a) Random sample


	Activity 15-3:  Testing 
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a) How many degrees of freedom are associated with the aircraft data?

b) Compute the value of t based on the value of Spearman’s rho from Activity 15-2.  Record it below.

c) Calculate the p-value for testing 
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d) What do you conclude?

For making inferences for other values of 
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we can make use of the fact that, for sample sizes greater than 10, 
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has a distribution which is approximately normal with a mean of 
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and a standard deviation of 
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.  This can be used to construct confidence intervals and test hypotheses.  We outline the confidence interval procedure below.

	Confidence Intervals for XE "Spearman's rho, confidence interval"  
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A confidence interval for 
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where z* is the critical value from the normal tables for the desired confidence level.

Technical Requirements:

a) Random sample.

b) 
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	Activity 15-4:  A Confidence Interval for 
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a) Use the procedure outlined above to construct a 95% confidence interval for 
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 for the relationship between aircraft speed and range.

The procedure for testing hypotheses regarding other values of 
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makes use of the normal distribution of 
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in a manner that we have seen many times before.  We summarize the procedure below.

	Testing XE "Spearman's rho, testing" 
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The test statistic is 
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The p-value is computed by the following.
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	Technical requirements:

a) Random Sample.

b) n > 10.


	Activity 15-5:  Testing 
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a) Let 
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.  Use this value to calculate z.  Record your value below.

b) Use your value for z to calculate the p-value for testing 
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c) What do you conclude?

SPSS does not construct confidence intervals for 
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.  These must be done by hand.  It does, however compute and return the p-value for testing 
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.  It is the quantity labeled Sig. (2-tailed) in the output.  If you are conducting a one-sided test where the alternative hypothesis is either 
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	Homework Activities


	Activity 15-6:  Aircraft Speed and Fuel Consumption


Use the data in the SPSS data file AIRCRAFT.SAV XE "AIRCRAFT.SAV" .

a) Draw a scatter plot for aircraft speed, SPEED, and fuel consumption, FUEL.  Describe the relationship between these two variables.

b) Compute the ordinary correlation coefficient for these two variables.

c) Compute Spearman’s rho for these two variables.  

d) Which measure best captures the relationship you observed in part (a)?

	Activity 15-7:  Insurance Premiums


Use the data in the SPSS data file INSURANCE.SAV XE "INSURANCE.SAV" .

a) Draw a scatter plot for age and the premium for male smokers.  Describe the relationship between these two variables.

b) Compute the ordinary correlation coefficient between these two variables.

c) Compute Spearman’s rho for these two variables.

d) Which measure best captures the relation you observed in part (a)?

	Activity 15-8:  Aircraft Speed and Fuel Consumption (cont’d.)


a) How many degrees of freedom are appropriate for testing 
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b) Compute the value of the t statistic for testing 
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c) Compute the p-value for testing 
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d) What do you conclude?  State, in English, what your results imply about the relation between speed and fuel consumption.

e) Test 
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	Activity 15-9:  Agreement Between Examiners 


Two examiners, A and B, were asked to rate 29 candidate on a scale from 0 = poor to 4 = excellent.  The results are stored in the SPSS data file EXAMINERS.SAV XE "EXAMINERS.SAV" .  

a) Calculate the value of Spearman’s rho for the scores of the two examiners.

b) What is the critical value for constructing a 90% confidence interval for 
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c) Construct a 90% confidence interval for 
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.

d) What does this interval tell you about the degree of agreement between these two examiners?

	Activity 15-10:  Agreement Between Examiners (cont’d.)


Refer to the data in Activity 15-9.  

a) Conduct a test of 
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b) What do you conclude?

	Activity 15-11:  Usefulness of Correlation Measures


Consider the following data.

	X
	-2
	-1
	0
	1
	2

	Y
	4
	1
	0
	1
	4


a) Draw a scatter plot for X and Y.  Describe the relationship between the two variables.

b) Compute the ordinary correlation between the two variables.

c) Compute Spearman’s rho between the two variables.

d) Based on the above what do you conclude about using correlation measures alone when assessing the strength of relationship between two variables?

Topic 16

Comparing Several Means XE "One-way ANOVA" 
	OVERVIEW


In previous topics we have seen how to test the equality of means from two independent populations.  The procedures revolved around analyzing the difference between the two sample means.  The greater the difference, the stronger the evidence that the population means differ from each other.  

There are instances when we wish to know if three or more groups have the same mean.  The problem in this case is that there is no way to take the method for two groups and adapt it to handle three groups.  In this and succeeding topics we shall see how this is done.  This begins an investigation of a topic known as Analysis of Variance XE "Variance" .  We have already encountered this term in regression analysis.  Recall that the standard regression analysis output from SPSS included an Analysis of Variance table for testing whether all of the slope coefficients were equal to zero.

	OBJECTIVES


· See how to test the equality of several population means.

· Introduce the topic of Analysis of Variance XE "Variance" .

· Learn about the One Way Analysis of Variance XE "Variance"  model.

· See how SPSS can be used to perform a One Way Analysis of Variance XE "Variance" .

	PRELIMINARIES


a) Do you feel that human beings physical measurements have changed over time?

b) Do you think humans physical measurements have tended to become larger or smaller?

c) Do you think that family size varies with educational level?  If so, how do you think it would differ?

	IN-CLASS ACTIVITIES


One way Analysis of Variance XE "Variance"  is a collection of procedures that are used to determine if there is a difference in the population mean of three or more populations.  The variable whose mean is being analyzed is known as the response variable, and the variable that identifies the population that a case belongs to is called the explanatory variable.  

	Activity 16-1:  Size of Families


a) Open the SPSS data file HOUSEHOLD.SAV XE "NSFH.SAV"  XE "HOUSEHOLD.SAV" .  It is a portion of the much larger NSFH data set.  The variable EDUC identifies the educational level of the respondent.  It will be the explanatory variable in this analysis.  The variable SIZE gives the number of people in the respondent’s household at the time of interview.  It will be the response variable.  Have SPSS draw side-by-side box plots of household size for the three educational categories.  Briefly describe what you see.

b) Do you think the mean household size is the same for all three groups?

c) Have SPSS the sample size, sample mean and sample standard deviation for each of the three groups.  Record the values in the table below.

	Group
	Sample Size
	Sample Mean
	Sample

Standard Deviation

	1


	
	
	

	2


	
	
	

	3


	
	
	


SPSS provides another graphical tool for comparing the means of several groups.  It is, logically enough, called a Means Plot XE "Means Plot" .  Proceed as follows.

· Click on Analyze > General Linear Model > Univariate to open the following dialog box.
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· Select size2 and place it in the Dependent XE "Dependent"  Variable box.

· Select Educ and place it in the Fixed Factor(s) box.

· Click on Plots to open the following dialog box.
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· Select Educ and place it in the Horizontal Axis box and click Add.  
· Click Continue and then OK.  The output window will contain among other items the following plot.

Profile Plots

[image: image792.emf]Some college Some high school Some elementary Education 3 2.8 2.6 Estimated Marginal Means Estimated Marginal Means of Household size


The horizontal axis lists the categories that form the different groups.  Above each category a dot is plotted at the value of the response variable sample mean.  The dots are connected by straight lines to form the means plot.
d) Comment on what you see in the means plot.

The side-by-side box plots and the means plot seem to indicate that the group with the lower educational level tends to have a smaller household size than do the groups with at least some high school education.  The other two groups appear to be approximately equal to each other.  The sample means, however, appear to be relatively close to each other.  We would like to be able to determine if this perceived difference from the plots can be attributed to the populations at large, or if the means are sufficiently close to each other to make the perceived difference attributable to sampling variability.  

The general problem we are considering is the following.  We have k independent groups.  In this particular instance k = 3.  We wish to test the null hypothesis that



[image: image793.wmf]012

:

k

H

mmm

===

L

 

against an alternative hypothesis that
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We are not interested in any particular difference in the population means.  The alternative hypothesis is simply that somehow they are not all the same.  In subsequent topics we shall look at analyzing what this difference looks like. 

In order to conduct this test we need a model for which the means we are testing are parameters.  The model is called the One Way Analysis of Variance XE "Variance"  Model or, more simply, the One Way ANOVA Model.  It is as shown below.

	One Way ANOVA Model XE "One Way ANOVA model" 
The One Way ANOVA Model is
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has a normal distribution with a mean of 0 and a standard deviation of 
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This means that the parameters of the model are
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It may not be clear how the double subscripts are interpreted.  Consider the following hypothetical samples from three groups.

	Group 1
	Group 2
	Group 3

	11
	10
	14

	9
	11
	11

	8
	9
	12

	7
	
	13

	5
	
	


Here k = 3, 
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, the sum of all the sample sizes.  In this example, N = 12.  Now 
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would denote the third observation from group 1.  So, 
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	Activity 16-2:  Quantities in the One Way ANOVA Model


a) In the hypothetical samples, what is the value for 
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X

?

b) What are the appropriate values for i and j for the observation of 7?

c) In Activity 16-1 we have 3 groups.  So k = 3 in the One Way ANOVA Model.  In terms of this model what are the following?
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We shall now address how we go about testing the null hypothesis that all the group means in a One Way ANOVA model are equal.  If all the means were equal then we could combine the samples from all of the groups and compute the sample mean for the combined sample to get an estimate of this common mean value.  Notationally, this would look like the following.  Let
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Then the combined mean, called the grand mean XE "Grand mean" , is
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	Activity 16-3: Computing the One Way ANOVA Test Statistic


a) Have SPSS compute the sample mean of size.  This will be 
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.  Record it below.

The testing procedure measures how each group mean differs from the grand mean.  If the null hypothesis is true, then the individual group means should be roughly equal to the grand mean.  If not, they should not be equal to the grand mean.  Our test statistic will measure this.

b) Using the grand mean from part (a) and the data from the table in Activity 16-1 fill in the following table.

	Group
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	1


	2.62
	2.62-2.89=-.27
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	2


	2.97
	2.97-2.89=.08
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	3


	2.87
	
	

	
	
	Total


	


This quantity is called the Treatment XE "Treatment"  Sum of Squares XE "Treatment sum of squares" , or SST.  The formula for it is
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The treatment sum of squares measures how much the individual group means differ from each other.  The term “treatment” is used for historical reasons.  When Analysis of Variance XE "Variance"  procedures were being developed they were initially applied to agricultural experiments.  One comparison of interest was the effect of different types of fertilizer.  So, soil was “treated” with the different fertilizers and the crop yields were compared to see if they differed.  

Anyway, the treatment sum of squares is analogous to what the difference in sample means did in the two group t test.  Recall that the test statistic there was
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Division by the standard error gave us a measure of how much the sample means differed when compared to the overall variability in the data.  We need to have a similar quantity in the One Way ANOVA case.  Recall from Topic 3 the t test that we could use when the two group standard deviations were equal had a standard error of the following.  We use notation consistent with that topic.
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For One Way ANOVA we shall take the computation under the square root for 
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and extend it to more than two groups.

c) Use the data from the table in Activity 16-1to fill in the following table.

	Group
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	1


	1.847
	3.411
	201(3.411)=685.61

	2


	1.590
	2.528
	998(2.528)=2523.04

	3


	
	
	

	
	
	Total


	


This quantity is called the Error Sum of Squares XE "Error sum of squares" , or SSE.  The formula for it is



[image: image823.wmf](

)

2

1.

ii

SSEns

=-

å


Now, for technical reasons we need to divide these two sums of squares by amount related to the number of groups and the sample size to obtain what are called mean squares.  These divisors are called degrees of freedom.  The divisor for the treatment sum of squares is called the degrees of freedom for treatment, or dfT.  For k groups this quantity is 
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A sum of squares divided by its degrees of freedom is called a mean square.  Thus, the Treatment XE "Treatment"  Mean Square XE "Mean square for treatment" , or MST is
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d) Use the data from part (b) to compute MST.

Similarly, we compute the Error Mean Square XE "Mean square for error" , or MSE by dividing SSE by its degrees of freedom, dfE.  This quantity is
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e) Use the data from part (c) to compute MSE.

Now the test statistic for testing 
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is the ratio of these two mean squares.  It is called F, and it’s formula is
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f) Use the mean squares from part (d) and part (e) to compute F.

In order to compute a p-value for this statistic we need to know the distribution of F.  If each of the groups has a normal distribution with the same standard deviation, then F will have an F distribution XE "F distribution"  with 
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.  The p-value is then calculated by
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g) What are the degrees of freedom for your F statistic?

h) Use these degrees of freedom and your value for f to compute the p-value.

i) What do you conclude?

The usual way to summarize what we have just done is to create an Analysis of Variance XE "Variance"  Table, or, more simply, an ANOVA Table XE "ANOVA table" .  We first need to define the Total Sum of Squares XE "Total sum of squares" , or SSTotal.  The formula is
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The One Way ANOVA table contains the following.  

	Source of

Variation
	df
	Sum of

Squares
	Mean

Square
	F
	p

	Treatment XE "Treatment" 
	k-1
	SST
	MST
	F
	p-value

	Error
	N-k
	SSE
	MSE
	
	

	Total
	N-1
	SSTotal
	
	
	


There a couple of interesting things to note about an ANOVA table.  They are 
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From a computational standpoint you only have to compute two of these quantities using the formulas in order to get all three.  Generally the name of the group identifying variable is used in the table instead of the word “Treatment.”  

	Activity 16-4: Creating an ANOVA Table


Use the information from Activity 16-3 to fill in the ANOVA table given below.

	Source of

Variation
	df
	Sum of

Squares
	Mean

Square
	F
	p

	Education


	
	
	
	
	

	Error


	
	
	
	
	

	Total


	
	
	
	
	


SPSS performs the One Way ANOVA calculations.  You proceed as follows.

· Click on Analyze > Compare Means > One-Way ANOVA.  This will bring up the following dialog box.
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· Enter the response variable in the Dependent XE "Dependent"  List box.

· Enter the explanatory variable in the Factor box.

· Click OK.  The ANOVA table will show up in an output window. 

	Activity 16-5:  Using SPSS 


a) Have SPSS conduct the One Way ANOVA test that the mean household size differs according to educational level.  Your output should look like the following.
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Up to rounding errors the ANOVA table should look like the one you filled in in Activity 16-4.

· Another common way of referring to the treatment sum of squares is to call it the between groups sum of squares.  Similarly, when the treatment sum or squares is referred to in this manner, the error sum of squares is called the within groups sum of squares.  

b) Looking at this output briefly describe what you know about the mean household size between the three educational levels.

	Activity 16-6:  Egyptian Skulls


Open the SPSS data file SKULLS.SAV XE "SKULLS.SAV" .  It contains the maximum breadth of skulls recovered from different Egyptian historical periods.  Use SPSS to create a means plots and construct a One Way ANOVA table to see if the mean skull size is the same for all periods or not.  Briefly comment on your results.

We summarize the procedure we have been discussing.

	Testing the Equality of Several Means XE "One-way ANOVA, testing" 
For testing the equality of means for k independent groups, let
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Then, for testing 
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the test statistic is
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and the p-value is
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Technical requirements:

a) Random samples.

b) Error terms have a normal distribution with a mean of 0 and a standard deviation of 
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.


	Homework Activities


	Activity 16-7:  Getting Used to the Notation


A number of experimental situations are described below.  In each instance give the values for k, N, and each 
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.  What is the response variable in each case?  

a) In order to compare the effectiveness of different approaches to advertising a candidate’s position on a particular issue in a political campaign, three different advertisements are taped.  Sixty randomly selected potential voters were randomly assigned in groups of twenty each.  Each group is shown one of the tapes and the ad was rated on a scale from 1 to 10.  The higher the number, more effective the viewer felt the ad was.

b) To compare the effectiveness of three different approaches to teaching speed reading, 10 people are randomly assigned to each of the three methods.  The increase in reading speed, in words per minute, is measured on each participant.

c) In order to see if there is a difference in income for people with different levels of education, the income levels of fifty randomly selected individuals from each of three different levels of education are obtained.

	Activity 16-8:  Number of Students in College


The following data summarize the findings of a study of the number of students in college in Australia according to various age groups.

	Age
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	16
	53.4
	7.77

	20-24
	16
	54.8
	7.33

	25-29
	16
	26.2
	4.62

	>29
	16
	50.0
	5.05


a) Draw, by hand, a means plot.

b) The grand mean is 46.1.  Use this value to compute the Sum of Squares for Treatment XE "Treatment" , SST.

c) How many degrees of freedom are associated with this sum of squares?

d) Calculate the Mean Square for Treatment XE "Treatment" , MST.

e) Calculate the sum of Sum of Squares for Error, SSE.

f) How many degrees of freedom are associated with this sum of squares?

g) Calculate the Mean Square for Error, MSE.

h) Calculate the F ratio.

i) Calculate the p-value for your F ratio.

j) Summarize your results in an ANOVA table.

k) What does the test lead your to conclude?

	Activity 16-9:  Education and Income


The experiment described in part (c) of Activity 16-7 was conducted and the data have been stored in the SPSS data file ED_G_INCOME.SAV XE "ED_G_INCOME.SAV" .  

a) Conduct a one way Analysis of Variance XE "Variance"  for these data, and report the results in an ANOVA table.  

b) What do you conclude from this analysis?

	Activity 16-10:  Silver Content in Coins


The SPSS data file COINS.SAV XE "COINS.SAV"  contains the silver content, in percent, from four different Byzantine coinages in the reign of King Manuel I, Comnenus.  The issue is whether the mean silver content differed between the coinages.

a) What are k, N, and each 
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 and the response variable for this experiment?

b) What are the null and alternative hypotheses for this problem?

c) Construct an ANOVA table for testing your hypotheses.

d) Have SPSS draw a means plot for these data.

e) Summarize your conclusions.

	Activity 16-11:  Butterfat Content of Milk


Does the milk from different breeds of dairy cattle differ in butterfat content?  The data in the SPSS data file BUTTERFAT.SAV XE "BUTTERFAT.SAV"  gives the percent butterfat content for 20 randomly selected cows of 5 different breeds of dairy cattle.

a) Have SPSS create a means plot.

b) What are k, N, and each 
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 and the response variable for this experiment?

c) What are the null and alternative hypotheses for this problem?

d) Complete an ANOVA table for testing your hypotheses.

e) What do you conclude?

	Activity 16-12:  Popes and Monarchs (cont’d.)


The SPSS data file PRES_POPE_MONARCH.SAV XE "PRES_POPE_MONARCH.SAV"  contains the lifetimes of a sample of U.S. Presidents, Roman Catholic Popes, and British monarchs.  The question is whether there is a difference in the mean lifetimes for these three groups of rulers.  Have SPSS draw a means plot and conduct a one way analysis of variance.  Summarize your conclusions.

Topic 17

Comparing Several Means—Contrasts XE "One-way ANOVA, contrasts" 
	OVERVIEW


In the last topic we learned how to test the null hypothesis that the means of several independent groups are equal against the alternative hypothesis that they somehow differ.  If you conclude that the means differ, a natural follow-up question is that of how they differ.  We shall look at two commonly used approaches to this question.  Contrast XE "Contrast"  analysis lets us test whether the difference follows a specific pattern.  Multiple comparisons XE "Multiple comparisons"  is a method for constructing many joint confidence intervals for the differences between pairs of means.  They both have their unique uses.  We will look at contrasts in this topic and take up multiple comparisons in the next topic.

	OBJECTIVES


· Learn what a contrast is.

· Learn how to test whether a certain contrast is true.

· Learn how SPSS does contrast analysis.

	PRELIMINARIES


a) What pattern do you see when you look at the comparison between the mean household size for the different races?

b) What pattern do you see when you compare the mean skull breadth for the various Egyptian dynasties?

	IN-CLASS ACTIVITIES


	Activity 17-1:  Differences in Mean Household Size  


a) Open the SPSS data file HOUSEHOLD.SAV XE "HOUSEHOLD.SAV" .  Draw a means plot of household size versus race.  Look at your responses to the preliminaries.  How do you feel that the means for the three groups differed from each other?

The pattern seems to imply that the mean household size is about the same for the White and Black groups and that they are smaller than the mean household size for the other race group.  We would like to be able to test this apparent difference to see if it can be attributed to the parent populations.  

A powerful tool for this problem is that of contrasts.  A contrast multiplies each of the population means by a separate constant.  The constants have the property that they must sum to zero.  The population means are multiplied by their respective constants and are then added together to form the contrast.  Although it is not necessary, it is common practice to keep the multipliers between +1 and –1.  Thus, 
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would be a contrast, while
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would not.  Formally stated, we make the following definition.

	Contrast XE "Contrast" 
A contrast of population means is anything of the form
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It is useful to note that some of the multipliers can be zero.

	Activity 17-2:  Identifying Contrasts


Which of the following are contrasts?

a) 
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b) 
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c) 
[image: image855.wmf]1234

1111

.

2222

mmmm

--+


d) 
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Now that we know what a valid contrast looks like, the next question is how to use one to test a particular pattern in the group means.  We shall look at the contrasts from Activity 17-2.   

· 
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 is a contrast that you could use to test if 
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· 
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is a contrast for testing that 
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In other words, if you wish to test whether one group of means differs from another group of means, give the members of one group the same positive multiplier and give the members of the other group the same negative multiplier.  Just make sure that the multipliers sum to zero.

	Activity 17-3:  Developing Contrasts


Suppose you have four groups, with their respective means, 
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.  Write a valid contrast that will make the following comparisons.  Give the values of 
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a) 
[image: image868.wmf]1

m

 and 
[image: image869.wmf]4

m

 differ.

b) 
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If a given difference in the population means is true, then the contrast for that difference will have a non-zero value.  Thus, we can test whether a pattern exists by testing the null hypothesis of
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 For each population contrast there is a corresponding sample contrast.  You simply replace each population mean with its sample mean.  For example, the contrast
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would have the corresponding sample contrast of 
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The sample contrast can be used to test whether its corresponding population contrast equals zero.  It also turns out that the standard error for C is given by
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where MSE is the error mean square from your ANOVA table.  Now, if the assumptions that the error terms in the ANOVA model have normal distributions with the same standard deviation are met, then
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will have a t distribution with N-k degrees of freedom.  This gives us the basis for developing a test.  We give the procedure below.

	Testing XE "Contrasts, testing" 
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	The test statistic is:

p-values are computed by:
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	Technical requirements:

a) Random samples

b) Each group has a normal distribution with a standard deviation of 
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	Activity 17-4:  Mean Household Size (cont’d.)


a) Write a population contrast that corresponds to the pattern that the mean household sizes for the White and Black groups are the same, but they differ from the other race group.

b) Compute the value of the sample contrast that corresponds to the population contrast in part (a).

c) Compute the value of 
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d) Compute the value of t.

e) How many degrees of freedom are associated with your t statistic?

f) What is the appropriate alternative hypothesis for testing if the White and Black groups have a mean household size that is less than the other race group?

g) Compute the p-value for your test.

h) What do you conclude?

We can also construct confidence intervals for population contrasts.  We summarize the procedure below.

	Confidence Intervals for XE "Contrasts, confidence interval"  
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Then a confidence interval for the corresponding population contrast
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is given by
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where t* is the critical value from the t table for the desired confidence level using 
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Technical requirements:

a) Random samples

b) Each group has a normal distribution with a standard deviation of 
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i) What is the critical value for constructing a 90% confidence interval for 
[image: image896.wmf]y

?

j) Use the above formula to construct a 90% confidence interval for 
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SPSS can do contrast analysis.  It will test 


[image: image898.wmf]0

:0 vs. :0.

a

HH

yy

=¹

  

If you want to construct a confidence interval, you must do it by hand.  To conduct the test proceed as follows.

· In the Analyze > Compare Means > One-way ANOVA dialog box click Contrasts to bring up the following dialog box.
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· For each value of the explanatory variable enter the value of the multiplying coefficient in the Coefficients box and click Add.  Enter the coefficients in ascending order of the value of the explanatory variable.  You need a coefficient for every value of the explanatory variable.  The coefficients shown above form the contrast 
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· Click Continue and then run the analysis of variance.  SPSS gives the results for both the situation that the error terms have the same standard deviation and when they do not.  The former is in the row of output labeled Assume equal variances.  The latter is in the row of output labeled Does not assume equal variances.  
If you want to run the test against a one sided alternative use the reported two sided p-value (Sig.) as follows.
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	If 
[image: image902.wmf]0

t

³

, then p-value = 1 – Sig./2.

If t < 0, then p-value = Sig./2.
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k) Have SPSS conduct the sided test of the contrast you wrote in part (a).   Write the value of t and the p-value for the one sided test in the space below.

Contrasts are useful for determining of two groups of means differ from each other.  However, in those cases where the patterns are something else, contrasts cannot be used.  For example, suppose we felt that the means of three groups are all different.  That is, the pattern appears to be 
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.  There is no single contrast that captures this kind of pattern.

	Homework Activities


	Activity 17-5:  Contrasts


Which of the following are contrasts?

a) 
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	Activity 17-6:  Creating Contrasts


Suppose you have five groups, with their respective means, 
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	Activity 17-7:  Number of Students in College (cont’d.)


Refer to the summary data given in Activity 16-8.

	Age
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	16
	53.4
	7.77

	20-24
	16
	54.8
	7.33

	25-29
	16
	26.2
	4.62

	>29
	16
	50.0
	5.05


MSE = 40.237
a) Write a contrast that measures whether the mean number of students in college is the same for the students in the less than 20, 20-24 and over 29 age groups are the same, but that common mean differs from that of the 25-29 age group.

b) In terms of your contrast, what null and alternative hypotheses are appropriate for testing that the common mean for the under 20, 20-24 and over 29 age groups is greater than that for the 25-29 age group?

c) What is the value of the sample contrast?

d) What is the standard error for the sample contrast?

e) What is the value of the t statistic for testing the hypotheses you gave in part (b)?  How many degrees of freedom are associated with your t statistic?

f) Compute the p-value for the test you gave in part (b).

g) What do you conclude?

	Activity 17-8:  Silver Content in Coins (cont’d.)


Use the SPSS data file COINS.SAV XE "COINS.SAV"  to calculate the answers for parts (c) through (f).

a) Write a contrast that measures whether the silver content of the third and fourth coinages are equal but differ from that of the first coinage.

b) In terms of your contrast, what null and alternative hypotheses are appropriate for testing that the silver content of the third and fourth coinages was less than that of the first coinage?

c) What is the value of the sample contrast?

d) What is the standard error for the sample contrast?

e) What is the value of the t statistic for testing the hypotheses you gave in part (b)?  How many degrees of freedom are associated with your t statistic?

f) Compute the p-value for the test you gave in part (b).

g) What do you conclude?

h) Does what you have done test the notion that the silver content decreased in later coinages compared to that of earlier ones?

	Activity 17-9:  Egyptian Skulls


Refer to you SPSS results from Activity 16-6.

a) Write a contrast for testing that the mean breadth for the 3300 BC skulls is different than that for the 4000 BC skulls.

b) Construct a 95% confidence interval for the contrast in part (a).

c) Write a contrast for testing that the mean breadth for the 3300 BC skulls is different than that for the 1850 BC skulls.

d) Construct a 95% confidence interval for the contrast in part (c).

e) Write a contrast for testing that the mean breadth for the 4000 BC skulls is different than that for the 1850 BC skulls.

f) Construct a 95% confidence interval for the contrast in part (e).

g) How do you explain what you see when you compare your three confidence intervals?

	Activity 17-10:  Popes and Monarchs (cont’d.)


For the data in the file PRES_POPE_MONARCH.SAV XE "PRES_POPE_MONARCH.SAV"  we have the following results.

	Group
	
[image: image920.wmf]X


	n

	Presidents
	13.5
	20

	Popes
	13.47
	30

	Monarchs
	22.71
	14


MSE = 141.464

a) Write a contrast to test that the mean lifetime of Presidents and Popes are the same, but less than that for British monarchs.

b) What are the null and alternative hypotheses for testing the statement in part (a)?

c) Conduct the test using hand calculations.

d) Construct a 90% confidence interval for your contrast.
Topic 18

Comparison of Several Means—Multiple Comparisons XE "Multiple comparisons" 
	OVERVIEW


In the last topic we saw how to use contrasts to test whether the group means differed according to a given pattern.  We also saw that it is not possible to devise a contrast that will capture all possible differences in group means.  In such situations the technique of multiple comparisons can be helpful.  In this topic we shall see the ideas behind multiple comparisons and see how they are interpreted.  In addition, we shall address the question of testing the model technical requirements.

	OBJECTIVES


· Learn the ideas that underlie multiple comparisons.

· Learn how SPSS does multiple comparisons.

· See how to assess the validity of the technical requirements in the One Way ANOVA model.

	PRELIMINARIES


a) How would you describe the differences in means skull breadth for the Egyptian skulls data?

b) Can you devise a contrast that captures the pattern of these differences?

	IN-CLASS ACTIVITIES


	Activity 18-1:  Size of Families (cont’d.)  


Open the SPSS data file HOUSEHOLD.SAV XE "HOUSEHOLD.SAV" .  Draw a means plot and conduct a one way ANOVA for mean household size for the different races.  We have seen that the mean household size varies according to the race of the respondent.  Briefly describe the form this difference takes.

The pattern seems to be that the mean household size for White respondents and Black respondents are about the same, but both are lower than for respondents from other races.  Even though a contrast can be used to test this pattern we will look at an alternative procedure.  

The procedure known as multiple comparisons does not attempt to verify the existence of a given pattern.  It takes all possible pairs of group means and computes a confidence interval for the difference between each pair of means.  It does this in a manner so that we can apply a given confidence interval to all of the confidence intervals simultaneously.  You might ask what the big deal is about that.  If you have two 95% confidence intervals can’t you say with 95% confidence that both contain the true parameter value?  For theoretical reasons, based on the fact that the same data are being used to construct both confidence intervals, this turns out not to be the case.  In fact, in order to state with 95% confidence that two confidence intervals jointly contain their true parameter values, each individual interval needs to have a confidence level greater than 95%.
A large number of multiple comparison procedures have been proposed.  In this topic we shall look at one called Bonferroni XE "Bonferroni intervals"  Simultaneous Confidence Intervals.  For all possible pairs of group means, 
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The difference is that the standard error of uses the error mean square from the ANOVA results rather than just the pooled standard deviation for the two samples, and the value of t** is chosen such that the combined confidence level of all such intervals is a predetermined value.  So,
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MSE is the mean square error from the ANOVA table.  The critical value, t** depends on the overall confidence level, the sample sizes, and the number of groups.  t** has N – k degrees of freedom.  For an overall confidence level of C*% each individual confidence interval must have a confidence level of 
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SPSS computes the Bonferroni XE "Bonferroni intervals"  simultaneous confidence intervals.  They are available in the One Way ANOVA dialog box.  

· In the Analyze > Compare Means > One-Way ANOVA dialog box set up the one way ANOVA test in the manner described in Topic 16 and click POST HOC to bring up the following dialog box.
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· In the Equal Variances Assumed area check Bonferroni XE "Bonferroni intervals" .
· For an overall confidence level of C% enter 1 – C/100 in the Significance XE "Significance"  level box.  The dialog box shown is requesting an overall confidence level of 95%.

· Click Continue followed by OK.  The Bonferroni XE "Bonferroni intervals"  intervals will appear in an output window following the ANOVA table.

	Activity 18-2:  Computing the Bonferroni XE "Bonferroni intervals"  Simultaneous Confidence Intervals


a) Run the One Way ANOVA asking for the Bonferroni XE "Bonferroni intervals"  simultaneous confidence intervals with an overall confidence level of 95%.  The output for the comparisons should look like the following.

Post Hoc Tests
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Since there are three groups in these data, there will be three pairs of means.  The output shows that the overall confidence level is 95%.  Next for each group the difference between the sample means and the standard error of that difference are shown.  In the Sig column the p-value for a test of 
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 is shown.  The final two columns give the confidence interval for 
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.  For example, we see that the confidence interval comparing White respondents with Black respondents is
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The fact that the interval contains zero indicates that the mean household sizes for these two groups do not differ significantly from one another. 

b) Look at the Bonferroni XE "Bonferroni intervals"  results.  Write a brief summary of what pattern they show.  Are these results consistent with your contrast analysis from Topic 17?

	Activity 18-3:  The Egyptian Skulls (cont’d.) 


a) Open the SPSS data file SKULLS.SAV XE "SKULLS.SAV" .  Draw a means plot and conduct a one way ANOVA.  We have seen that the mean skull breadth varies with the dynasty.  Briefly describe the form this difference takes.

b) Have SPSS construct a set of Bonferroni XE "Bonferroni intervals"  intervals at an overall confidence level of 95%.  Write a brief summary of what pattern they show.

The pattern seems to be that the more recent skulls have greater mean breadths than do their predecessors.  This kind of a pattern means that there is no way to write a contrast that captures the notion that
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.  In fact, if we look at adjacent dynasties, the degree to which the individual confidence intervals overlap indicates that we cannot conclude statistically that the mean skull breadth in one dynasty differs from its predecessor or its successor.  It is interesting to note the intervals imply that the mean skull breadth for the 150 AD dynasty does not differ from the 200 BC dynasty, the means skull breadth for the 200 BC dynasty does not differ from the 1850 BC dynasty, but the mean skull breadth from the 150 AD dynasty does differ from the 1850 BC dynasty.  So, A = B and B = C does not necessarily imply that A = C in this setting.

In Topic 16 we gave the technical requirements for the One Way ANOVA model.  They were that the error terms had a normal distribution with a mean of zero and a standard deviation of 
[image: image932.wmf]s

.  The validity of the tests and confidence intervals that we have been discussing are dependent on these assumptions being true.  


In  Analyze > General Linear Model > Univariate SPSS can store the residuals.  These can be used to draw Q-Q plots for each group.  Proceed as follows.

· In Analyze > General Linear Model > Univariate enter the response variable in the Dependent XE "Dependent"  Variable box and the explanatory variable in the Fixed Factor(s) box.  

· Click Save to bring up the following dialog box.
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· Check Unstandardized in the Residuals area.

· Click Continue and then click OK.  The residuals will be stored in a new variable RES_1 in the data view.

· Split the file according to the explanatory variable and then draw a Q-Q plot of the residuals.  You will get a separate Q-Q plot for each group.

· Unsplit the file.

There are formal tests of the hypothesis that all of the error terms have the same standard deviation.  They are often called tests of homogeneity XE "Tests of homogeneity" .  The null hypothesis is
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with an alternative hypothesis of
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We shall not go into the details of how these tests are done by hand.  SPSS conducts one such test, Levene’s Test XE "Levene’s Test" .  Levene’s test is valid for any measurement variable regardless of the distribution.  You run this test from Analyze > General Linear Model > Univariate as follows.

· In Analyze > Compare Means > One-way ANOVA set up the analysis of variance as explained in the instructions for analyzing the residuals.  Click Options to bring up the following dialog box.  
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· Check Homogeneity of Variance XE "Variance"  test in the Statistics area.

· Click Continue followed by OK.  The test results will appear in an output window.

	Activity 18-4:  Testing Model Assumptions


a) Open the SPSS data file SKULLS.SAV XE "SKULLS.SAV" .  Have SPSS store the residuals and then draw a Q-Q plot for each group.  What do you conclude?

b) Run the tests for equal variances on the data.  The results in the output window should look like the following.  Interpret the results.
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The output contains the following results.

· The value of the F statistic.

· The degrees of freedom for the numerator (df1)and for the denominator (df2) . 

· The p-value for the test.  A non –significant result is evidence that the standard deviations are equal.

	Activity 18-5:  Household Sizes (cont’d.)


Use the methods we have been discussing to assess the validity of the model assumptions for the data in HOUSEHOLD.SAV XE "HOUSEHOLD.SAV" .  Write your conclusions below.  

	Homework Activities


	Activity 18-6:  Butterfat Content of Milk (cont’d.)


Refer to the data in the SPSS data file BUTTERFAT.SAV XE "BUTTERFAT.SAV" .  

a) Have SPSS compute Bonferroni XE "Bonferroni intervals"  simultaneous confidence intervals using breed of cattle as the factor.  Use an overall 95% confidence level.

b) Describe the pattern of differences that the results of part (a) show.

c) Could this pattern have been tested using a contrast?

	Activity 18-7:  Silver Content of Coins (cont’d.)


Refer to the data in the SPSS data file COINS.SAV XE "COINS.SAV" .

a) Have SPSS compute Bonferroni XE "Bonferroni intervals"  simultaneous confidence intervals for the four coinages.  Use an overall 90% confidence level.

b) Describe the pattern of differences that the comparisons show.

	Activity 18-8:  Number of College Students


Refer to the data in the SPSS data file AUS_STUDENT.SAV XE "AUS_STUDENT.SAV" .

a) Have SPSS compute Bonferroni XE "Bonferroni intervals"  simultaneous confidence intervals for the four age groups.  Use an overall 99% confidence level.

b) Describe the pattern of differences that the comparisons indicate.

c) Does this pattern coincide with the results of Activity 17-7?

	Activity 18-9:  Butterfat Content of Milk (cont’d.)


a) Use the methods described in this topic to assess whether the one way ANOVA model’s assumptions are satisfied for the butterfat data.

b) What does this imply about the results of Activity 18-6?

	Activity 18-10:  Silver Content of Coins (cont’d.)


a) Use the methods described in this topic to assess whether the one way ANOVA model’s assumptions are satisfied for the silver content of Byzantine coins data.

b) What does this imply about the results of Activity 18-7?

	Activity 18-11:  Number of College Students (cont’d.)


a) Use the methods described in this topic to assess whether the one way ANOVA model’s assumptions are satisfied for the number of students in college in Australia data.

b) What does this imply about the results of Activity 18-8?

Topic 19

Comparing Several Medians XE "Kruskal-Wallis test" 
	OVERVIEW


For the last three topics we have seen how to compare several means using One Way Analysis of Variance XE "Variance" , contrasts, and multiple comparisons.  All of these procedures depend on the groups having normal distributions with the same standard deviation.  When these conditions are not met we can still compare the medians of the groups using ranks.  In this topic we shall look at the Kruskal-Wallis Test.  It is a popular non-parametric alternative to the ANOVA F test.

	OBJECTIVES


· Learn how to conduct the Kruskal-Wallis Test.

· See how SPSS runs the Kruskal-Wallis Test.

	PRELIMINARIES


a) Do you think the number of students in higher education varies according to age?

b) What would you expect the pattern to be?

	IN-CLASS ACTIVITIES


	Activity 19-1:  Australian Student Population


a) Open the SPSS data file AUS_STUDENT.SAV XE "AUS_STUDENT.SAV" .  It contains data on the number of students in higher education in Australia during the 1980’s.  They are grouped according to age and gender.  Use the techniques discussed in Topic 18 to determine if the assumptions regarding the error terms in the One Way ANOVA model are met for the number of male students.  What do you conclude?

Both the normal distribution of the error terms and the equality of standard deviations appear to be questionable in this case.  Thus, the results given by a One Way ANOVA may not be reliable.  In such cases, a rank based procedure is recommended.  This means that, rather than testing the equality of the group means, we shall be testing the equality of the group medians.  The null hypothesis is
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The alternative hypothesis is
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The test we will be conducting is known as the Kruskal-Wallis test.  It is based on the same idea as the One Way ANOVA F test.  Recall that the F test compared the individual group means to the grand mean.  The Kruskal-Wallis test compares the average rank for each group with the grand average of the combined observations.  We shall walk you through the computation.  The formula for the Kruskal-Wallis test is
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where 
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	Activity 19-2:  Computing the Kruskal-Wallis Test Statistic


a) Have SPSS assign ranks to the number of male students.  Remember that SPSS will stores these in a new variable called RSTUDENT.  Use SPSS to determine the total sample size.

b) Split the file according to age group.  Have SPSS compute the mean rank and sample size of each age group  

c) Calculate N.  Record its value in the space below.

d) Fill in the missing entries in the following table

	Age Group
	n
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 EMBED Equation.DSMT4  [image: image945.wmf]

	< 20
	8


	17.19
	.69
	3.81

	20-24
	8


	28.06
	11.56
	1069.07

	25-29
	
	
	
	

	>29
	8


	16.25
	-.25
	.5

	
	
	
	Total


	


e) Multiply the total by 
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.  Write the result in the space below.

The result in part (d) is the value of the Kruskal-Wallis test statistic, H.  The value of H will grow as the average group ranks deviate from the combined mean rank.  This means that “large” values of H give evidence against the null hypothesis that all of the group medians are equal.  

The next question to be answered is how do we compute p-values for this test?  It turns out that, if the individual group sample sizes are at least 5, H will have an approximate chi-square distribution XE "chi-square distribution"  with d.f. = k-1.  Then the p-value is computed as follows.  Let h be the computed value of H.
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where H has a chi-square distribution with d.f. = k-1.

	Activity 19-3:  Computing the p-value for the Kruskal-Wallis Test


a) What are the individual group sample sizes for the male student data?  

b) How many degrees of freedom are there?

c) Use the formula given above and Table III to compute the p-value for your test.  Record the value below.

d) What do you conclude?

We summarize the Kruskal-Wallis Test below.

	Kruskal Wallis Test XE "Kruskal Wallis test"  XE "Kruskal Wallis Test" 
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Test statistic:
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H has an approximate chi-square distribution with d.f. = k-1.

p-value:
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Technical requirements:

a) Random Samples

b) All 
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SPSS conducts the Kruskal-Wallis Test.  You proceed as follows.

· Select Analyze > Nonparametric Tests > k Independent XE "Independent"  Samples to open the following dialog box.  
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· Enter the response variable in the Test Variable List box and the explanatory variable in the Grouping Variable box.

· Make sure Kruskal-Wallis H is checked in the Test Type area.

· Click on Define Range to bring up the following dialog box.
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· Enter the smallest value of your explanatory variable in the Minimum box and the largest value of your explanatory variable in the Maximum box.

· Click Continue followed by OK to conduct the test.  The results will appear in an output window.

	Activity 19-4:  Using SPSS to Perform the Kruskal-Wallis Test


Have SPSS test the equality of the median number of male students in the data file AUS_STUDENT.SAV XE "AUS_STUDENT.SAV" .  You should see something like the following.

Kruskal-Wallis Test
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The results contain the following.

· The individual group sample sizes and total sample size.

· The average rank for each group.

· The value of the Kruskal-Wallis statistic, degrees of freedom and p-value.

The value of the Kruskal-Wallis statistic should agree to within rounding with the value you computed in Activity 19-3.

	Activity 19-5:  Female Students in Higher Education


Have SPSS test the equality of the median number of female students in the data file AUS_STUDENT.SAV XE "AUS_STUDENT.SAV" .   You do this by selecting those cases that are female and then run the Kruskal-Wallis test.  Record the value of the Kruskal-Wallis test statistic and the p-value.  What do you conclude?

	Homework Activities


	Activity 19-6:  Silver Content of Coins (cont’d.)


The data in the SPSS data file COINS.SAV XE "COINS.SAV"  show that there is weak evidence that the standard deviations of the four coinages are not equal.  So, it might be prudent to check the results using the Kruskal-Wallis test.  We shall do it by hand.  The four samples have been combined and sorted, keeping track of the coinage to which each belonged.  The results of this are given in the table below.

	% Silver
	4.5
	4.6
	4.9
	5.1
	5.3
	5.5
	5.5
	5.6
	5.8

	Coinage
	3
	3
	3
	4
	4
	3
	4
	4
	4

	Rank
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	

	% Silver
	5.8
	5.9
	6.2
	6.2
	6.4
	6.6
	6.6
	6.8
	6.9

	Coinage
	4
	1
	1
	4
	1
	1
	2
	1
	1

	Rank
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	

	% Silver
	6.9
	7.0
	7.2
	7.7
	8.1
	8.6
	9.0
	9.2
	9.3

	Coinage
	2
	1
	1
	1
	2
	2
	2
	2
	2

	Rank
	
	
	
	
	
	
	
	
	


a) What is the value of N for these data?

b) Assign ranks to the sorted observations.

c) Compute the values of 
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d) Compute the value of the Kruskal-Wallis statistic.

e) Even though the sample from coinage 3 is only 4, go ahead and compute the p-value for the test.

f) What do you conclude?

	Activity 19-7:  Butterfat Content of Milk (cont’d.)


The data in the SPSS data file BUTTERFAT.SAV XE "BUTTERFAT.SAV"  show that there is strong evidence that the individual group standard deviations are not equal.  Twenty cattle were sampled from each of the five breeds.  After combining and ranking the data the following average ranks were obtained.
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a) What is the value of N for these data?

b) Compute the value of the Kruskal-Wallis statistic.

c) Compute the p-value for the test.

d) What do you conclude?

	Activity 19-8:  Education and Income


Use the data in the SPSS data file NSFH.SAV XE "NSFH.SAV" .  The appropriate variables are education, COMPLED, and income, IREARN.  The response variable is income.

a) Do the data indicate that the one way ANOVA model technical requirements are satisfied?  Explain your reasoning.

b) Conduct the Kruskal-Wallis Test.  Report the value of the test statistic and the p-value.

c) What do you conclude?

d) If you conclude the medians differ, what can you say about the pattern of those differences?

	Activity 19-9:  Survival of Cancer Patients


Use the data in the SPSS data file CANCER.SAV XE "CANCER.SAV" .  Each column gives the survival time, in days, of patients with various types of cancer after completion of a treatment regimen.

a) Do the data indicate that the one way ANOVA model technical requirements are satisfied?  Explain your reasoning.

b) Although we could use the Wilcoxon rank sum test XE "Wilcoxon rank sum test"  go ahead and conduct the Kruskal-Wallis Test.  Report the value of the test statistic and the p-value.

c) What do you conclude?

d) If you conclude the medians differ, what do you think the pattern of differences looks like?  Does the treatment appear to be more effective for certain types of cancer?

	Activity 19-10:  Heights of Singers


Use the data in the SPSS data file CHORAL.SAV XE "CHORAL.SAV"  give the heights of singers in different voice ranges for the New York Choral Society.  There were 21 Tenor 1 singers, 21 Tenor 2 singers, 39 Bass 1 singers and 26 Bass 2 singers.  After combining and ranking the data the following average ranks were obtained.
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a) What is the value of N for these data?

b) Compute the value of the Kruskal-Wallis statistic.

c) Compute the p-value for the test.

d) What do you conclude?

Topic 20

Comparing Several Means—Repeated Measures XE "Repeated measures" 
	OVERVIEW


Until now we have been considering experiments where random samples are drawn from k independent groups.  These data are used to conduct the One Way ANOVA F test.  As you might suspect not every experimental situation for comparing group means will look like this.  Consider a situation in which you wish to compare four different brands of golf balls for driving distance.  Five golfers have been selected to test the balls.  Because the variability among golfers is fairly large you have each golfer hit each of the different balls.  This type of design is called a repeated measures design.  Each golfer has a measurement taken at each treatment level (the different balls).  The order in which each golfer hits the different balls should be selected at random.  Randomization is to be preferred, but there are situations where this is not possible.  For example, it may be the case that trainees are measured before, during and after a training program.  Thus, randomization is impossible.

	OBJECTIVES


· Introduce the repeated measures design.
· Learn how to test the equality of means in a repeated measures design.

· See how to use SPSS to analyze a repeated measures design.

	PRELIMINARIES


a) How might you assess the success or failure of a treatment for anorexia?

b) The overview gives an example of a repeated measures experiment.  Can you think of another experimental situation where you might use repeated measures?

	IN-CLASS ACTIVITIES


	Activity 20-1:  Body Mass Index in Anorexic Patients


a) Open the SPSS data file BODYMASS.SAV XE "BODYMASS.SAV" .  The file contains data on the body mass index 20 patients suffering from anorexia.  The body mass index is computed by dividing the weight, in kilograms, of a person by the square of the person’s height, in meters.  For each patient Admit contains the body mass index when the patient began treatment.  Disch contains the body mass index when the patient was discharged from the treatment program.  Pref contains the body mass index based on the patient’s stated preferred weight at the time of admission.

b) Briefly explain why we cannot use One Way Analysis of Variance XE "Variance"  to test if 
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Clearly, we do not have three independent random samples in these data.  The data can, however, be viewed in the following manner.  We have 20 different patients.  Each patient gives us one observation in each of the three body mass index groups.  Therefore, we can view this as being a repeated measures experiment.  

In general, a repeated measures experiment XE "Repeated measures"  compares the means of k different treatment levels (in our example, body mass index at admission, at discharge and preferred) by using b different experimental units (in our example, patients).  Each experimental unit is observed exactly once for each treatment level.  From an experimental standpoint, the advantage of such a design over a One Way Analysis of Variance XE "Variance"  experiment is that we are comparing the treatment levels by using the same experimental units.  This means that any real difference in the treatment levels will not be confounded with the differences in the experimental units.  Recall that confounding was a situation where the variability in experimental units masks the variability in measurements.  Thus, such an experiment accomplishes for k groups what paired comparisons did for two groups.

In order to conduct a test of 
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we define the following model.

	Model for Repeated Measures XE "Model for repeated measures" 
The model for repeated measures is
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· Each experimental unit is an observation from a population of experimental units having a normal distribution with a mean of 0 and a standard deviation of 
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· Each error term has a normal distribution with a mean of 0 and a standard deviation of 
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What this model states is that each observed value of the response consists of the overall mean response, to which is added a contribution for being in a given treatment level and another random contribution for being a given experimental unit.  These are then additionally randomly scattered using the error term.  The experimental unit term and the error term account for the sampling variability.   

Since each experimental unit is measured at each treatment level it implies that observations within each subject will be correlated.  The model implies that the correlation between any pair of observations will have a correlation of
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This property is known as compound symmetry XE "Compound symmetry" .  It is analogous to the property that the error terms in one-way ANOVA all have the same standard deviation.  Part of the standard output for repeated measures tests whether this is so.
In this model, the test for equality of treatment levels becomes that of 
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This null hypothesis is equivalent to testing that each treatment level has the same mean.  This test is referred to as the within subjects test.  In addition, in a repeated measures experiment we can test
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This null hypothesis is equivalent to testing that each subject has the same mean value.  This is referred to as the between subjects test.  In order to do this we compute the following quantities.  The notation is the same as we used in Topic 16.
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	Activity 20-2:  Computing the Sums of Squares


a) What are the values of k, b, and N?  Record their values in the space below.
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b) Have SPSS compute the mean of the variables Admit, Disch, and Pref.  Record the values in the space below.
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c) Compute the mean of these means.  This will be the grand mean.  Record its value in the space below.
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d) Complete the missing entries in the table below.
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	Admit

	14.427-16.4893=-2.06233
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	Pref

	
	
	

	Disch

	17.728-16.4893=
1.23867
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e) Sum the results in the last column.  This will be SSW.  Record this amount in the space below.
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f) Compute SSB by doing the following in SPSS.  

· Use Transform > Compute to create a new variable, mean, that contains the mean of each subject.  That is, mean will be computed as (Admit+Pref+Disch)/3.

· Use Transform > Compute to create a new variable, component, that contains the individual components of SSB.  That is, component will be computed as 3*(mean-16.4893)**2.  Do not type two asterisks.  Use the double asterisk button in Transform > Compute.  This is SPSS’s button for exponentiation.
· Sum the values in component by clicking Analyze > Reports > Report Summaries in Columns to bring up the following dialog box.
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· Select component in the Data Columns window.  It will show in the window as component:sum meaning that the sum of the variable will be computed.  Click OK, and the sum will appear in an output window.  Record the value of this sum in the space below.
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g) It turns out that SSTotal=  537.431.  Compute SSE and record it in the space below.
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Now that we have the sums of squares, we obtain the mean squares XE "mean squares"  by dividing by the appropriate degrees of freedom.  It turns out that SSTotal has kb-1 degrees of freedom, SSW has k-1 degrees of freedom, SSB has b-1 degrees of freedom, and SSE has 
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	Activity 20-3:  Computing the Mean Squares


Compute MSW, MSB, and MSE and record their values in the space below.
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The test statistic for 
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When the model assumptions regarding the distribution of subjects and the error terms are true, F will have an F distribution XE "F distribution"  with 
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.  Then we can compute the p-value as follows.
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Similarly, the test statistic for 
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When the model assumptions regarding the error terms are true, F will have an F distribution XE "F distribution"  with 
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	Activity 20-4:  Testing the Equality of Means


a) Compute the F ratio for testing the equality of within subject means.  Record your value below.

b) What are the degrees of freedom associated with your F statistic?

c) Compute the p-value for your test.  Record the value below.

d) What do you conclude?

e) Compute the F statistic for testing that the standard deviation of subjects is zero.  Record your value below.

f) What are the degrees of freedom associated with your F statistic?

g) Compute the p-value for your test.  Record the value below.

h) What do you conclude?

We summarize the test procedure for repeated measures below.

	Testing in Repeated measures XE "Repeated measures, testing"  XE "Repeated measures" 
For a repeated measures experiment with k treatment levels and b blocks let
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Then, for testing 
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the test statistic is
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and the p-value is
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For testing 
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and the p-value is
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Technical requirements

a) Subjects are randomly sampled.

b) Subjects have a normal distribution with a mean of 0 and a standard deviation of 
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c) Error terms have a normal distribution with a mean of 0 and a standard deviation of 
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The ANOVA table for repeated measures shown above has the general form given below.

	Source ofVariation
	d.f.
	Sum of

Squares
	Mean

Square
	F
	p-value

	Between subjects
	b-1
	SSB
	MSB
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	Wiithin subjects
	k-1
	SSW
	MWT
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SPSS will conduct these tests. Proceed as follows.

· Select Analyze > General Linear Model > Repeated Measures to bring up the following dialog box.
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· Enter the number of treatment levels in the Number of Levels and click Add.

· Click Define to bring up the following dialog box.
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· One at a time select the variables that correspond to the treatment levels and enter them in the Within-Subjects Variables (factor1) box.

· Click OK to run the analysis.  The results will appear in an output window.

	Activity 20-5:  Repeated measures XE "Repeated measures"  Using SPSS


Have SPSS conduct the repeated measures analysis for the data on the anorexia patients.  Your dialog boxes should look like the ones shown above.  Your results should look like the following.  We will discuss the pieces individually.

General Linear Model
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· This summarizes which variables were used as the treatment levels.
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· There are a set of alternative tests for the equality of within subjects means.  They come from an area of statistics known as multivariate analysis.  These are the results of those tests.  A significant result is evidence against the equality of treatment levels.  We will not discuss them further.
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· The requirement of sphericity, like compound symmetry, XE "Sphericity"  is analogous to the requirement of error terms having the same standard deviation in one-way ANOVA.  The null hypothesis is that we have sphericity, and the alternative hypothesis is that we do not.  If sphericity is not indicated (as is the case with this example), then the degrees of freedom must be adjusted in order for F to have an approximate F distribution XE "F distribution" .  These adjustment factors are called epsilon.  Three of the more popular ones are listed in the output.  You adjust the degrees of freedom by multiplying each degree of freedom by epsilon.  It is recommended by some that when Greenhouse-Geisser is greater than 0.75 the Huynh-Feldt correction should be used.  Otherwise, the Greenhouse-Geisser correction should be used.  Others recommend averaging the two.
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· This table gives the ANOVA table for the within subjects test.  It gives the results for the case when we have sphericity along with the three adjusted tests when spericity is not present.
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· Sometimes researchers are interested in whether or not the within subjects means lie on some kind of curve.  The usual curves of interest are a straight line (linear), a parabola (quadratic), or a cubic curve.  SPSS tests whether this is true for the curves appropriate for the number of treatment levels.  If you have three or more treatment levels, SPSS will test all polynomials from linear up to one of degree k-1.  Recall that the degree of a polynomial is the highest power of X it has.  Recall from algebra that it is always possible to fit a polynomial of degree k through k+1 distinct points.  The null hypothesis is that the means do lie on that type of curve, and the alternative hypothesis is that they do not.
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· SPSS tests the equality of subject means in a manner that is different from what we describe in this topic.  This is the ANOVA table for that test.  The entry in the sum of squares column for Intercept XE "Intercept"  is the square of the sum of all the observations divided by kb. The entry in the sum of squares column for Error is SSB.  It is extremely rare for this to indicate the subjects have the same mean.
How do the results of your hand calculations for the within subjects test compare with those given by SPSS?

	Homework Activities


	Activity 20-6:  Identifying Experiments


For each of the experiments described below, identify it as being either a one-way analysis of variance, a repeated measures experiment, or neither.

a) Ten randomly selected people are asked to view three different advertisements for a brand of mouthwash and rate each on a scale from 1 to 10—1 being poor and 10 being excellent.  The order of viewing was randomly chosen for each person.  The question was whether the advertisements were equally well received.

b) Three groups of ten people each were asked to view an advertisement for a brand of mouthwash and rate  it on a scale from 1 to 10—1 being poor and 10 being excellent.  Each group viewed a different advertisement.  The question was whether the advertisements were equally well received.

c) In order to see if three rust inhibiting compounds are equally effective, thirty strips of metal were randomly divided into three groups of 10 each.  Each group was treated with one of the three compounds.

d) In order to see if three rust inhibiting compounds are equally effective, ten strips of metal were divided into three parts and each part was treated with one of the compounds.

e) In order to see if three rust inhibiting compounds are equally effective, five strips of galvanized metal and five strips of ungalvanized metal were divided into three parts and each part was treated with one of the compounds.

	Activity 20-7: Testing in Grade Schools


The SPSS data file SCHOOLTESTS.SAV XE "SCHOOLTESTS.SAV"  contains the average test scores for fourth and eighth graders in participating states.  We wish to see if the performance of fourth graders and eighth graders is the same.

a) What are the subjects in this experiment?

b) Formulate the appropriate null and alternative hypotheses.

c) Perform the test you describe in part (b).  Report your ANOVA table.

d) Do fourth and eighth graders appear to do as well, on average, on standardized  examinations?

	Activity 20-8:  Rating Conference Papers


Papers submitted to COMPSTAT-88, the 1988 conference on computational statistics, were sent to a number of judges for assessment.  The ratings were combined and discussed to decide which papers should be accepted for presentation at the meeting.  The data can be found in the SPSS data file CONF.SAV XE "CONF.SAV" .  They constitute a sample of 30 of the papers submitted.  Ratings range from 1 (highest) to 5 (lowest).

a) What are the subjects in this experiment?

b) What are the treatment levels in this experiment?

c) What are the null and alternative hypotheses for testing whether or not the papers were rated similarly by each judge?

d) Conduct the test you described in part (a).  Report your ANOVA table.

e) What do you conclude?

f) Do the data indicate that the papers received the same mean rating?

	Activity 20-9:  Judging Synchronized Swimming


The SPSS data file SYNCHRO.SAV XE "SYNCHRO.SAV"  contains the ratings of five judges for forty synchronized swimming teams.  The issue is whether there is uniformity, on average, in the ratings of the five judges.  This is a repeated measures experiment.

a) What are the subjects?

b) What is the response?

c) What are the null and alternative hypotheses for testing whether the average rating of the judges are the same or not?

d) Conduct the appropriate test of hypotheses.  Report your ANOVA table.

e) Do the judges appear to give the same average rating?

	Activity 20-10:  Estimating Lengths


Three students were asked to estimate the length of fifteen separate pieces of string.  The data in the SPSS data file STRING.SAV XE "STRING.SAV"  gives the actual length of each piece and the estimate by each of the three students, designated A, B and C.  The question is whether the average amount, in absolute value, by which each student’s estimate deviates from the true length are equal.

a) What are the subjects in this experiment?

b) What is the response?

c) Formulate the appropriate null and alternative hypotheses for this problem.

d) Conduct the test you give in part (c).  Report your ANOVA table.

e) What do you conclude?

Topic 21

Analyzing Two Treatments—I XE "Two-way ANOVA" 
	OVERVIEW


One Way Analysis of Variance XE "Variance"  is commonly viewed as an extension of the problem of comparing the means of two independent groups to more than two groups.  In many situations investigators are interested in determining if a particular response variable varies according to two different treatment effects.  As an example, suppose a psychologist is interested in the effects, if any, of watching cartoon violence on the behavior of children.  The investigator might also be interested in whether boys are more aggressive than girls, and whether viewing cartoon violence has a different effect on boys than it does on girls.  All of these questions can be addressed in a single experiment by using what is known as a factorial experiment.  In such an experiment observations are made of all possible combinations of the two treatments.  In our example, some boys would view a cartoon containing violence, some boys would view a cartoon containing no violence, some girls would view a cartoon containing violence, and some girls would view a cartoon containing no violence.  

	OBJECTIVES


· Learn about factorial designs.

· Learn the concept of interaction.

· See the population model for a factorial design.

· Learn to conduct Two Way Analysis of Variance XE "Variance" .

	PRELIMINARIES


a) Do you think that people in different religions tend to have different size households?  If so, what do you think the differences look like?

b) Do you think that different combinations of educational level and religious affiliation result in a difference in household size?  If so, what do you think the differences look like?

	IN-CLASS ACTIVITIES


As we said in the overview, the subject of this topic is factorial designs.  If we wanted to see if a given mean response differed according to the group membership for one categorical variable, we could collect samples and conduct a two sample t test or a one way analysis of variance, depending on the number of categories.  Recall from one way analysis of variance, the group membership variable is called a treatment XE "Treatment"  or a main effect XE "Main effect" , and each individual category is called a treatment level or main effect level.   If, in addition, we wanted to see if the mean response for the same variable differed according to the group membership for a different categorical variable, we could collect different samples and do a separate two sample t test or one way analysis of variance.  This would work just fine.  If, however, we felt that the combination of belonging to one category of one of the variables and a category of the other variable would result in an additional contribution to the mean response, then the approach just outlined would not allow us to assess this.  This additional effect is called an interaction XE "Interaction"  effect.  The use of factorial designs lets us test for interactions.  It is common practice to refer to a two factor factorial design as being a Two Way Analysis of Variance XE "Two way Analysis of Variance"  XE "Variance" .  The term two-way simply means that we have two main effects in our experiment.

In a factorial design all possible combinations of treatment levels are sampled.  If the number of sample units assigned to each treatment combination is the same, then the experimental design is said to be balanced XE "Balanced design" .  We will only consider balanced designs in this course.  In addition to the ability to test for interactions, this type of design has the benefit of letting us test the two main effects with fewer sample units. 

	Activity 21-1:  Effect of Education and Religion on Household Size


a) Open the SPSS data file REL_EDUC.SAV XE "REL_EDUC.SAV" .  The column Educ contains the educational level of the respondent, the column Size contains the household size, and the column Re contains the religious affiliation of the respondent.  

b) Identify the response variable and the main effects variables.

 In Topic 16 we used a means plot XE "Means plot"  to assess the likelihood that we would find a difference in group means for One Way Analysis of Variance XE "Variance" .  We can do the same for a factorial design.  The data must be stored so that the response variable is in one variable, the group identifier for one main effect is in a second variable, and the group identifier for the other main effect is in a third variable .  Proceed as follows

· Click Analyze > General Linear Model > Univariate to bring up the same dialog box you saw in Topic 16.

· Enter the response variable, household size, in the Dependent XE "Dependent"  Variable box and the two group identifiers, religion and education, in the Fixed Factor(s) box.  

· Click Plots to get the second dialog box we saw in Topic 16.

· One at a time enter each group identifying variable in the Horizontal Axis box and click Add.

· Click Continue followed by OK.  Along with other results which will be described later you will see two means plots in an output window.

c) Have SPSS create a main effects plot for both main effects variables.  Briefly discuss what you see.

In addition to a main effects plot, SPSS can also draw what is known as an interaction plot XE "Interaction plot" .  In such a plot, one of the main effects is assigned to the horizontal axis, and the response variable is assigned to the vertical axis for each possible level of the two treatments.  The mean response is calculated and plotted for all possible pairs of main effects treatment levels.  These means are connected with a straight line.  Each line corresponds to a level of the main effect treatment that is not used for the horizontal axis.

You proceed in a manner much like the means plots.

· Click Analyze > General Linear Model > Univariate.  

· Enter the response variable in the Dependent XE "Dependent"  Variable box and the two group identifiers in the Fixed Factor(s) box.  

· Click Plots to get the second dialog box we saw in Topic 16.

· Enter one group identifying variable in the Horizontal Axis box.

· Enter the other group identifying variable in the Separate Lines box and click Add.

· Click Continue followed by OK.  Along with other results which will be described later you will see the interaction plot in an output window.

d) Have SPSS create the interaction plot for the religion and education main effects with household size as the response.  Enter religion in the Horizontal Axis box and education Separate Lines box.  What you get should look like the following.

Profile Plots
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This one plot can give a considerable amount of information.  If there is no difference in mean household size for the various religion categories, then each of the lines in the plot should be almost horizontal.  If there is no difference in mean household size for the different educational levels, then the three lines should roughly coincide.  If there is no interaction effect, then the three lines should be roughly parallel.

e) Using the interaction plot and the main effects plots do you feel there is a difference in mean household size according to education?

f) Using the interaction plot and the main effects plot do you feel there is a difference in mean household size according to religion?

g) Using the interaction plot do you feel there is an interaction effect between education and religion?

We would like to be able to test whether or not the main effects levels differ and whether there is an interaction between the two main effects.  In order to do this we need a model for the population.  

	Population Model for a Factorial Design with Two Main Effects XE "Model for a Factorial Design" 
The population model for a balanced factorial design with two main effects is
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In a two factor factorial design we will be testing the following hypotheses.
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As was the case in One-way analysis of variance and repeated measures, we will be using sums of squares to form ratios that will have an F distribution XE "F distribution" .  We give the formulas below.  Let
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Then we define the following sums of squares XE "sums of squares" .
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It is useful to note that
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From a computational standpoint this means that we do not have to compute all of the sums of squares directly.  We can compute all but one of them and then solve for the remaining one.  Usually you compute all but the interaction sum of squares, SSAB.  You get it by computing
SSAB = SSTotal – SSA – SSB – SSE.
	Activity 21-2:  Computing the Sums of Squares


a) Have SPSS create a crosstabulation using religion and education.  Let education be the A effect and religion be the B effect.  Record the values for a, b, n, and N in the space below.
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b) Have SPSS compute the mean of the variable Size. Use Analyze > Descriptive Statistics > Explore.  This is the grand mean.  Record it in the space below.
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c) In your output for EXPLORE take the value of the variance and multiply it by N-1.  This will be SSTotal.  Record this value in the space below.
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d) Have SPSS compute the mean household size for each educational level.  Use Analyze > Descriptive Statistics > Explore with education in the Factor List box.  Use these results to complete the missing entries in the following table.
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	Some Elem
	
	
	

	Some HS
	3.51 - 3.04 = .47


	(.47)2 = .2209
	3(40)(.2209) = 26.508

	Some Coll
	2.79 - 3.04 = -.25  


	(-.25)2 = .0625
	3(40)(.0625) = 7.5

	
	
	Total

	


e) Sum the results in the rightmost column.  This will be SSA.  Record this value in the space below.
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f) Have SPSS compute the mean household size for each religious category.  Use Analyze > Descriptive Statistics > Explore with religion in the Factor List box.  Use these results to complete the missing entries in the following table.
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	Protestant
	2.63 – 3.04 = -.41

	(-.41)2 = .1681
	3(40)(.1681) = 20.172

	Catholic
	
	
	

	Other
	3.11 - 3.04 = .07  


	(.07)2 = .0049
	3(40)(.0049) = .588

	
	
	Total

	


g) Sum the values in the rightmost column.  This will be SSB.  Record this value in the space below.
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h) Split the cases by entering both religion and education in the Groups Based On box.  Run Analyze > Descriptive Statistics > Explore on size.  The Factor List box should be empty.  Multiply the reported variances by n-1, and fill in the missing entries in the table below.
	
	Protestant
	Catholic
	Other

	Some Elem


	39(1.82) = 70.98
	39(7.023) = 273.897
	39(2.779) = 108.381

	Some HS


	
	39(3.382) = 131.898 
	39(2.738) = 106.782

	Some Coll


	39(1.323) = 51.597
	
	39(1.426) = 55.614


i) Sum the entries in the table.  This is SSE.  Record the value in the space below.
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j) Finally, compute SSAB as follows.
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We are now ready to compute the mean squares.  In order to do this we need to know the number of degrees of freedom associated with each sum of squares.  These are


[image: image1048.wmf](

)

(

)

(

)

1,

1

11,

1, and

.

dfAa

dfBb

dfABab

dfEabn

dfTotaldfAdfBdfABdfE

=-

=-

=--

=-

=+++


Using these we compute the necessary mean squares XE "mean squares"  as follows.
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	Activity 21-3:  Computing the Mean Squares


a) What are the values of a, b and n?

b) Using these values and the sums of squares from Activity 21-2 compute and record the mean squares in the space below.
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We can now compute the statistics for testing both main effects and the interaction.  If the model assumptions of normally distributed error terms, each having the same standard deviation, are met then the ratios we form will have F distribution XE "F distribution" s.  This means that the p-values will be computed in the same manner as we did for the one-way analysis of variance model and for repeated measures.  

That is, for testing 
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For testing 
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the test statistic is
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For testing 
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the test statistic is
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and the p-value is
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We summarize the procedure below.

	Testing in a Two Factor Factorial Design XE "Two factor factorial design, testing" 
For a balanced two factor factorial experiment with a levels for Treatment XE "Treatment"  A and b levels for Treatment B and n observations per treatment combination, let
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Then, for testing 
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the test statistic is
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For testing 
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the test statistic is
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For testing 
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the test statistic is
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Technical requirements

a) Random samples.

b) Error terms have a normal distribution with a mean of 0 and a standard deviation of 
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	Activity 21-3:  Conducting the Tests


a) Compute and record the F ratio for testing for a difference in mean household size due to educational level.

b) Compute and record the p-value for this test.

c) What do you conclude?

d) Compute and record the value of the F ratio for testing a difference in mean household size due to religious preference.

e) Compute and record the p-value for this test.

f) What do you conclude?

g) Compute and record the value of the F ratio for testing for an interaction between educational level and religious preference.

h) Compute and record the p-value for this test.

i) What do you conclude?

	Homework Activities


	Activity 21-4:  Memorization Methods and Gender


The SPSS data file MEM2WAY.SAV XE "MEM2WAY.SAV"  contains the results of a two factor factorial experiment.  It compares two memorization methods—repetition and visualization, and gender.  We shall use memorization as Treatment XE "Treatment"  A and gender as Treatment B.

a) Have SPSS draw the main effects and interaction plots.  What do they show? 

b) What are the value for a, b and n?

c) Compute 
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 as was done in Activity 21-2.

	Activity 21-5:  Memorization Methods and Gender (cont’d.)


Use the results of Activity 21-4.

a) Compute SSA and SSB.

b) Compute SSTotal.

c) Compute SSE.

d) Compute SSAB.

	Activity 21-6:  Memorization Methods and Gender (cont’d.)


Use the results of Activities 21-4 and 21-5.

a) Compute the mean squares.

b) Compute the F ratios for the test of the two main effects and the test of the interaction.  What are the number of degrees of freedom associated with each one?

c) Compute the p-value for the three tests.

d) What do you conclude?

	Activity 21-7:  Butterfat Content of Milk


The SPSS data file BUTTERFAT.SAV XE "BUTTERFAT.SAV"  contains the butter fat content of milk from five breeds of dairy cattle and whether or not the individual cow was mature or two years old or less.  For each breed there were data for twenty cattle—ten mature cattle and ten younger cattle.  Let the breed of cattle be Treatment XE "Treatment"  A and age be Treatment B.  The data are summarized below.

	Breed
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	Mature

s
	Young

s
	
	Age
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	Ayrshire
	4.06
	0.315
	0.193
	
	Young
	4.53

	Canadian
	4.44
	0.348
	0.386
	
	Mature
	4.44

	Guernsey
	4.95
	0.466
	0.503
	
	
	

	Holstein
	3.67
	0.167
	0.329
	
	
	

	Jersey
	5.29
	0.674
	0.547
	
	
	


a) Have SPSS draw the main effects and interaction plots.  What do they indicate?

b) What are the values for a, b and n?

c) Compute SSA and SSB.

d) Compute SSE.

e) The value for SSTotal is 50.68.  Use this to compute SSAB.

	Activity 21-8:  Butterfat Content of Milk (cont’d.)


Use the information and results from Activity 21-7.

a) Compute the mean squares.

b) Compute the F ratios for the test of the two main effects and the test of the interaction.  What are the number of degrees of freedom associated with each one?

c) Compute the p-value for the three tests.

d) What conclusions do you reach?

	Activity 21-9:  Insurance Rates


The SPSS data file INSURANCE.SAV XE "INSURANCE.SAV"  the rates paid for term life insurance.  The main effects are the gender of the insured and whether or not he/she smokes.  The goal is to see how the amount paid varies according to these two main effects and to see if there is in interaction.

a) Have SPSS draw the main effects and interaction plots.  Describe what they show.

b) What are the values of a, b, n, and N?

c) Compute SSA and SSB.
d) Compute SSE.
e) Compute SSTotal.
f) Compute SSAB.
	Activity 21-10:  Insurance Rates (cont’d.)


Use the information and results from Activity 21-9.

a) Compute the mean squares.

b) Compute the F ratios for testing the two main effects and the interaction.  What are the degrees of freedom for each of your F ratios?

c) Compute the p-value for each of your F ratios.

d) What conclusions do your reach?

Topic 22

Analysis of Two Treatments—II XE "Two-way ANOVA" 
	OVERVIEW


In Topic 21 we learned how to construct a balanced two factor factorial experiment.  We also learned how to test hypotheses regarding the two main effects and an interaction between the main effects.  We now wish to show you how these results are commonly summarized in an Analysis of Variance XE "Variance"  table.  We will also see how SPSS performs the tests discussed in Topic 21.   

In addition, we wish to discuss briefly the possible consequences of the existence of an interaction on the test for the main effect.

	OBJECTIVES


· Learn how to construct an Analysis of Variance XE "Variance"  table for a Two Way Analysis of Variance.

· Learn how to use SPSS to analyze a balanced two factor experiment.

· See the impact of an interaction effect on the main effects.

	PRELIMINARIES


a) Do you think it is easier for people to solve problems that require them to detect the existence of a certain feature than it is for them to solve problems that require them to detect the absence of a certain feature?

b) How would you interpret a significant result for a main effects test when the test for an interaction is also significant?

	IN-CLASS ACTIVITIES


The most common method for summarizing a two factor Analysis of Variance XE "Variance"  is by constructing an ANOVA table XE "ANOVA table" .  These tables take the following general form.

	Source of

Variation
	d.f.
	Sum of

Squares
	Mean

Square
	F
	p

	Treatment XE "Treatment"  A
	a-1
	SSA
	MSA
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	Treatment XE "Treatment"  B
	b-1
	SSB
	MSB
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	Interaction XE "Interaction" 
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	SSAB
	MSAB
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	Error
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	SSE
	MSE
	
	

	Total
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	SSTotal
	
	
	


It is usual for the two treatments to be named.  There are two common ways of stating the interaction.  One is to simply use the term “Interaction XE "Interaction" .”  The other is to write it as 
[image: image1083.wmf]Treatment A  Treatment B
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	Activity 22-1:  Constructing an ANOVA Table


Use the results from the in-class activities in Topic 21 to summarize the analysis done there using an Analysis of Variance XE "Variance"  table.

SPSS can test for the main effects and interaction in a balanced two factor experiment.  The data must be stored so that one column contains all of the values of 
[image: image1084.wmf]ijk

Y

.  You also need one column containing the level identifiers for one of the main effects and another column containing the level identifiers for the other main effect.  Proceed as follows.

· Select Analyze > General Linear Model > Univariate to bring up the following dialog box.
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· Enter the response variable in the Dependent XE "Dependent"  Variable box.

· A main effect is said to be fixed if the treatment levels are the only ones of interest.  A main effect is said to be random if the levels are a random sample of all possible levels.  In this course we will only consider fixed effects.  Enter the two group identifying variables in the Fixed Factor(s) box.  

· Click OK to perform the analysis.  The results will appear in an output window.

	Activity 22-2:  Analyzing a Two Factor Experiment using SPSS


a) Open the SPSS data file REL_EDUC.SAV XE "REL_EDUC.SAV" .  Have SPSS conduct the analysis of the main effects of education and religion along with the interaction effect on mean household size.  Your results should look something like the following.

Univariate Analysis of Variance XE "Variance" 
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The output contains the following.

· The top table shows the level of each main effect along with the number of observational units in each one.

· The bottom table is the ANOVA table.  It contains the sums of squares we have been discussing along with some that we have not.

· The entry in the sum of squares labeled Total is 
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, the sum of the squares of each value on the response variable.

· The entry in the sum of squares labeled Intercept XE "Intercept"  is 
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, the grand mean squared times the total sample size.

· The entry in the sum of squares labeled Corrected Model is 
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.  The F test associated with it is testing that the population means for each of the nine different treatment combination are all equal.

· The entry in the sum of squares labeled Corrected Total is SSTotal.
· The entries in the sum of squares labeled Educ and Religion are SSA and SSB.
· The entry in the sum of squares labeled Educ*Rel is SSAB.
· The entry in the sum of squares labeled Error is SSE.
b) Compare the entries in this ANOVA table with the one you constructed in Activity 22-1. Briefly summarize your conclusions.

	Activity 22-3:  Problem Solving


a) Open the SPSS data file PROBLEM.SAV XE "PROBLEM.SAV" .  

Thirty-two people—16 men and 16 women—participated in an experiment in problem solving.  Each participant was asked to look at 60 pairs of three letter syllables (called trigrams), one pair at a time, and deduce for each pair, which trigram the experimenter has decided is “good” and which the experimenter has decided is “not good.”  The participants were not told the rule that the experimenter used to decide which trigrams are “good.”  The participants were told when their choice of trigram was correct.  Each participant was to deduce the rule the experimenter used to decide which trigrams were “good.”  The number of correct guesses by a participant was the measure of how quickly he or she was able to deduce the rule.  

In half the cases—8 men and 8 women—the rule was the presence of a given letter in a “good” trigram.  This is called feature positive.  In the other half the rule was the absence of a given letter in a “good” trigram.  This is called feature negative.
The SPSS data file contains three columns—sex of the participant, whether the rule was feature positive or feature negative, and the number of correct guesses out of 60 pairs of trigrams.  It is a two factor factorial design with the main effects being sex and rule.  The response is the number of correct guesses.

b) Have SPSS perform the Analysis of Variance XE "Variance"  for this experiment.  Transcribe your ANOVA table in the space below and summarize what you conclude from the analysis.

In both sets of experimental data that we have considered there is no evidence for an interaction.  In such cases the mean response for a given level of, say, Treatment XE "Treatment"  A does not depend on the level of Treatment B.  The reverse is also true.  The mean response for a given level of Treatment B does not depend on the level of Treatment A.  This situation lets us test whether or not there is a different mean response for different levels of each of the main effects.

In a situation where there is a significant interaction XE "Interaction"  effect, it is not possible to assign much meaning to the individual main effects tests.  If a main effect test is significant, this significant difference in the levels could be due to the interaction between it and the other main effect.  Also, if a main effect test is not significant, the presence of an interaction could be such that it counteracts an actual difference between main effect levels.

What this means is that, if you do find a significant interaction between the two main effects, then you should conduct a separate One Way Analysis of Variance XE "Variance"  experiments on each of the main effects.

	Activity 22-4:  Household Size versus Education and Race


Open the SPSS data file RACE_EDUC.SAV XE "RACE_EDUC.SAV" .  This data file gives the household size, educational level of the respondent and the race of the respondent.  Conduct a Two Way Analysis of Variance XE "Variance"  on the data and indicate what you conclude.  If there is an interaction indicated then test the main effects separately.  Summarize your findings below.


	Homework Activities


	Activity 22-5:  Memorization Methods and Gender (cont’d.)


a) Use the results from Activities 21-4, 21-5 and 21-6 to complete an ANOVA table for the memorization methods experiment.

b) Are the results on the main effects tests reliable?  Explain your reasoning.

	Activity 22-6:  Butterfat Content of Milk (cont’d.)


a) Use the results from Activities 21-7 and 21-8 to complete an ANOVA table for the dairy cow data.

b) What can you conclude about the validity of the tests on breed and age?

	Activity 22-7:  Insurance Rates (cont’d.)


a) Use the results from Activities 21-9 and 21-10 to complete an ANOVA table for the insurance rates data.

b) Are the results on the main effects tests reliable?  Explain your reasoning.

	Activity 22-8:  Birthrates in the United States


The SPSS data file BIRTHRATE.SAV XE "BIRTHRATE.SAV"  gives the birthrates in nine states in each of five different regions of the United States for the years 1975 and 1985.  Assume that these effects are fixed.

a) Perform an Analysis of Variance XE "Variance"  to see if there is a difference between the regions, a difference between the years and an interaction.  Report your findings in an ANOVA table.

b) What do you conclude?

c) What can you conclude about the validity of the tests on region and year?

	Activity 22-9: Education, Gender and Income


The SPSS data file ED_G_INCOME.SAV XE "ED_G_INCOME.SAV"  gives the educational level—no high school, high school and beyond high school, gender and income of a random sample of US adults.

a) Perform an Analysis of Variance XE "Variance"  to see if there is a difference in mean income between the educational levels, gender and an interaction.  Report your findings in an ANOVA table.

b) What do you conclude?

	Activity 22-10:  Australian Students (cont’d.)


The SPSS data file AUS_STUDENT.SAV XE "AUS_STUDENT.SAV"  gives the age range (less than 20, 20-24, 25-29, greater than 29) and gender along with the number of university students in Australia over five randomly selected years.

a) Perform an Analysis of Variance XE "Variance"  to see if there is a difference in the mean number of students due to age and due to gender, and whether there is an interaction.  Report your findings in an ANOVA table.

b) What are your conclusions?

c) What can you say about the validity of the tests on age and gender?

TABLES
TABLE I

NORMAL DISTRIBUTION XE "Normal distribution" 
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-1.9

-1.8

-1.7
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-1.0

-0.9

-0.8

-0.7

-0.6

-0.5

-0.4

-0.3

-0.2

-0.1

-0.0
	0.0003 0.0003 0.0003 0.0003 0.0003 0.0003 0.0003 0.0003 0.0003 0.0002  

0.0005 0.0005 0.0005 0.0004 0.0004 0.0004 0.0004 0.0004 0.0004 0.0003  

0.0007 0.0007 0.0006 0.0006 0.0006 0.0006 0.0006 0.0005 0.0005 0.0005  

0.0010 0.0009 0.0009 0.0009 0.0008 0.0008 0.0008 0.0008 0.0007 0.0007  

0.0013 0.0013 0.0013 0.0012 0.0012 0.0011 0.0011 0.0011 0.0010 0.0010  

0.0019 0.0018 0.0018 0.0017 0.0016 0.0016 0.0015 0.0015 0.0014 0.0014  

0.0026 0.0025 0.0024 0.0023 0.0023 0.0022 0.0021 0.0021 0.0020 0.0019  

0.0035 0.0034 0.0033 0.0032 0.0031 0.0030 0.0029 0.0028 0.0027 0.0026  

0.0047 0.0045 0.0044 0.0043 0.0041 0.0040 0.0039 0.0038 0.0037 0.0036  

0.0062 0.0060 0.0059 0.0057 0.0055 0.0054 0.0052 0.0051 0.0049 0.0048  

0.0082 0.0080 0.0078 0.0075 0.0073 0.0071 0.0069 0.0068 0.0066 0.0064  

0.0107 0.0104 0.0102 0.0099 0.0096 0.0094 0.0091 0.0089 0.0087 0.0084  

0.0139 0.0136 0.0132 0.0129 0.0125 0.0122 0.0119 0.0116 0.0113 0.0110  

0.0179 0.0174 0.0170 0.0166 0.0162 0.0158 0.0154 0.0150 0.0146 0.0143  

0.0228 0.0222 0.0217 0.0212 0.0207 0.0202 0.0197 0.0192 0.0188 0.0183  

0.0287 0.0281 0.0274 0.0268 0.0262 0.0256 0.0250 0.0244 0.0239 0.0233  

0.0359 0.0351 0.0344 0.0336 0.0329 0.0322 0.0314 0.0307 0.0301 0.0294  

0.0446 0.0436 0.0427 0.0418 0.0409 0.0401 0.0392 0.0384 0.0375 0.0367  

0.0548 0.0537 0.0526 0.0516 0.0505 0.0495 0.0485 0.0475 0.0465 0.0455  

0.0668 0.0655 0.0643 0.0630 0.0618 0.0606 0.0594 0.0582 0.0571 0.0559  

0.0808 0.0793 0.0778 0.0764 0.0749 0.0735 0.0721 0.0708 0.0694 0.0681  

0.0968 0.0951 0.0934 0.0918 0.0901 0.0885 0.0869 0.0853 0.0838 0.0823  

0.1151 0.1131 0.1112 0.1093 0.1075 0.1056 0.1038 0.1020 0.1003 0.0985  

0.1357 0.1335 0.1314 0.1292 0.1271 0.1251 0.1230 0.1210 0.1190 0.1170  

0.1587 0.1562 0.1539 0.1515 0.1492 0.1469 0.1446 0.1423 0.1401 0.1379  

0.1841 0.1814 0.1788 0.1762 0.1736 0.1711 0.1685 0.1660 0.1635 0.1611  

0.2119 0.2090 0.2061 0.2033 0.2005 0.1977 0.1949 0.1922 0.1894 0.1867  

0.2420 0.2389 0.2358 0.2327 0.2296 0.2266 0.2236 0.2206 0.2177 0.2148  

0.2743 0.2709 0.2676 0.2643 0.2611 0.2578 0.2546 0.2514 0.2483 0.2451  

0.3085 0.3050 0.3015 0.2981 0.2946 0.2912 0.2877 0.2843 0.2810 0.2776  

0.3446 0.3409 0.3372 0.3336 0.3300 0.3264 0.3228 0.3192 0.3156 0.3121  

0.3821 0.3783 0.3745 0.3707 0.3669 0.3632 0.3594 0.3557 0.3520 0.3483  

0.4207 0.4168 0.4129 0.4090 0.4052 0.4013 0.3974 0.3936 0.3897 0.3859  

0.4602 0.4562 0.4522 0.4483 0.4443 0.4404 0.4364 0.4325 0.4286 0.4247  

0.5000 0.4960 0.4920 0.4880 0.4840 0.4801 0.4761 0.4721 0.4681 0.4641  


For values of z less than –3.49 use 0.0000.
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	  .00    .01    .02    .03    .04    .05    .06    .07    .08    .09

	0.0

0.1

0.2

0.3

0.4

0.5

0.6

0.7
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2.0
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2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

3.0

3.1

3.2

3.3

3.4
	0.5000 0.5040 0.5080 0.5120 0.5160 0.5199 0.5239 0.5279 0.5319 0.5359  

0.5398 0.5438 0.5478 0.5517 0.5557 0.5596 0.5636 0.5675 0.5714 0.5753  

0.5793 0.5832 0.5871 0.5910 0.5948 0.5987 0.6026 0.6064 0.6103 0.6141  

0.6179 0.6217 0.6255 0.6293 0.6331 0.6368 0.6406 0.6443 0.6480 0.6517  

0.6554 0.6591 0.6628 0.6664 0.6700 0.6736 0.6772 0.6808 0.6844 0.6879  

0.6915 0.6950 0.6985 0.7019 0.7054 0.7088 0.7123 0.7157 0.7190 0.7224  

0.7257 0.7291 0.7324 0.7357 0.7389 0.7422 0.7454 0.7486 0.7517 0.7549  

0.7580 0.7611 0.7642 0.7673 0.7704 0.7734 0.7764 0.7794 0.7823 0.7852  

0.7881 0.7910 0.7939 0.7967 0.7995 0.8023 0.8051 0.8078 0.8106 0.8133  

0.8159 0.8186 0.8212 0.8238 0.8264 0.8280 0.8315 0.8340 0.8365 0.8389  

0.8413 0.8438 0.8461 0.8485 0.8508 0.8531 0.8554 0.8577 0.8599 0.8621  

0.8643 0.8665 0.8686 0.8708 0.8729 0.8749 0.8770 0.8790 0.8810 0.8830  

0.8849 0.8869 0.8888 0.8907 0.8925 0.8944 0.8962 0.8980 0.8997 0.9015  

0.9032 0.9049 0.9066 0.9082 0.9099 0.9115 0.9131 0.9147 0.9162 0.9177  

0.9192 0.9207 0.9222 0.9236 0.9251 0.9265 0.9279 0.9292 0.9306 0.9319  

0.9332 0.9345 0.9357 0.9370 0.9382 0.9394 0.9406 0.9418 0.9429 0.9441  

0.9452 0.9463 0.9474 0.9484 0.9495 0.9505 0.9515 0.9525 0.9535 0.9545  

0.9554 0.9564 0.9573 0.9582 0.9591 0.9599 0.9608 0.9616 0.9625 0.9633  

0.9641 0.9649 0.9656 0.9664 0.9671 0.9678 0.9686 0.9693 0.9699 0.9706  

0.9713 0.9719 0.9726 0.9732 0.9738 0.9744 0.9750 0.9756 0.9761 0.9767  

0.9772 0.9778 0.9783 0.9788 0.9793 0.9798 0.9803 0.9808 0.9812 0.9817  

0.9821 0.9826 0.9830 0.9834 0.9838 0.9842 0.9846 0.9850 0.9854 0.9857  

0.9861 0.9864 0.9868 0.9871 0.9875 0.9878 0.9881 0.9884 0.9887 0.9890  

0.9893 0.9896 0.9898 0.9901 0.9904 0.9906 0.9909 0.9911 0.9913 0.9916  

0.9918 0.9920 0.9922 0.9925 0.9927 0.9929 0.9931 0.9932 0.9934 0.9936  

0.9938 0.9940 0.9941 0.9943 0.9945 0.9946 0.9948 0.9949 0.9951 0.9952  

0.9953 0.9955 0.9956 0.9957 0.9959 0.9960 0.9961 0.9962 0.9963 0.9964  

0.9965 0.9966 0.9967 0.9968 0.9969 0.9970 0.9971 0.9972 0.9973 0.9974  

0.9974 0.9975 0.9976 0.9977 0.9977 0.9978 0.9979 0.9979 0.9980 0.9981  

0.9981 0.9982 0.9982 0.9983 0.9984 0.9984 0.9985 0.9985 0.9986 0.9986  

0.9987 0.9987 0.9987 0.9988 0.9988 0.9989 0.9989 0.9989 0.9990 0.9990  

0.9990 0.9991 0.9991 0.9991 0.9992 0.9992 0.9992 0.9992 0.9993 0.9993  

0.9993 0.9993 0.9994 0.9994 0.9994 0.9994 0.9994 0.9995 0.9995 0.9995  

0.9995 0.9995 0.9995 0.9996 0.9996 0.9996 0.9996 0.9996 0.9996 0.9997  

0.9997 0.9997 0.9997 0.9997 0.9997 0.9997 0.9997 0.9997 0.9997 0.9998


For values of z greater than 3.49 use 1.000.

TABLE II

T DISTRIBUTION
 XE "T distribution" 
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	 1.000  1.376  1.963  3.078  6.314 12.706 15.895 31.821 63.657 127.321 318.309 636.62  

 0.816  1.061  1.386  1.886  2.920  4.303  4.849  6.965  9.925  14.089  22.327  31.599  

 0.765  0.978  1.25   1.638  2.353  3.182  3.482  4.541  5.841   7.453  10.215  12.924  

 0.741  0.941  1.190  1.533  2.132  2.776  2.999  3.747  4.604   5.598   7.173   8.610  

 0.727  0.920  1.156  1.476  2.015  2.571  2.757  3.365  4.032   4.773   5.893   6.869  

 0.718  0.906  1.134  1.440  1.943  2.447  2.612  3.143  3.707   4.317   5.208   5.959  

 0.711  0.896  1.119  1.415  1.895  2.365  2.517  2.998  3.499   4.029   4.785   5.408  

 0.706  0.889  1.108  1.397  1.860  2.306  2.449  2.896  3.355   3.833   4.501   5.041  

 0.703  0.883  1.100  1.383  1.833  2.262  2.398  2.821  3.250   3.690   4.297   4.781  

 0.700  0.879  1.093  1.372  1.812  2.228  2.359  2.764  3.169   3.581   4.144   4.587  

 0.697  0.876  1.088  1.363  1.796  2.201  2.328  2.718  3.106   3.497   4.025   4.437  

 0.695  0.873  1.083  1.356  1.782  2.179  2.303  2.681  3.055   3.428   3.930   4.318  

 0.694  0.870  1.079  1.350  1.771  2.160  2.282  2.650  3.012   3.372   3.852   4.221  

 0.692  0.868  1.076  1.345  1.761  2.145  2.264  2.624  2.977   3.326   3.787   4.140  

 0.691  0.866  1.074  1.341  1.753  2.131  2.249  2.602  2.947   3.286   3.733   4.073  

 0.690  0.865  1.071  1.337  1.746  2.120  2.235  2.583  2.921   3.252   3.686   4.015  

 0.689  0.863  1.069  1.333  1.740  2.110  2.224  2.567  2.898   3.222   3.646   3.965  

 0.688  0.862  1.067  1.330  1.734  2.101  2.214  2.552  2.878   3.197   3.611   3.922  

 0.688  0.861  1.066  1.328  1.729  2.093  2.205  2.539  2.861   3.174   3.579   3.883  

 0.687  0.860  1.064  1.325  1.725  2.086  2.197  2.528  2.845   3.153   3.552   3.850  

 0.686  0.859  1.063  1.323  1.721  2.080  2.189  2.518  2.831   3.135   3.527   3.819  

 0.686  0.858  1.061  1.321  1.717  2.074  2.183  2.508  2.819   3.119   3.505   3.792  

 0.685  0.858  1.060  1.319  1.714  2.069  2.177  2.500  2.807   3.104   3.485   3.768  

 0.685  0.857  1.059  1.318  1.711  2.064  2.172  2.492  2.797   3.091   3.467   3.745  

 0.684  0.856  1.058  1.316  1.708  2.060  2.167  2.485  2.787   3.078   3.450   3.725  

 0.684  0.856  1.058  1.315  1.706  2.056  2.162  2.479  2.779   3.067   3.435   3.707  

 0.684  0.855  1.057  1.314  1.703  2.052  2.158  2.473  2.771   3.057   3.421   3.690  

 0.683  0.855  1.056  1.313  1.701  2.048  2.154  2.467  2.763   3.047   3.408   3.674  

 0.683  0.854  1.055  1.311  1.699  2.045  2.150  2.462  2.756   3.038   3.396   3.659  

 0.683  0.854  1.055  1.310  1.697  2.042  2.147  2.457  2.750   3.030   3.385   3.646  

 0.681  0.851  1.050  1.303  1.684  2.021  2.123  2.423  2.704   2.971   3.307   3.551  

 0.679  0.849  1.047  1.299  1.676  2.009  2.109  2.403  2.678   2.937   3.261   3.496  

 0.679  0.848  1.045  1.296  1.671  2.000  2.099  2.390  2.660   2.915   3.232   3.460  

 0.678  0.846  1.043  1.292  1.664  1.990  2.088  2.374  2.639   2.887   3.195   3.416  

 0.677  0.845  1.042  1.290  1.660  1.984  2.081  2.364  2.626   2.871   3.174   3.391  

 0.675  0.842  1.037  1.282  1.646  1.962  2.056  2.330  2.581   2.813   3.098   3.300  

 0.674  0.842  1.036  1.282  1.645  1.960  2.054  2.326  2.576   2.807   3.090   3.291  

	Conf.
	  50%    60%    70%    80%    90%    95%    96%    98%    99%    99.5%   99.8%   99.9%  


TABLE III

CHI-SQUARE DISTRIBUTION
 XE "Chi-square distribution" 
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	  1.32   1.64   2.07   2.71   3.84   5.02   5.41   6.63   7.88   9.14  10.83  12.12 

  2.77   3.22   3.79   4.61   5.99   7.38   7.82   9.21  10.6   11.98  13.82  15.2 

  4.11   4.64   5.3    6.25   7.81   9.35   9.84  11.34  12.84  14.32  16.27  17.73

  5.39   5.99   6.74   7.78   9.49  11.14  11.67  13.28  14.86  16.42  18.47  20

  6.63   7.29   8.12   9.24  11.07  12.83  13.39  15.09  16.75  18.39  20.52  22.11  

  7.84   8.56   9.45  10.64  12.59  14.45  15.03  16.81  18.55  20.25  22.46  24.1  

  9.04   9.8   10.75  12.02  14.07  16.01  16.62  18.48  20.28  22.04  24.32  26.02  

 10.22  11.03  12.03  13.36  15.51  17.53  18.17  20.09  21.95  23.77  26.12  27.87  

 11.39  12.24  13.29  14.68  16.92  19.02  19.68  21.67  23.59  25.46  27.88  29.67  

 12.55  13.44  14.53  15.99  18.31  20.48  21.16  23.21  25.19  27.11  29.59  31.42  

 13.7   14.63  15.77  17.28  19.68  21.92  22.62  24.72  26.76  28.73  31.26  33.14  

 14.85  15.81  16.99  18.55  21.03  23.34  24.05  26.22  28.3   30.32  32.91  34.82  

 15.9   16.98  18.2   19.81  22.36  24.74  25.47  27.69  29.82  31.88  34.53  36.48  

 17.12  18.15  19.41  21.06  23.68  26.12  26.87  29.14  31.32  33.43  36.12  38.11  

 18.25  19.31  20.6   22.31  25     27.49  28.26  30.58  32.8   34.95  37.7   39.72  

 19.37  20.47  21.79  23.54  26.3   28.85  29.63  32     34.27  36.46  39.25  41.31  

 20.49  21.61  22.98  24.77  27.59  30.19  31     33.41  35.72  37.95  40.79  42.88  

 21.6   22.76  24.16  25.99  28.87  31.53  32.35  34.81  37.16  39.42  42.31  44.43  

 22.72  23.9   25.33  27.2   30.14  32.85  33.69  36.19  38.58  40.89  43.82  45.97  

 23.83  25.04  26.5   28.41  31.41  34.17  35.02  37.57  40     42.34  45.31  47.5 

 24.93  26.17  27.66  29.62  32.67  35.48  36.34  38.93  41.4   43.78  46.8   49.01  

 26.04  27.3   28.82  30.81  33.92  36.78  37.66  40.29  42.8   45.2   48.27  50.51  

 27.14  28.43  29.98  32.01  35.17  38.08  38.97  41.64  44.18  46.62  49.73  52  

 28.24  29.55  31.13  33.2   36.42  39.36  40.27  42.98  45.56  48.03  51.18  53.48  

 29.34  30.68  32.28  34.38  37.65  40.65  41.57  44.31  46.93  49.44  52.62  54.95  

 30.43  31.79  33.43  35.56  38.89  41.92  42.86  45.64  48.29  50.83  54.05  56.41  

 31.53  32.91  34.57  36.74  40.11  43.19  44.14  46.96  49.64  52.22  55.48  57.86  

 32.62  34.03  35.71  37.92  41.34  44.46  45.42  48.28  50.99  53.59  56.89  59.3  

 33.71  35.14  36.85  39.09  42.56  45.72  46.69  49.59  52.34  54.97  58.3   60.73  

 34.8   36.25  37.99  40.26  43.77  46.98  47.96  50.89  53.67  56.33  59.7   62.16  

 45.62  47.27  49.24  51.81  55.76  59.34  60.44  63.69  66.77  69.7   73.4   76.09  

 56.33  58.16  60.35  63.17  67.5   71.42  72.61  76.15  79.49  82.66  86.66  89.56  

 66.98  68.97  71.34  74.4   79.08  83.3   84.58  88.38  91.95  95.34  99.61 102.69  

 88.13  90.41  93.11  96.58 101.88 106.63 108.07 112.33 116.32 120.1  124.84 128.26  

109.14 111.67 114.66 118.5  124.34 129.56 131.14 135.81 140.17 144.29 149.45 153.17  


TABLE IV

F DISTRIBUTION
 XE "F distribution" 
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	Dfn

	dfd
	p
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10

	
	0.1
	39.86
	49.50
	53.59
	55.83
	57.24
	58.20
	58.91
	59.44
	59.86
	60.20

	
	0.05
	161.45
	199.50
	215.71
	224.58
	230.16
	233.99
	236.77
	238.88
	240.54
	241.88

	1
	0.025
	647.79
	799.50
	864.16
	899.58
	921.85
	937.11
	948.22
	956.66
	963.29
	968.63

	
	0.01
	4052.18
	4999.5
	5403.35
	5624.58
	5763.65
	5858.99
	5928.36
	5981.07
	6022.47
	6055.85

	
	0.001
	405284
	500000
	540379
	562500
	576405
	585937
	592873
	598144
	602284
	605621

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	8.53
	9.00
	9.16
	9.24
	9.29
	9.33
	9.35
	9.37
	9.38
	9.39

	
	0.05
	18.51
	19.00
	19.16
	19.25
	19.30
	19.33
	19.35
	19.37
	19.38
	19.40

	2
	0.025
	38.51
	39.00
	39.17
	39.25
	39.30
	39.33
	39.36
	39.37
	39.39
	39.40

	
	0.01
	98.50
	99.00
	99.17
	99.25
	99.30
	99.33
	99.36
	99.38
	99.39
	99.40

	
	0.001
	998.50
	999.00
	999.17
	999.25
	999.30
	999.33
	999.36
	999.37
	999.39
	999.40

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	5.54
	5.46
	5.39
	5.34
	5.31
	5.29
	5.27
	5.25
	5.24
	5.23

	
	0.05
	10.13
	9.55
	9.28
	9.12
	9.01
	8.94
	8.89
	8.85
	8.81
	8.79

	3
	0.025
	17.44
	16.04
	15.44
	15.10
	14.89
	14.74
	14.62
	14.54
	14.47
	14.42

	
	0.01
	34.12
	30.82
	29.46
	28.71
	28.24
	27.91
	27.67
	27.49
	27.35
	27.23

	
	0.001
	167.03
	148.50
	141.11
	137.10
	134.58
	132.85
	131.58
	130.62
	129.86
	129.25

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	4.55
	4.32
	4.19
	4.11
	4.05
	4.01
	3.98
	3.96
	3.94
	3.92

	
	0.05
	7.71
	6.94
	6.59
	6.39
	6.26
	6.16
	6.09
	6.04
	6.00
	5.96

	4
	0.025
	12.22
	10.65
	9.98
	9.60
	9.36
	9.20
	9.07
	8.98
	8.90
	8.84

	
	0.01
	21.20
	18.00
	16.69
	15.98
	15.52
	15.21
	14.98
	14.80
	14.66
	14.55

	
	0.001
	74.14
	61.25
	56.18
	53.44
	51.71
	50.53
	49.66
	49.00
	48.47
	48.05

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	4.06
	3.78
	3.62
	3.52
	3.45
	3.40
	3.37
	3.34
	3.32
	3.30

	
	0.05
	6.61
	5.79
	5.41
	5.19
	5.05
	4.95
	4.88
	4.82
	4.77
	4.73

	5
	0.025
	10.01
	8.43
	7.76
	7.39
	7.15
	6.98
	6.85
	6.76
	6.68
	6.62

	
	0.01
	16.26
	13.27
	12.06
	11.39
	10.97
	10.67
	10.46
	10.29
	10.16
	10.05

	
	0.001
	47.18
	37.12
	33.20
	31.09
	29.75
	28.83
	28.16
	27.65
	27.24
	26.92

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	3.78
	3.46
	3.29
	3.18
	3.11
	3.05
	3.01
	2.98
	2.96
	2.94

	
	0.05
	5.99
	5.14
	4.76
	4.53
	4.39
	4.28
	4.21
	4.15
	4.10
	4.06

	6
	0.025
	8.81
	7.26
	6.60
	6.23
	5.99
	5.82
	5.70
	5.60
	5.52
	5.46

	
	0.01
	13.75
	10.92
	9.78
	9.15
	8.75
	8.47
	8.26
	8.10
	7.98
	7.87

	
	0.001
	35.51
	27.00
	23.70
	21.92
	20.80
	20.03
	19.46
	19.03
	18.69
	18.41

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	3.59
	3.26
	3.07
	2.96
	2.88
	2.83
	2.79
	2.75
	2.73
	2.70

	
	0.05
	5.59
	4.74
	4.35
	4.12
	3.97
	3.87
	3.79
	3.73
	3.68
	3.64

	7
	0.025
	8.07
	6.54
	5.89
	5.52
	5.29
	5.12
	5.00
	4.90
	4.82
	4.76

	
	0.01
	12.25
	9.55
	8.45
	7.85
	7.46
	7.19
	6.99
	6.84
	6.72
	6.62

	
	0.001
	29.25
	21.69
	18.77
	17.20
	16.21
	15.52
	15.02
	14.63
	14.33
	14.08

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	3.46
	3.11
	2.92
	2.81
	2.73
	2.67
	2.62
	2.59
	2.56
	2.54

	
	0.05
	5.32
	4.46
	4.07
	3.84
	3.69
	3.58
	3.50
	3.44
	3.39
	3.35

	8
	0.025
	7.57
	6.06
	5.42
	5.05
	4.82
	4.65
	4.53
	4.43
	4.36
	4.29

	
	0.01
	11.26
	8.65
	7.59
	7.01
	6.63
	6.37
	6.18
	6.03
	5.91
	5.81

	
	0.001
	25.42
	18.49
	15.83
	14.39
	13.48
	12.86
	12.40
	12.05
	11.77
	11.54

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	3.36
	3.01
	2.81
	2.69
	2.61
	2.55
	2.51
	2.47
	2.44
	2.42

	
	0.05
	5.12
	4.26
	3.86
	3.63
	3.48
	3.37
	3.29
	3.23
	3.18
	3.14

	9
	0.025
	7.21
	5.71
	5.08
	4.72
	4.48
	4.32
	4.20
	4.10
	4.03
	3.96

	
	0.01
	10.56
	8.02
	6.99
	6.42
	6.06
	5.80
	5.61
	5.47
	5.35
	5.26

	
	0.001
	22.86
	16.39
	13.90
	12.56
	11.71
	11.13
	10.70
	10.37
	10.11
	9.89

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	3.29
	2.92
	2.73
	2.61
	2.52
	2.46
	2.41
	2.38
	2.35
	2.32

	
	0.05
	4.96
	4.10
	3.71
	3.48
	3.33
	3.22
	3.14
	3.07
	3.02
	2.98

	10
	0.025
	6.94
	5.46
	4.83
	4.47
	4.24
	4.07
	3.95
	3.86
	3.78
	3.72

	
	0.01
	10.04
	7.56
	6.55
	5.99
	5.64
	5.39
	5.20
	5.06
	4.94
	4.85

	
	0.001
	21.04
	14.91
	12.55
	11.28
	10.48
	9.93
	9.52
	9.20
	8.96
	8.75
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	Dfn

	dfd
	p
	12
	15
	20
	25
	30
	40
	50
	60
	120
	1000

	
	0.1
	60.71
	61.22
	61.74
	62.05
	62.26
	62.53
	62.69
	62.79
	63.06
	63.30

	
	0.05
	243.91
	245.95
	248.01
	249.26
	250.10
	251.14
	251.77
	252.20
	253.25
	254.19

	1
	0.025
	976.71
	984.87
	993.10
	998.08
	1001.41
	1005.60
	1008.12
	1009.80
	1014.02
	1017.75

	
	0.01
	6106.32
	6157.28
	6208.73
	6239.83
	6260.65
	6286.78
	6302.52
	6313.03
	6339.39
	6362.68

	
	0.001
	610668
	615764
	620908
	624017
	626099
	628712
	630285
	631337
	633972
	636301

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	9.41
	9.42
	9.44
	9.45
	9.46
	9.47
	9.47
	9.47
	9.48
	9.49

	
	0.05
	19.41
	19.43
	19.45
	19.46
	19.46
	19.47
	19.48
	19.48
	19.49
	19.50

	2
	0.025
	39.41
	39.43
	39.45
	39.46
	39.46
	39.47
	39.48
	39.48
	39.49
	39.50

	
	0.01
	99.42
	99.43
	99.45
	99.46
	99.47
	99.47
	99.48
	99.48
	99.49
	99.50

	
	0.001
	999.42
	999.43
	999.45
	999.46
	999.47
	999.48
	999.48
	999.48
	999.49
	999.50

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	5.22
	5.20
	5.18
	5.17
	5.17
	5.16
	5.15
	5.15
	5.14
	5.14

	
	0.05
	8.74
	8.70
	8.66
	8.63
	8.62
	8.59
	8.58
	8.57
	8.55
	8.53

	3
	0.025
	14.34
	14.25
	14.17
	14.12
	14.08
	14.04
	14.01
	13.99
	13.95
	13.91

	
	0.01
	27.05
	26.87
	26.69
	26.58
	26.50
	26.41
	26.35
	26.32
	26.22
	26.14

	
	0.001
	128.32
	127.37
	126.42
	125.84
	125.45
	124.96
	124.66
	124.47
	123.97
	123.53

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	3.90
	3.87
	3.84
	3.83
	3.82
	3.80
	3.79
	3.79
	3.78
	3.76

	
	0.05
	5.91
	5.86
	5.80
	5.77
	5.75
	5.72
	5.70
	5.69
	5.66
	5.63

	4
	0.025
	8.75
	8.66
	8.56
	8.50
	8.46
	8.41
	8.38
	8.36
	8.31
	8.26

	
	0.01
	14.37
	14.20
	14.02
	13.91
	13.84
	13.75
	13.69
	13.65
	13.56
	13.47

	
	0.001
	47.41
	46.76
	46.10
	45.70
	45.43
	45.09
	44.88
	44.75
	44.40
	44.09

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	3.27
	3.24
	3.21
	3.19
	3.17
	3.16
	3.15
	3.14
	3.12
	3.11

	
	0.05
	4.68
	4.62
	4.56
	4.52
	4.50
	4.46
	4.44
	4.43
	4.40
	4.37

	5
	0.025
	6.52
	6.43
	6.33
	6.27
	6.23
	6.18
	6.14
	6.12
	6.07
	6.02

	
	0.01
	9.89
	9.72
	9.55
	9.45
	9.38
	9.29
	9.24
	9.20
	9.11
	9.03

	
	0.001
	26.42
	25.91
	25.39
	25.08
	24.87
	24.60
	24.44
	24.33
	24.06
	23.82

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.90
	2.87
	2.84
	2.81
	2.80
	2.78
	2.77
	2.76
	2.74
	2.73

	
	0.05
	4.00
	3.94
	3.87
	3.83
	3.81
	3.77
	3.75
	3.74
	3.70
	3.67

	6
	0.025
	5.37
	5.27
	5.17
	5.11
	5.07
	5.01
	4.98
	4.96
	4.90
	4.86

	
	0.01
	7.72
	7.56
	7.40
	7.30
	7.23
	7.14
	7.09
	7.06
	6.97
	6.89

	
	0.001
	17.99
	17.56
	17.12
	16.85
	16.67
	16.44
	16.31
	16.21
	15.98
	15.77

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.67
	2.63
	2.59
	2.57
	2.56
	2.54
	2.52
	2.51
	2.49
	2.47

	
	0.05
	3.57
	3.51
	3.44
	3.40
	3.38
	3.34
	3.32
	3.30
	3.27
	3.23

	7
	0.025
	4.67
	4.57
	4.47
	4.40
	4.36
	4.31
	4.28
	4.25
	4.20
	4.15

	
	0.01
	6.47
	6.31
	6.16
	6.06
	5.99
	5.91
	5.86
	5.82
	5.74
	5.66

	
	0.001
	13.71
	13.32
	12.93
	12.69
	12.53
	12.33
	12.20
	12.12
	11.91
	11.72

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.50
	2.46
	2.42
	2.40
	2.38
	2.36
	2.35
	2.34
	2.32
	2.30

	
	0.05
	3.28
	3.22
	3.15
	3.11
	3.08
	3.04
	3.02
	3.01
	2.97
	2.93

	8
	0.025
	4.20
	4.10
	4.00
	3.94
	3.89
	3.84
	3.81
	3.78
	3.73
	3.68

	
	0.01
	5.67
	5.51
	5.36
	5.26
	5.20
	5.12
	5.07
	5.03
	4.95
	4.87

	
	0.001
	11.19
	10.84
	10.48
	10.26
	10.11
	9.92
	9.80
	9.73
	9.53
	9.36

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.38
	2.34
	2.30
	2.27
	2.25
	2.23
	2.22
	2.21
	2.18
	2.16

	
	0.05
	3.07
	3.01
	2.94
	2.89
	2.86
	2.83
	2.80
	2.79
	2.75
	2.71

	9
	0.025
	3.87
	3.77
	3.67
	3.60
	3.56
	3.51
	3.47
	3.45
	3.39
	3.34

	
	0.01
	5.11
	4.96
	4.81
	4.71
	4.65
	4.57
	4.52
	4.48
	4.40
	4.32

	
	0.001
	9.57
	9.24
	8.90
	8.69
	8.55
	8.37
	8.26
	8.19
	8.00
	7.84

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.28
	2.24
	2.20
	2.17
	2.16
	2.13
	2.12
	2.11
	2.08
	2.06

	
	0.05
	2.91
	2.85
	2.77
	2.73
	2.70
	2.66
	2.64
	2.62
	2.58
	2.54

	10
	0.025
	3.62
	3.52
	3.42
	3.35
	3.31
	3.26
	3.22
	3.20
	3.14
	3.09

	
	0.01
	4.71
	4.56
	4.41
	4.31
	4.25
	4.17
	4.12
	4.08
	4.00
	3.92

	
	0.001
	8.45
	8.13
	7.80
	7.60
	7.47
	7.30
	7.19
	7.12
	6.94
	6.78
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	Dfn

	dfd
	p
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10

	
	0.1
	3.23
	2.86
	2.66
	2.54
	2.45
	2.39
	2.34
	2.30
	2.27
	2.25

	
	0.05
	4.84
	3.98
	3.59
	3.36
	3.20
	3.09
	3.01
	2.95
	2.90
	2.85

	11
	0.025
	6.72
	5.26
	4.63
	4.28
	4.04
	3.88
	3.76
	3.66
	3.59
	3.53

	
	0.01
	9.65
	7.21
	6.22
	5.67
	5.32
	5.07
	4.89
	4.74
	4.63
	4.54

	
	0.001
	19.69
	13.81
	11.56
	10.35
	9.58
	9.05
	8.66
	8.35
	8.12
	7.92

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	3.18
	2.81
	2.61
	2.48
	2.39
	2.33
	2.28
	2.24
	2.21
	2.19

	
	0.05
	4.75
	3.89
	3.49
	3.26
	3.11
	3.00
	2.91
	2.85
	2.80
	2.75

	12
	0.025
	6.55
	5.10
	4.47
	4.12
	3.89
	3.73
	3.61
	3.51
	3.44
	3.37

	
	0.01
	9.33
	6.93
	5.95
	5.41
	5.06
	4.82
	4.64
	4.50
	4.39
	4.30

	
	0.001
	18.64
	12.97
	10.80
	9.63
	8.89
	8.38
	8.00
	7.71
	7.48
	7.29

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	3.14
	2.76
	2.56
	2.43
	2.35
	2.28
	2.23
	2.20
	2.16
	2.14

	
	0.05
	4.67
	3.81
	3.41
	3.18
	3.03
	2.91
	2.83
	2.77
	2.71
	2.67

	13
	0.025
	6.41
	4.97
	4.35
	4.00
	3.77
	3.60
	3.48
	3.39
	3.31
	3.25

	
	0.01
	9.07
	6.70
	5.74
	5.21
	4.86
	4.62
	4.44
	4.30
	4.19
	4.10

	
	0.001
	17.82
	12.31
	10.21
	9.07
	8.35
	7.86
	7.49
	7.21
	6.98
	6.80

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	3.10
	2.73
	2.52
	2.39
	2.31
	2.24
	2.19
	2.15
	2.12
	2.10

	
	0.05
	4.60
	3.74
	3.34
	3.11
	2.96
	2.85
	2.76
	2.70
	2.65
	2.60

	14
	0.025
	6.30
	4.86
	4.24
	3.89
	3.66
	3.50
	3.38
	3.29
	3.21
	3.15

	
	0.01
	8.86
	6.52
	5.56
	5.04
	4.70
	4.46
	4.28
	4.14
	4.03
	3.94

	
	0.001
	17.14
	11.78
	9.73
	8.62
	7.92
	7.44
	7.08
	6.80
	6.58
	6.40

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	3.07
	2.70
	2.49
	2.36
	2.27
	2.21
	2.16
	2.12
	2.09
	2.06

	
	0.05
	4.54
	3.68
	3.29
	3.06
	2.90
	2.79
	2.71
	2.64
	2.59
	2.54

	15
	0.025
	6.20
	4.77
	4.15
	3.80
	3.58
	3.42
	3.29
	3.20
	3.12
	3.06

	
	0.01
	8.68
	6.36
	5.42
	4.89
	4.56
	4.32
	4.14
	4.00
	3.89
	3.81

	
	0.001
	16.59
	11.34
	9.34
	8.25
	7.57
	7.09
	6.74
	6.47
	6.26
	6.08

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	3.05
	2.67
	2.46
	2.33
	2.24
	2.18
	2.13
	2.09
	2.06
	2.03

	
	0.05
	4.49
	3.63
	3.24
	3.01
	2.85
	2.74
	2.66
	2.59
	2.54
	2.49

	16
	0.025
	6.11
	4.69
	4.08
	3.73
	3.50
	3.34
	3.22
	3.13
	3.05
	2.99

	
	0.01
	8.53
	6.23
	5.29
	4.77
	4.44
	4.20
	4.03
	3.89
	3.78
	3.69

	
	0.001
	16.12
	10.97
	9.01
	7.94
	7.27
	6.80
	6.46
	6.19
	5.98
	5.81

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	3.03
	2.64
	2.44
	2.31
	2.22
	2.15
	2.10
	2.06
	2.03
	2.00

	
	0.05
	4.45
	3.59
	3.20
	2.96
	2.81
	2.70
	2.61
	2.55
	2.49
	2.45

	17
	0.025
	6.04
	4.62
	4.01
	3.67
	3.44
	3.28
	3.16
	3.06
	2.99
	2.92

	
	0.01
	8.40
	6.11
	5.19
	4.67
	4.34
	4.10
	3.93
	3.79
	3.68
	3.59

	
	0.001
	15.72
	10.66
	8.73
	7.68
	7.02
	6.56
	6.22
	5.96
	5.75
	5.58

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	3.01
	2.62
	2.42
	2.29
	2.20
	2.13
	2.08
	2.04
	2.00
	1.98

	
	0.05
	4.41
	3.55
	3.16
	2.93
	2.77
	2.66
	2.58
	2.51
	2.46
	2.41

	18
	0.025
	5.98
	4.56
	3.95
	3.61
	3.38
	3.22
	3.10
	3.00
	2.93
	2.87

	
	0.01
	8.29
	6.01
	5.09
	4.58
	4.25
	4.01
	3.84
	3.70
	3.60
	3.51

	
	0.001
	15.38
	10.39
	8.49
	7.46
	6.81
	6.35
	6.02
	5.76
	5.56
	5.39

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.99
	2.61
	2.40
	2.27
	2.18
	2.11
	2.06
	2.02
	1.98
	1.96

	
	0.05
	4.38
	3.52
	3.13
	2.90
	2.74
	2.63
	2.54
	2.48
	2.42
	2.38

	19
	0.025
	5.92
	4.51
	3.90
	3.56
	3.33
	3.17
	3.05
	2.96
	2.88
	2.82

	
	0.01
	8.19
	5.93
	5.01
	4.50
	4.17
	3.94
	3.77
	3.63
	3.52
	3.43

	
	0.001
	15.08
	10.16
	8.28
	7.27
	6.62
	6.18
	5.85
	5.59
	5.39
	5.22

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.98
	2.59
	2.38
	2.25
	2.16
	2.09
	2.04
	2.00
	1.96
	1.94

	
	0.05
	4.35
	3.49
	3.10
	2.87
	2.71
	2.60
	2.51
	2.45
	2.39
	2.35

	20
	0.025
	5.87
	4.46
	3.86
	3.52
	3.29
	3.13
	3.01
	2.91
	2.84
	2.77

	
	0.01
	8.10
	5.85
	4.94
	4.43
	4.10
	3.87
	3.70
	3.56
	3.46
	3.37

	
	0.001
	14.82
	9.95
	8.10
	7.10
	6.46
	6.02
	5.69
	5.44
	5.24
	5.07
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	dfd
	p
	12
	15
	20
	25
	30
	40
	50
	60
	120
	1000

	
	0.1
	2.21
	2.17
	2.12
	2.10
	2.08
	2.05
	2.04
	2.03
	2.00
	1.98

	
	0.05
	2.79
	2.72
	2.65
	2.60
	2.57
	2.53
	2.51
	2.49
	2.45
	2.41

	11
	0.025
	3.43
	3.33
	3.23
	3.16
	3.12
	3.06
	3.03
	3.00
	2.94
	2.89

	
	0.01
	4.40
	4.25
	4.10
	4.01
	3.94
	3.86
	3.81
	3.78
	3.69
	3.61

	
	0.001
	7.63
	7.32
	7.01
	6.82
	6.68
	6.52
	6.42
	6.35
	6.18
	6.02

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.15
	2.10
	2.06
	2.03
	2.01
	1.99
	1.97
	1.96
	1.93
	1.91

	
	0.05
	2.69
	2.62
	2.54
	2.50
	2.47
	2.43
	2.40
	2.38
	2.34
	2.30

	12
	0.025
	3.28
	3.18
	3.07
	3.01
	2.96
	2.91
	2.87
	2.85
	2.79
	2.73

	
	0.01
	4.16
	4.01
	3.86
	3.77
	3.70
	3.62
	3.57
	3.54
	3.45
	3.37

	
	0.001
	7.01
	6.71
	6.40
	6.22
	6.09
	5.93
	5.83
	5.76
	5.59
	5.44

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.10
	2.05
	2.01
	1.98
	1.96
	1.93
	1.92
	1.90
	1.88
	1.85

	
	0.05
	2.60
	2.53
	2.46
	2.41
	2.38
	2.34
	2.31
	2.30
	2.25
	2.21

	13
	0.025
	3.15
	3.05
	2.95
	2.88
	2.84
	2.78
	2.74
	2.72
	2.66
	2.60

	
	0.01
	3.96
	3.82
	3.66
	3.57
	3.51
	3.43
	3.38
	3.34
	3.25
	3.18

	
	0.001
	6.52
	6.23
	5.93
	5.75
	5.63
	5.47
	5.37
	5.30
	5.14
	4.99

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.05
	2.01
	1.96
	1.93
	1.91
	1.88
	1.87
	1.86
	1.83
	1.80

	
	0.05
	2.53
	2.46
	2.39
	2.34
	2.31
	2.27
	2.24
	2.22
	2.18
	2.14

	14
	0.025
	3.05
	2.95
	2.84
	2.78
	2.73
	2.67
	2.64
	2.61
	2.55
	2.50

	
	0.01
	3.80
	3.66
	3.50
	3.41
	3.35
	3.27
	3.22
	3.18
	3.09
	3.01

	
	0.001
	6.13
	5.85
	5.56
	5.38
	5.25
	5.10
	5.00
	4.94
	4.77
	4.62

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.02
	1.97
	1.92
	1.89
	1.87
	1.85
	1.83
	1.82
	1.79
	1.76

	
	0.05
	2.47
	2.40
	2.33
	2.28
	2.25
	2.20
	2.18
	2.16
	2.11
	2.07

	15
	0.025
	2.96
	2.86
	2.76
	2.69
	2.64
	2.59
	2.55
	2.52
	2.46
	2.40

	
	0.01
	3.67
	3.52
	3.37
	3.28
	3.21
	3.13
	3.08
	3.05
	2.96
	2.88

	
	0.001
	5.81
	5.54
	5.25
	5.07
	4.95
	4.80
	4.70
	4.64
	4.47
	4.33

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	1.99
	1.94
	1.89
	1.86
	1.84
	1.81
	1.79
	1.78
	1.75
	1.72

	
	0.05
	2.42
	2.35
	2.28
	2.23
	2.19
	2.15
	2.12
	2.11
	2.06
	2.02

	16
	0.025
	2.89
	2.79
	2.68
	2.61
	2.57
	2.51
	2.47
	2.45
	2.38
	2.32

	
	0.01
	3.55
	3.41
	3.26
	3.17
	3.10
	3.02
	2.97
	2.93
	2.84
	2.76

	
	0.001
	5.55
	5.27
	4.99
	4.82
	4.70
	4.55
	4.45
	4.39
	4.23
	4.08

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	1.96
	1.91
	1.86
	1.83
	1.81
	1.78
	1.76
	1.75
	1.72
	1.69

	
	0.05
	2.38
	2.31
	2.23
	2.18
	2.15
	2.10
	2.08
	2.06
	2.01
	1.97

	17
	0.025
	2.83
	2.72
	2.62
	2.55
	2.50
	2.44
	2.41
	2.38
	2.32
	2.26

	
	0.01
	3.45
	3.31
	3.16
	3.07
	3.00
	2.92
	2.87
	2.84
	2.75
	2.66

	
	0.001
	5.32
	5.05
	4.77
	4.60
	4.48
	4.33
	4.24
	4.18
	4.02
	3.87

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	1.93
	1.89
	1.84
	1.81
	1.78
	1.75
	1.74
	1.72
	1.69
	1.66

	
	0.05
	2.34
	2.27
	2.19
	2.14
	2.11
	2.06
	2.04
	2.02
	1.97
	1.92

	18
	0.025
	2.77
	2.67
	2.56
	2.49
	2.44
	2.38
	2.35
	2.32
	2.26
	2.20

	
	0.01
	3.37
	3.23
	3.08
	2.98
	2.92
	2.84
	2.78
	2.75
	2.66
	2.58

	
	0.001
	5.13
	4.87
	4.59
	4.42
	4.30
	4.15
	4.06
	4.00
	3.84
	3.69

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	1.91
	1.86
	1.81
	1.78
	1.76
	1.73
	1.71
	1.70
	1.67
	1.63

	
	0.05
	2.31
	2.23
	2.16
	2.11
	2.07
	2.03
	2.00
	1.98
	1.93
	1.88

	19
	0.025
	2.72
	2.62
	2.51
	2.44
	2.39
	2.33
	2.30
	2.27
	2.20
	2.14

	
	0.01
	3.30
	3.15
	3.00
	2.91
	2.84
	2.76
	2.71
	2.67
	2.58
	2.50

	
	0.001
	4.97
	4.70
	4.43
	4.26
	4.14
	3.99
	3.90
	3.84
	3.68
	3.53

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	1.89
	1.85
	1.79
	1.76
	1.74
	1.71
	1.69
	1.68
	1.64
	1.61

	
	0.05
	2.28
	2.20
	2.12
	2.07
	2.04
	1.99
	1.97
	1.95
	1.90
	1.85

	20
	0.025
	2.68
	2.57
	2.46
	2.40
	2.35
	2.29
	2.25
	2.22
	2.16
	2.09

	
	0.01
	3.23
	3.09
	2.94
	2.84
	2.78
	2.69
	2.64
	2.61
	2.52
	2.43

	
	0.001
	4.82
	4.56
	4.29
	4.12
	4.01
	3.86
	3.77
	3.70
	3.54
	3.40
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	Dfn

	dfd
	p
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10

	
	0.1
	2.96
	2.58
	2.36
	2.23
	2.14
	2.07
	2.02
	1.98
	1.95
	1.92

	
	0.05
	4.32
	3.47
	3.07
	2.84
	2.69
	2.57
	2.49
	2.42
	2.37
	2.32

	21
	0.025
	5.83
	4.42
	3.82
	3.48
	3.25
	3.09
	2.97
	2.87
	2.80
	2.74

	
	0.01
	8.02
	5.78
	4.87
	4.37
	4.04
	3.81
	3.64
	3.51
	3.40
	3.31

	
	0.001
	14.59
	9.77
	7.94
	6.95
	6.32
	5.88
	5.56
	5.31
	5.11
	4.95

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.95
	2.56
	2.35
	2.22
	2.13
	2.06
	2.01
	1.97
	1.93
	1.90

	
	0.05
	4.30
	3.44
	3.05
	2.82
	2.66
	2.55
	2.46
	2.40
	2.34
	2.30

	22
	0.025
	5.79
	4.38
	3.78
	3.44
	3.22
	3.05
	2.93
	2.84
	2.76
	2.70

	
	0.01
	7.95
	5.72
	4.82
	4.31
	3.99
	3.76
	3.59
	3.45
	3.35
	3.26

	
	0.001
	14.38
	9.61
	7.80
	6.81
	6.19
	5.76
	5.44
	5.19
	4.99
	4.83

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.94
	2.55
	2.34
	2.21
	2.11
	2.05
	2.00
	1.95
	1.92
	1.89

	
	0.05
	4.28
	3.42
	3.03
	2.80
	2.64
	2.53
	2.44
	2.37
	2.32
	2.27

	23
	0.025
	5.75
	4.35
	3.75
	3.41
	3.18
	3.02
	2.90
	2.81
	2.73
	2.67

	
	0.01
	7.88
	5.66
	4.76
	4.26
	3.94
	3.71
	3.54
	3.41
	3.30
	3.21

	
	0.001
	14.20
	9.47
	7.67
	6.70
	6.08
	5.65
	5.33
	5.09
	4.89
	4.73

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.93
	2.54
	2.33
	2.20
	2.10
	2.04
	1.98
	1.94
	1.91
	1.88

	
	0.05
	4.26
	3.40
	3.01
	2.78
	2.62
	2.51
	2.42
	2.36
	2.30
	2.25

	24
	0.025
	5.72
	4.32
	3.72
	3.38
	3.15
	2.99
	2.87
	2.78
	2.70
	2.64

	
	0.01
	7.82
	5.61
	4.72
	4.22
	3.89
	3.67
	3.50
	3.36
	3.26
	3.17

	
	0.001
	14.03
	9.34
	7.55
	6.59
	5.98
	5.55
	5.24
	4.99
	4.80
	4.64

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.92
	2.53
	2.32
	2.18
	2.09
	2.02
	1.97
	1.93
	1.90
	1.87

	
	0.05
	4.24
	3.39
	2.99
	2.76
	2.60
	2.49
	2.40
	2.34
	2.28
	2.24

	25
	0.025
	5.69
	4.29
	3.69
	3.35
	3.13
	2.97
	2.85
	2.75
	2.68
	2.61

	
	0.01
	7.77
	5.57
	4.68
	4.18
	3.86
	3.63
	3.46
	3.32
	3.22
	3.13

	
	0.001
	13.88
	9.22
	7.45
	6.49
	5.89
	5.46
	5.15
	4.91
	4.71
	4.56

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.91
	2.52
	2.31
	2.17
	2.08
	2.01
	1.96
	1.92
	1.88
	1.86

	
	0.05
	4.23
	3.37
	2.98
	2.74
	2.59
	2.47
	2.39
	2.32
	2.27
	2.22

	26
	0.025
	5.66
	4.27
	3.67
	3.33
	3.10
	2.94
	2.82
	2.73
	2.65
	2.59

	
	0.01
	7.72
	5.53
	4.64
	4.14
	3.82
	3.59
	3.42
	3.29
	3.18
	3.09

	
	0.001
	13.74
	9.12
	7.36
	6.41
	5.80
	5.38
	5.07
	4.83
	4.64
	4.48

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.90
	2.51
	2.30
	2.17
	2.07
	2.00
	1.95
	1.91
	1.87
	1.85

	
	0.05
	4.21
	3.35
	2.96
	2.73
	2.57
	2.46
	2.37
	2.31
	2.25
	2.20

	27
	0.025
	5.63
	4.24
	3.65
	3.31
	3.08
	2.92
	2.80
	2.71
	2.63
	2.57

	
	0.01
	7.68
	5.49
	4.60
	4.11
	3.78
	3.56
	3.39
	3.26
	3.15
	3.06

	
	0.001
	13.61
	9.02
	7.27
	6.33
	5.73
	5.31
	5.00
	4.76
	4.57
	4.41

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.89
	2.50
	2.29
	2.16
	2.06
	2.00
	1.94
	1.90
	1.87
	1.84

	
	0.05
	4.20
	3.34
	2.95
	2.71
	2.56
	2.45
	2.36
	2.29
	2.24
	2.19

	28
	0.025
	5.61
	4.22
	3.63
	3.29
	3.06
	2.90
	2.78
	2.69
	2.61
	2.55

	
	0.01
	7.64
	5.45
	4.57
	4.07
	3.75
	3.53
	3.36
	3.23
	3.12
	3.03

	
	0.001
	13.50
	8.93
	7.19
	6.25
	5.66
	5.24
	4.93
	4.70
	4.50
	4.35

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.89
	2.50
	2.28
	2.15
	2.06
	1.99
	1.94
	1.89
	1.86
	1.83

	
	0.05
	4.18
	3.33
	2.93
	2.70
	2.55
	2.43
	2.35
	2.28
	2.22
	2.18

	29
	0.025
	5.59
	4.20
	3.61
	3.27
	3.04
	2.88
	2.76
	2.67
	2.59
	2.53

	
	0.01
	7.60
	5.42
	4.54
	4.04
	3.73
	3.50
	3.33
	3.20
	3.09
	3.00

	
	0.001
	13.39
	8.85
	7.12
	6.19
	5.59
	5.18
	4.87
	4.64
	4.45
	4.29

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.88
	2.49
	2.28
	2.14
	2.05
	1.98
	1.93
	1.88
	1.85
	1.82

	
	0.05
	4.17
	3.32
	2.92
	2.69
	2.53
	2.42
	2.33
	2.27
	2.21
	2.16

	30
	0.025
	5.57
	4.18
	3.59
	3.25
	3.03
	2.87
	2.75
	2.65
	2.58
	2.51

	
	0.01
	7.56
	5.39
	4.51
	4.02
	3.70
	3.47
	3.30
	3.17
	3.07
	2.98

	
	0.001
	13.29
	8.77
	7.05
	6.12
	5.53
	5.12
	4.82
	4.58
	4.39
	4.24
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	Dfn

	dfd
	p
	12
	15
	20
	25
	30
	40
	50
	60
	120
	1000

	
	0.1
	1.87
	1.83
	1.78
	1.74
	1.72
	1.69
	1.67
	1.66
	1.62
	1.59

	
	0.05
	2.25
	2.18
	2.10
	2.05
	2.01
	1.96
	1.94
	1.92
	1.87
	1.82

	21
	0.025
	2.64
	2.53
	2.42
	2.36
	2.31
	2.25
	2.21
	2.18
	2.11
	2.05

	
	0.01
	3.17
	3.03
	2.88
	2.79
	2.72
	2.64
	2.58
	2.55
	2.46
	2.37

	
	0.001
	4.70
	4.44
	4.17
	4.00
	3.88
	3.74
	3.64
	3.58
	3.42
	3.28

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	1.86
	1.81
	1.76
	1.73
	1.70
	1.67
	1.65
	1.64
	1.60
	1.57

	
	0.05
	2.23
	2.15
	2.07
	2.02
	1.98
	1.94
	1.91
	1.89
	1.84
	1.79

	22
	0.025
	2.60
	2.50
	2.39
	2.32
	2.27
	2.21
	2.17
	2.14
	2.08
	2.01

	
	0.01
	3.12
	2.98
	2.83
	2.73
	2.67
	2.58
	2.53
	2.50
	2.40
	2.32

	
	0.001
	4.58
	4.33
	4.06
	3.89
	3.78
	3.63
	3.54
	3.48
	3.32
	3.17

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	1.85
	1.80
	1.74
	1.71
	1.69
	1.66
	1.64
	1.62
	1.59
	1.55

	
	0.05
	2.20
	2.13
	2.05
	2.00
	1.96
	1.91
	1.88
	1.86
	1.81
	1.76

	23
	0.025
	2.57
	2.47
	2.36
	2.29
	2.24
	2.18
	2.14
	2.11
	2.04
	1.98

	
	0.01
	3.07
	2.93
	2.78
	2.69
	2.62
	2.54
	2.48
	2.45
	2.35
	2.27

	
	0.001
	4.48
	4.23
	3.96
	3.79
	3.68
	3.53
	3.44
	3.38
	3.22
	3.08

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	1.83
	1.78
	1.73
	1.70
	1.67
	1.64
	1.62
	1.61
	1.57
	1.54

	
	0.05
	2.18
	2.11
	2.03
	1.97
	1.94
	1.89
	1.86
	1.84
	1.79
	1.74

	24
	0.025
	2.54
	2.44
	2.33
	2.26
	2.21
	2.15
	2.11
	2.08
	2.01
	1.94

	
	0.01
	3.03
	2.89
	2.74
	2.64
	2.58
	2.49
	2.44
	2.40
	2.31
	2.22

	
	0.001
	4.39
	4.14
	3.87
	3.71
	3.59
	3.45
	3.36
	3.29
	3.14
	2.99

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	1.82
	1.77
	1.72
	1.68
	1.66
	1.63
	1.61
	1.59
	1.56
	1.52

	
	0.05
	2.16
	2.09
	2.01
	1.96
	1.92
	1.87
	1.84
	1.82
	1.77
	1.72

	25
	0.025
	2.51
	2.41
	2.30
	2.23
	2.18
	2.12
	2.08
	2.05
	1.98
	1.91

	
	0.01
	2.99
	2.85
	2.70
	2.60
	2.54
	2.45
	2.40
	2.36
	2.27
	2.18

	
	0.001
	4.31
	4.06
	3.79
	3.63
	3.52
	3.37
	3.28
	3.22
	3.06
	2.91

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	1.81
	1.76
	1.71
	1.67
	1.65
	1.61
	1.59
	1.58
	1.54
	1.51

	
	0.05
	2.15
	2.07
	1.99
	1.94
	1.90
	1.85
	1.82
	1.80
	1.75
	1.70

	26
	0.025
	2.49
	2.39
	2.28
	2.21
	2.16
	2.09
	2.05
	2.03
	1.95
	1.89

	
	0.01
	2.96
	2.81
	2.66
	2.57
	2.50
	2.42
	2.36
	2.33
	2.23
	2.14

	
	0.001
	4.24
	3.99
	3.72
	3.56
	3.44
	3.30
	3.21
	3.15
	2.99
	2.84

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	1.80
	1.75
	1.70
	1.66
	1.64
	1.60
	1.58
	1.57
	1.53
	1.50

	
	0.05
	2.13
	2.06
	1.97
	1.92
	1.88
	1.84
	1.81
	1.78
	1.73
	1.68

	27
	0.025
	2.47
	2.36
	2.25
	2.18
	2.13
	2.07
	2.03
	2.00
	1.93
	1.86

	
	0.01
	2.93
	2.78
	2.63
	2.54
	2.47
	2.38
	2.33
	2.29
	2.20
	2.11

	
	0.001
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	3.92
	3.66
	3.49
	3.38
	3.23
	3.14
	3.08
	2.92
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	1.65
	1.62
	1.59
	1.57
	1.56
	1.52
	1.48

	
	0.05
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	1.91
	1.87
	1.82
	1.79
	1.77
	1.71
	1.66

	28
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	2.34
	2.23
	2.16
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	2.05
	2.01
	1.98
	1.91
	1.84

	
	0.01
	2.90
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	2.60
	2.51
	2.44
	2.35
	2.30
	2.26
	2.17
	2.08
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	3.60
	3.43
	3.32
	3.18
	3.09
	3.02
	2.86
	2.72
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	1.78
	1.73
	1.68
	1.64
	1.62
	1.58
	1.56
	1.55
	1.51
	1.47

	
	0.05
	2.10
	2.03
	1.94
	1.89
	1.85
	1.81
	1.77
	1.75
	1.70
	1.65

	29
	0.025
	2.43
	2.32
	2.21
	2.14
	2.09
	2.03
	1.99
	1.96
	1.89
	1.82

	
	0.01
	2.87
	2.73
	2.57
	2.48
	2.41
	2.32
	2.27
	2.23
	2.14
	2.05

	
	0.001
	4.05
	3.80
	3.54
	3.38
	3.27
	3.12
	3.03
	2.97
	2.81
	2.66

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	1.77
	1.72
	1.67
	1.63
	1.61
	1.57
	1.55
	1.54
	1.50
	1.46

	
	0.05
	2.09
	2.01
	1.93
	1.88
	1.84
	1.79
	1.76
	1.74
	1.68
	1.63

	30
	0.025
	2.41
	2.31
	2.20
	2.12
	2.07
	2.01
	1.97
	1.94
	1.87
	1.80

	
	0.01
	2.84
	2.70
	2.55
	2.45
	2.39
	2.30
	2.25
	2.21
	2.11
	2.02

	
	0.001
	4.00
	3.75
	3.49
	3.33
	3.22
	3.07
	2.98
	2.92
	2.76
	2.61
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	Dfn

	dfd
	p
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10

	
	0.1
	2.84
	2.44
	2.23
	2.09
	2.00
	1.93
	1.87
	1.83
	1.79
	1.76

	
	0.05
	4.08
	3.23
	2.84
	2.61
	2.45
	2.34
	2.25
	2.18
	2.12
	2.08

	40
	0.025
	5.42
	4.05
	3.46
	3.13
	2.90
	2.74
	2.62
	2.53
	2.45
	2.39

	
	0.01
	7.31
	5.18
	4.31
	3.83
	3.51
	3.29
	3.12
	2.99
	2.89
	2.80

	
	0.001
	12.61
	8.25
	6.59
	5.70
	5.13
	4.73
	4.44
	4.21
	4.02
	3.87

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.81
	2.41
	2.20
	2.06
	1.97
	1.90
	1.84
	1.80
	1.76
	1.73

	
	0.05
	4.03
	3.18
	2.79
	2.56
	2.40
	2.29
	2.20
	2.13
	2.07
	2.03

	50
	0.025
	5.34
	3.97
	3.39
	3.05
	2.83
	2.67
	2.55
	2.46
	2.38
	2.32

	
	0.01
	7.17
	5.06
	4.20
	3.72
	3.41
	3.19
	3.02
	2.89
	2.79
	2.70

	
	0.001
	12.22
	7.96
	6.34
	5.46
	4.90
	4.51
	4.22
	4.00
	3.82
	3.67

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.79
	2.39
	2.18
	2.04
	1.95
	1.87
	1.82
	1.77
	1.74
	1.71

	
	0.05
	4.00
	3.15
	2.76
	2.52
	2.37
	2.25
	2.17
	2.10
	2.04
	1.99

	60
	0.025
	5.29
	3.93
	3.34
	3.01
	2.79
	2.63
	2.51
	2.41
	2.33
	2.27

	
	0.01
	7.08
	4.98
	4.13
	3.65
	3.34
	3.12
	2.95
	2.82
	2.72
	2.63

	
	0.001
	11.97
	7.77
	6.17
	5.31
	4.76
	4.37
	4.09
	3.87
	3.69
	3.54

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.76
	2.36
	2.14
	2.00
	1.91
	1.83
	1.78
	1.73
	1.70
	1.66

	
	0.05
	3.94
	3.09
	2.70
	2.46
	2.31
	2.19
	2.10
	2.03
	1.97
	1.93

	100
	0.025
	5.18
	3.83
	3.25
	2.92
	2.70
	2.54
	2.42
	2.32
	2.24
	2.18

	
	0.01
	6.89
	4.82
	3.98
	3.51
	3.21
	2.99
	2.82
	2.69
	2.59
	2.50

	
	0.001
	11.50
	7.41
	5.86
	5.02
	4.48
	4.11
	3.83
	3.61
	3.44
	3.30

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.73
	2.33
	2.11
	1.97
	1.88
	1.80
	1.75
	1.70
	1.66
	1.63

	
	0.05
	3.89
	3.04
	2.65
	2.42
	2.26
	2.14
	2.06
	1.99
	1.93
	1.88

	200
	0.025
	5.10
	3.76
	3.18
	2.85
	2.63
	2.47
	2.35
	2.26
	2.18
	2.11

	
	0.01
	6.76
	4.71
	3.88
	3.41
	3.11
	2.89
	2.73
	2.60
	2.50
	2.41

	
	0.001
	11.15
	7.15
	5.63
	4.81
	4.29
	3.92
	3.65
	3.43
	3.26
	3.12

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	2.71
	2.31
	2.09
	1.95
	1.85
	1.78
	1.72
	1.68
	1.64
	1.61

	
	0.05
	3.85
	3.00
	2.61
	2.38
	2.22
	2.11
	2.02
	1.95
	1.89
	1.84

	1000
	0.025
	5.04
	3.70
	3.13
	2.80
	2.58
	2.42
	2.30
	2.20
	2.13
	2.06

	
	0.01
	6.66
	4.63
	3.80
	3.34
	3.04
	2.82
	2.66
	2.53
	2.42
	2.34

	
	0.001
	10.89
	6.96
	5.46
	4.66
	4.14
	3.78
	3.51
	3.30
	3.13
	2.99
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	Dfn

	dfd
	p
	12
	15
	20
	25
	30
	40
	50
	60
	120
	1000

	
	0.1
	1.71
	1.66
	1.61
	1.57
	1.54
	1.51
	1.48
	1.47
	1.42
	1.38

	
	0.05
	2.00
	1.92
	1.84
	1.78
	1.74
	1.69
	1.66
	1.64
	1.58
	1.52

	40
	0.025
	2.29
	2.18
	2.07
	1.99
	1.94
	1.87
	1.83
	1.80
	1.72
	1.65

	
	0.01
	2.66
	2.52
	2.37
	2.27
	2.20
	2.11
	2.06
	2.02
	1.92
	1.82

	
	0.001
	3.64
	3.40
	3.14
	2.98
	2.87
	2.73
	2.64
	2.57
	2.41
	2.25

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	1.68
	1.63
	1.57
	1.53
	1.50
	1.46
	1.44
	1.42
	1.38
	1.33

	
	0.05
	1.95
	1.87
	1.78
	1.73
	1.69
	1.63
	1.60
	1.58
	1.51
	1.45

	50
	0.025
	2.22
	2.11
	1.99
	1.92
	1.87
	1.80
	1.75
	1.72
	1.64
	1.56

	
	0.01
	2.56
	2.42
	2.27
	2.17
	2.10
	2.01
	1.95
	1.91
	1.80
	1.70

	
	0.001
	3.44
	3.20
	2.95
	2.79
	2.68
	2.53
	2.44
	2.38
	2.21
	2.05

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	1.66
	1.60
	1.54
	1.50
	1.48
	1.44
	1.41
	1.40
	1.35
	1.30

	
	0.05
	1.92
	1.84
	1.75
	1.69
	1.65
	1.59
	1.56
	1.53
	1.47
	1.40

	60
	0.025
	2.17
	2.06
	1.94
	1.87
	1.82
	1.74
	1.70
	1.67
	1.58
	1.50

	
	0.01
	2.50
	2.35
	2.20
	2.10
	2.03
	1.94
	1.88
	1.84
	1.73
	1.62

	
	0.001
	3.32
	3.08
	2.83
	2.67
	2.55
	2.41
	2.32
	2.25
	2.08
	1.91

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	1.61
	1.56
	1.49
	1.45
	1.42
	1.38
	1.36
	1.34
	1.28
	1.22

	
	0.05
	1.85
	1.77
	1.68
	1.62
	1.57
	1.52
	1.48
	1.45
	1.38
	1.30

	100
	0.025
	2.08
	1.97
	1.85
	1.77
	1.71
	1.64
	1.59
	1.56
	1.46
	1.36

	
	0.01
	2.37
	2.22
	2.07
	1.97
	1.89
	1.80
	1.73
	1.69
	1.57
	1.45

	
	0.001
	3.07
	2.84
	2.59
	2.43
	2.32
	2.17
	2.08
	2.01
	1.83
	1.64

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	1.58
	1.52
	1.46
	1.41
	1.38
	1.34
	1.31
	1.29
	1.23
	1.16

	
	0.05
	1.80
	1.72
	1.62
	1.56
	1.52
	1.46
	1.41
	1.39
	1.30
	1.21

	200
	0.025
	2.01
	1.90
	1.78
	1.70
	1.64
	1.56
	1.51
	1.47
	1.37
	1.25

	
	0.01
	2.27
	2.13
	1.97
	1.87
	1.79
	1.69
	1.63
	1.58
	1.45
	1.30

	
	0.001
	2.90
	2.67
	2.42
	2.26
	2.15
	2.00
	1.90
	1.83
	1.64
	1.43

	
	
	
	
	
	
	
	
	
	
	
	

	
	0.1
	1.55
	1.49
	1.43
	1.38
	1.35
	1.30
	1.27
	1.25
	1.18
	1.08

	
	0.05
	1.76
	1.68
	1.58
	1.52
	1.47
	1.41
	1.36
	1.33
	1.24
	1.11

	1000
	0.025
	1.96
	1.85
	1.72
	1.64
	1.58
	1.50
	1.45
	1.41
	1.29
	1.13

	
	0.01
	2.20
	2.06
	1.90
	1.79
	1.72
	1.61
	1.54
	1.50
	1.35
	1.16

	
	0.001
	2.77
	2.54
	2.30
	2.14
	2.02
	1.87
	1.77
	1.70
	1.49
	1.22


TABLE V

WILCOXON

SIGNED RANK TEST
 XE "Wilcoxon signed rank test" 
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The number in parentheses is the actual for p if it differs from the column heading when rounded to two decimal places.  Column headings are upper tail probabilities.

	
	P

	N
	.99
	.95
	.90
	.10
	.05
	.01

	3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20
	— 

—

—

1(.98)

1

3

4

6

8

11

13

17

20

24

29

34

39

44
	—

1(.94)

2(.94)

3

5

7

9

12

15

18

22

27

31

37

42

48

54

61
	1(.88)

2(.88)

3(.91)

5(.89)

7(.89)

9

12

15

19

23

27

32

38

43

50

56

63

71
	6(.13)

9(.13)

13(.09)

17(.11)

22(.11)

28

34

41

48

56

65

74

83

94

104

116

128

140
	—

10(.06)

14(.06)

19

23

30

37

43

52

60

70

79

89

100

112

124

136

150
	—

—

— 

21(.02)

28

34

42

50

59

68

79

89

100

112

125

138

152

167


TABLE VI

WILCOXON

RANK SUM TEST
 XE "Wilcoxon rank sum test" 
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The number in parentheses is the actual value for p if it differs from the column heading when 
rounded to two decimal places. Column headings are upper tail probabilities.  

	
	p

	m:
	.99
	.95
	.90
	.10
	.05
	.01

	
	n = 3:

	3
	---
	0
	1
	6
	7
	---

	4
	---
	1(.96)
	2(.89)
	9(.89)
	10(.94)
	11(.97)

	5
	0(.98)
	1(.96)
	3(.88)
	11(.12)
	13(.04)
	14

	6
	0
	2
	3(.92)
	13(.08)
	15
	17

	7
	0
	3(.94)
	4(.91)
	16(.09)
	17(.06)
	20

	8
	1
	3(.96)
	5
	18
	20(.04)
	22

	9
	1
	4
	6
	20
	22
	25

	10
	2
	5(.94)
	7(.91)
	22(.11)
	24(.06)
	27

	
	n = 4:

	4
	0
	2(.94)
	3
	12
	13(.06)
	15

	5
	0
	3(.94)
	4
	14
	16(.06)
	19

	6
	1
	4(.94)
	5
	15
	19(.06)
	21

	7
	2
	4
	5(.91)
	21(.09)
	22
	25

	8
	3
	6
	8(.89)
	23(.11)
	25
	29

	9
	3
	7
	9
	26
	28
	32

	10
	4
	8
	10(.91)
	29(.09)
	31
	35

	
	n = 5:

	5
	1
	4
	6(.89)
	18(.11)
	20
	23

	6
	2
	5(.96)
	7(.91)
	22(.09)
	24(.04)
	27

	7
	3
	7
	9
	25
	27
	31

	8
	4
	8
	11(.89)
	28(.11)
	31
	35

	9
	5
	10(.94)
	12(.91)
	32(.09)
	34(.06)
	39

	10
	6
	11
	14
	35
	38
	43

	
	n = 6

	6
	4
	7
	9(.91)
	26(.09)
	28
	32

	7
	5
	9
	11(.91)
	30(.09)
	32
	37

	8
	6
	11
	13(.91)
	34(.09)
	36
	41

	9
	8
	12(.96)
	15(.91)
	38(.09)
	41(.04)
	46

	10
	9
	14
	17(.91)
	42(.09)
	45
	50

	
	n = 7

	7
	7
	11
	14
	34
	37
	42

	8
	8
	13
	16(.91)
	39(.09)
	42
	47

	9
	10
	15
	10(.89)
	43(.11)
	47
	53

	10
	11
	18
	21
	48
	51
	58

	
	n = 8:

	8
	10
	16
	19
	44
	47
	54

	9
	12
	18
	22
	49
	53
	59

	10
	14
	21
	25
	54
	58
	65

	
	n = 9

	9
	14
	21
	25
	55
	59
	66

	10
	17
	24
	29(.89)
	60(.11)
	65
	72

	
	n = 10

	10
	19
	28
	32
	67
	71
	80
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